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MyCalls   – Advanced Call Management System 

WHAT THIS GUIDE CONTAINS  

This end user guide contains essential information about MyCalls illustrating the use of the MyCalls 
application and then providing steps to customize the application to end user requirements.  

 

WHO SHOULD READ THIS GUIDE  

This guide is for end users of a MyCalls SL1100 installation  
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How this manual is organised. 

 

The MyCalls   consists of Call Recorder and Call Manager. Each product is available independently or 

they can be purchased as a complete integrated application. Various features of each product are 

enabled or disabled depending on what aspects of each product have been licensed.  

This manual covers the use of all available features of the products and shows all features available 

but some features may not be available on your installation due to license limitations. 

To improve readability the term MyCalls has been used to refer to one or more of the MyCalls   

products. 
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Chapter 1 

Getting Started with SL MyCalls  

Welcome to MyCalls your comprehensive call management and reporting application. Here in this 
chapter you are introduced to the free to use application, SL MyCalls. A more detailed description of 
the features of SL MyCalls and the fully featured MyCalls Call Manager are described in subsequent 
chapters. Please note that many features are only available with the full MyCalls Call Manager. Full 
details of the licensable options are shown in the appendix at the end of this manual.   

What is SL MyCalls  

SL MyCalls is available as a free to use application. SL MyCalls is an ideal tool for your call 
management, call statistics, costing and reporting tasks. Whilst SL MyCalls will provide a wide range 
of functionality it can be expanded by purchasing MyCalls Call Manager which provides a fully 
comprehensive set of features for the most demanding call management needs. 

Appendix A shows the features available in SL MyCalls and the features available in the MyCalls call 
manager. 

Installed applications  

 

Once installed, you will have access to both the application and a configuration utility. These can be 
accessed via the windows menu under 

NEC Infrontia  -> MyCalls    

The applications are: 

 MyCalls – The main Call Management application 

 MyCalls Configuration Import – Configuration utility 

 Collector Configuration – Configuration utility 

 Computer ID Generator and License Manager – Used for license installation 

Before you can use the applications you will need to run the MyCalls configuration import 
application and configure your system. Refer to the MyCalls installation manual for further 
information. 
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Launching MyCalls  

 

MyCalls can be launched by clicking the desktop shortcut or selecting MyCalls from the windows 
menu under NEC Infrontia -> MyCalls. The application will display a default page which includes a 
calls list and statistics windows for Incoming, Outgoing and abandoned calls.  

 
The SL MyCalls Main Screen 

 

Call Lists 

 

 

All MyCalls applications provide call lists in the main display area. Where call recording has been 
installed on its own the standard call log view is available. For MyCalls Call Manager installations the 
additional call views of Unreturned calls, Alarms and Audit Logs are also available. These views share 
the following features 
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View the grid: Positioning the mouse over the appropriate icon in the bottom grid bar will cause 
the window to pop up. 

Pin the Grid: Allows the grid to be fixed in position by selecting the Pin icon to the top right of the 
window. 

 

If the grid is not pinned then it will automatically hide (minimise) when the mouse is not positioned 
over the window. 

The window can be adjusted in height by hovering over and clicking the upper part of the window 
with the mouse and then dragging the window vertically. 

Adjusting the column width: Dragging a column divider with the mouse allows the column to be 
sized horizontally  

Ordering by column:  Selecting the column title will cause the grid to be ordered by that column’s 
content, e.g. clicking on a number column will sort the contents in ascending numerical order, 
clicking on a name column will sort the items in ascending alphabetical order of the name column. 

Grouping by column: Dragging a column to the grouping area (Drag a column header here to group 
by that column) will group records on that column. To ungroup simply drag the column name 
outside the window. 

 

The screen shot below shows grouping by the date-time column 

 

Column Chooser: Allows the grid to be customized by adding and removing different columns. Top 
add a column select it from the column chooser list and drag it to the grid. To remove a column, drag 
it from the grid and release the mouse button. To move the position of a column, drag the column 
horizontally along the grid. 

Grid View Options 
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Clicking on the options button allows you to display the following options: 
 

 

*My calls only: This displays only calls related to the user currently logged onto the system. 

*All calls for users in my Organisational Group on my PBX: Lists all calls for users in the logged 
on user’s group but only includes those extensions connected to the local PBX.   

All calls for users in my Organisational Group across all PBX’s: Lists all calls for users in the 
logged on user’s group irrespective of the PBX the extension is connected to.   

*Custom:  Allows setting of specific period for calls. This can be a date range and can be further 
limited to a specific time period during each day. Extensions, DID filters etc can also be applied. 

Quick Search Filtering: Set the grid filtering using the quick search fields. 

*Only available with the MyCalls manager application 

The Calls View 

The calls visible in the calls view have some special features.  

Call Playback* 

*Only available with the MyCalls manager application 

A speaker icon against a call indicates the call has been recorded, double clicking on the speaker icon 
will playback the call. 

Multiple call legs 

If the call includes transferred legs then the call will have an expansion symbol  
indicating the call can be opened up to reveal the individual legs of the call. 
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For multi-leg calls a summary call is displayed at the outer level  and each of the legs of the call 
(transfers) at the inner level.  If a summary call has been filtered out (usually by extension) then call 
legs will appear at the outer level and may NOT be grouped together. 

Normal calls without transfers will appear at the outer level . 

 The layout of the call record view is incompatible with versions prior to MyCalls R-3.0.0.0.  This 
means that when upgrading from an earlier version the call record view layout will be set to the 
default layout. 

Using Call Notes* 

*Only available with the MyCalls Manager application. 

Notes can be added to a call and notes do not require call recording in order to be used. To add a 
note right click on the call and select ‘Notes’. The Notes entry dialog will be displayed. You may then 
type in your notes and click ‘Save’. A note applies to a complete call, you cannot enter individual 
notes for each leg of a call. 

Once a note has been added to a call this will be indicated by a notes icon. Double clicking this icon 
will open the note dialog allowing you to add further notes to the call. 

  

Notes are also available as a selectable column from the column chooser. 

Using Quick Search 

 

 

Quick Search fields can be used to search by Number, DID, Extension, Call type, Date/Time. Results 
must meet all criteria in the filter so be careful not to leave anything in the Number box if you are 
only searching for calls related to an Extension as any calls returned in the grid would need to match 
both number and extension. 

Searching for calls using the Notes filters 

 

 

Quick search can also use the notes field. The Note search type can be set to one of the following: 

Matches Filter: Finds all notes where the note contains text matching whatever has been entered 
in the Note Filter textbox. 

Has a note: Finds all calls which have a note attached. 

No Note: Finds all calls with no note attached. 

If the filter is set to ‘Matches Filter’ then set the ‘Note Filter’ box to the search word or phrase within 
the notes attached to the calls. 
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Max Calls: Limits the number of calls viewable in the grid up to a maximum of 500. It is 
recommended that this is kept to a maximum of 50 calls for normal operation to limit the loading on 
the database. 

Refresh: allows you to manually refresh the calls in the view. 

Unreturned Calls View* 

 

*Only available with the MyCalls manager application 

Unreturned calls are calls where the caller has abandoned and not been called back. The unreturned 
calls are automatically updated when a call is abandoned. Calls are automatically removed from this 
view when either: 

A call is returned 

The same caller calls again and the call is answered 

 

Unreturned calls can be searched using a quick search panel. This quick search allows you to search 

by number, DID, extension and notes 

Unreturned calls can also be displayed in a real time status window – See Real Time Status 

Exporting Unreturned calls 

Right clicking an unreturned call or multiple unreturned calls allows you to export the list of 

unreturned calls either to a file, clipboard or an email recipient. 

Real time Statistics windows  

MyCalls can display real time statistics within individually configurable colour coded windows. 
Depending on the type of statistics being displayed they may have a number of options available. 

Statistics windows all have the option to lock, refresh and configure using the context menu which is 
viewed by right clicking the mouse whilst hovering over the window.  

Using the mouse you can hover over any real time window and press the right mouse button to get a 
menu of window options. 
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The window menu has the following options available. 

Lock Position 

This allows you to lock a window in place on the screen layout so that it can no longer be re-sized or 
moved.  

 When a window is locked it loses its borders and if you right click on it again you will see a tick next 
to the Lock Position option.  To unlock a window select the Lock Position option again to remove the 
tick and display the windows borders again.  You should now be able to resize and move the 
window. 

 

Refresh Data 

Windows are updated at prescribed intervals  

You can select the refresh data option to force the window to be updated.  

Configure  

This option allows you to configure existing window settings. The actual dialog presented will 
depend on the window type displayed.  (See ‘real time window configuration’ in the chapter on real 
time statistics for more details.) 
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The View Menu 

The MyCalls main screen provides a view menu from which you can select various real time windows 

 

 

Selecting the View-> Real Time Information option allows you to create additional statistics . You can 
choose the following statistics: 

 Extension 

 DID (DDI) 

 Incoming Calls (Trunks) 

 Outgoing Calls (Trunks) 

 Abandoned Calls (Trunks)  
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Once added to the screen the windows can be placed in any position. Ther are various alignment 
tools available to help you design your screen layout. Full details of how these layouts can be edited 
are described in the ‘Screen Layout’ chapter. The Layout menu provides an option to reset to default 
layout however this will delete any new statistics windows you have  

 

A full description of statistics windows and their configuration can be found in the ‘Real Time 
Statistics’ chapter. 

Reporting. 

Reports allow you to analyse your call activity. SL MyCalls provides a number of preconfigured 
reports or alternatively you can create your own reports using the MyCalls report templates. 

SL MyCalls provides a range of preset reports for daily, weekly and monthly activity. These are easy 
to access via the Reports menu. 

The figure below shows the preconfigured reports for daily activity. 

 

 

And the following figure shows the weekly and monthly reports. 
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You can produce your own tailored reports using a MyCalls report template. This allows you to select 
the reporting period(s) and grouping options. The available templates are: 

System Audit 

Lists the audit entries created during the operation of the application 

Call Details 

Shows a list of calls. Each call is itemised separately. Calls can be grouped . For example if you set the 
grouping by extension all calls for each extension appear together. 

Group Summary 

This produces a summary of calls to all Extensions, all DIDs or all Trunks. A single line of statistical 
data is produced showing a summary statistics for the selected device e.g. All Extensions, All DID’s or 
All Trunks. SL MyCalls does not allow user defined groups of devices to be created. 

 Group Summary by Member 

This shows a line of summary statistics for each extension, trunk or DID (depending on the device 
selected).  

Most Frequent calls  

Show the numbers which have been dialled or answered by your business in order of frequency. 

Top Calls 

Provides a list of calls ordered by duration, call cost, handling cost, ring times or held times.  
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Example: Configuring a simple call details report. 

The following example describes how to generate a simple extension call details report for the 
current week. For more in depth instructions on creating reports refer to the ‘Reporting’ chapter. 

 

Firstly you need to access the report wizard. The Report wizard provide a step by step process for 
creating and running a report based on the type of report you wish to create.  Before you start the 
wizard you need to select the appropriate template from the list of report templates. 

Select Report from the main menu. 

Click on ‘Report Templates’ . 

Click on Usage and then select Call Details. This will allow you to create a call details report. 

From the right hand list of options ensure Call Details is displayed at the top of the window and 
select ‘Configure and Run Now’. 
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The wizard will start. 

Select a time period which the report data will cover. In this example we select ‘This Week’. 
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Specify the grouping criteria, in this case ‘Extension’. You can also limit the number of calls included 

in the report if required. 

 

Finally specify the call types you wish to include. These can be individually selected from a range of 

incoming, outgoing and abandoned call types. 

 

Click Finish to generate the report. 
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The report will look similar to that shown below.  

 

 

The MyCalls reporting system is quite extensive. The full details for creting and generating the 

reports is covered in the chapter on ‘Reporting’ .The SL MyCalls does not include the following 

features. 

 User created Device Groups 

 Filters (e.g. report on specific extensions or only show calls over 10 minutes etc). 

 Custom Report fields. 
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Chapter 2 
MyCalls Call Manager 

Logging into MyCalls  

MyCalls Manager is the fully licensed Mycalls product. The Mycalls Manager supports multiple users 
and therefore you will need to log in to the system.  

Logging into the system as a user requires that users with appropriate user types and passwords 
have been set up during the configuration of the application. For more details on this see the 
‘Organisation settings’ section. 

Normally a user will be associated with a default extension. If this is not the case then you will be 
prompted to select your normal extension as detailed below.  

 

 

How To: Log into the system 

Click ‘User’ and then ‘Login’ 

 

Type in a name in User Name and type in a password, alternatively click ‘Browse’ to search for a 
name 
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Click ‘OK’ 

Quick tip:  

At least one PBX administrator must be defined in the configuration otherwise you can’t 
create or alter any other user.  

 

Selecting your extension when logging on to MyCalls Call Manager 

 

MyCalls Call Manager offers users a hot-desk facility. This enables a user to log onto any extension of 
their choice. Users must be specifically enabled for hot-desking otherwise they will be restricted to 
their default extension. In addition, extensions enabled for hot desking will appear in the list of 
available extensions as well as any extensions for which the user is marked as the default user when 
the user logs on to MyCalls   

 To Summarise: 

 Only Users enabled for Hot Desking can select an extension other than their default 

 Any  Extensions enabled for Hot Desking will appear in the list of available extensions when 
logging on as well as the extensions for which the user is the ‘default’ user 

 

Once the hot desking options have been enabled for both users and extensions then the user will be 
presented with the extension list whenever they log on. 
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The user should select the extension that they wish to control which will then be the extension 
controlled from the call control toolbar etc. 

Users can be enabled for hot desking in the user configuration and extensions can be enabled for hot 
desking in the extensions configuration. 
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Chapter 3 

MyCalls Call Recorder 

The MyCalls system provides access to call recordings using the calls list on the front screen. From 
the calls list you can see at a glance any calls which have been recorded and you can playback these 
calls simply by clicking the call playback icon. 

Enabling Users for Call Playback  

Any MyCalls user can be enabled for call playback. Once users have been created then anyone 
logging into MyCalls as a user will have certain rights and restrictions dependent on their user type 
and where they appear within the organisational hierarchy. 

The steps required to ensure call recording can take place for a given set of users are as follows: 

 Create your users and user groups* 

 Assign each user with a Role 

 Assign your users to their respective organisational groups 

 Assign each user a default extension 

 Enable the user for Call-Recording 

 Configure any Call-Recording rules 

The rules governing the playback of calls  

 Any users that are created and want to play back calls must be enabled for call playback 

A normal User can listen to their calls only 

A Supervisor can listen to any calls within their organisational group and any sub group 

A PBX Administrator can listen to any calls on their PBX  

An Enterprise administrator can listen to any calls on all PBXs 

*A Wallboard user can not listen to any calls 

(*Only applies when call manager is installed) 

The above rules can be overridden by applying call recording rules to Callers, Users, Extensions, 
Trunks, DIDs and call types.  

To ensure call recordings are only visible to users with appropriate permissions it is important to 
setup the organisational hierarchy correctly.  In the example below, the highest level group is called 
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Office admin and in that group, there is a Supervisor (Mark).  The supervisor can playback any calls 
from office admin and customer service. 

The Supervisor in customer service (Sarah) however, can only playback calls in the customer service 
group. 

 

 

For the Hierarchal user structure to work correctly, the users must be assigned to extensions.  To 
assign a user to an extension, go to configure / telephone system and edit an extension. The user is 
only assigned to calls on that extension from the time the extension is assigned to them. 

How to: Enable a User for playback  

1) In Configure -> Organisation click ‘Create New User’ or ‘Edit an Existing User’ 

 

2) To give a user the ability to playback calls, check the ‘Enable Call Playback’ box 

3) To give the user the ability to export calls click ‘Enable Export of Recordings’ 

4) Click ‘OK’ to save any changes. 

 

*For more details on users and groups see the Organisation configuration section 

Restricting Call Playback 

To enable or disable the recording of certain types of calls or calls made to or from certain parts of 
your organization you can define recording rules. These rules enable or disable specific devices, 
users and call types from being recorded. This allows you to override the normal rules governing 
users as described above. However recording rules cannot enable a user to listen to a wider range of 
calls than their position in the organisation allows. For example a user can only ever listen to their 
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own calls however you could specifically disable calls on an extension within a group from being 
recorded.   

How To: Configure Call Recording Rules  

1) From the menu select - Configure -> Telephone system -> PBX -> Call 

Recording  

2) Select the ‘Edit Call Recorder’ Configuration 

3) The ‘Edit Call Recorders’ window will be displayed – select the ‘edit’ button for the recorder for 
which you wish to set rules 

4)  
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5) From the call recording configuration page click ‘Recording Rules’ 

 

6) The Recording Rules dialog is displayed and you can define rules for enabling or disabling calls. 

 

7) Extensions, DIDs, Callers, Trunks and Users can all be included or excluded from being recorded 
as required.  
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How to: Set up recording rules for Extensions  

  

1) Add devices to the ‘Selected’ list by selecting them in the ‘Available’ list and clicking    

2) Choose ‘Do not record the selected devices’ or ‘Only record the selected extensions.’    

You can also decide to include incoming only, outgoing calls only or both. 

Using the Call Playback Interface  

Once logged into MyCalls the calls list will provide access to the recorded calls. The leftmost column 
of the calls list provides an Icon to indicate the call recording status. 

‘No Icon’ indicates there is no recording for that call 

‘A plain speaker icon’ indicates a recording has been matched to the call 

 

‘A greyed out speaker icon’ indicates a recording has been matched to the call but the recording has 
been disabled 

 

 ‘A speaker icon with a red cross’ indicates a recording has been matched to the call but the user is 
barred from playing back the call 

 

‘A speaker icon with a red cross and a green arrow’ indicates the call is a transferred incoming call, a 
recording has been matched to the call but the user is barred from playing back at least part of the 
call 

 

How To: Select and Playback a call  

1) From the ‘view’ menu select ‘Call Records View’ or select ‘Calls’ from the toolbar at the bottom 
left side of the screen: 
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2) By default the call records view will display the last 50 calls for the current day.  Calls that have 
been recorded will show a speaker icon meaning they have been recorded.   

3) To play a call that has been recorded, simply double click the speaker icon   located in the far 
left box to play the call. 

 

 

 

4) After you have double clicked the speaker, the player will load and play the call. At the same 
time the new call will be added to the playlist. 

5) The currently playing call or call leg is displayed in Red. 

6) Right clicking on the calls view will also allow you to playback a call by selecting the Playback Call 
item from the menu. 

 

Multiple call selection 

You may select several calls from the calls view listing.  

To select a range of call click on the first call required from the list and then hold down the shift key 
and click on the last call required. All calls between the first and last calls will be selected.  
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To select several individual calls click on each call whilst holding down the Ctrl key. 

  

 

The Call Player 

MyCalls provides a Call Control player specifically designed for call recording and playback. The 
player provides the following functions 

 Play/Stop 

 Fast forward/Rewind 

 Overall Volume 

 Adjust relative volume between each call participant   

 Change speed of playback without affecting pitch to clarify what was said 

 Create selections and store as sound clips 

 Set the start and endpoints of a selection as either a time or via mouse selection 

 Loop round selections or complete calls 

 View transfers as separate sections of a call 

 Navigate between sections of a call  

 Play next and previous sections of a call 

 Create playlists of complete calls 

 Play next/previous call in playlist 

 Create notes for calls 

 Auditing of playback and export activity 

 Export of audit logs 

 Export of calls 
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Feature Configuration 

You may not have all the features of the player available. The call player feature configuration is 
determined by the license as follows. 

 

 Waveform 

Display 

Sound 
clips 

Section 
markers 

Single 
call 
recording 
export 

Bulk call 
recording 
export 

Volume, 

Balance, 

Playback 
Speed 

Call 
Audit 

Basic         

Enhanced             

Enhanced+Audit              

 

Call Playback 

When a call is selected for call playback it is added to the playlist. Double clicking the speaker icon 
from the call records list launches the player and commences call playback. Control of playback is via 
the playback buttons. 
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Call Player Waveform 

 

 

The call player can display a waveform representing the recorded call. This option is licensable and 
only available with the enhanced call player.  If the product is licensed as a basic configuration then a 
compressed waveform window will be visible but no actual waveform trace will be shown. With the 
enhanced player a full two channel waveform is visible. 

When a call is played a yellow cursor line will move across the waveform window indicating the 
position of the playback point. The cursor also displays the elapsed time in minutes and seconds 
from the start of the call. If the call length is greater than 1 hour then hours and minutes will be 
shown. 

 

The bottom of the waveform window shows the time base of the call and this is scaled automatically 
to match the call length.  

The player can playback the whole call or selected parts of the call. Whether you are using the player 
in basic or enhanced configuration selections can be made from the waveform window in the same 
way. 

How To: Make a selection in the waveform window  

To make a selection from the waveform window simply click and drag the mouse along the 
waveform window.  

The selected area will show up as a grey block. 

 Release the mouse and the selection will be displayed along with a selection control bar which 
appears as a white line with a grab handle at either end of the selection.  

Selecting the control bar in the centre will allow you to move the selection left or right.  

Selecting either of the grab handles will allow you to adjust the start or end point of the selection 
independently. 

Clicking within the selection but away from the selection control bar causes the playback cursor to 
move to the mouse position.  
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Basic Player showing selection but no waveform 

To cancel a selection simply right click the selection and pick ‘Cancel Selection’ from the context 
menu. 

 

 

Creating a sound clip (Enhanced player only) 

Once you have created a selection it can be turned into a sound clip. Sound clips can be named and 
are automatically saved into a sound clip list when they are created. 

How To: Create a new sound clip 

To create a new sound clip right click a selection and select ‘Add to sound clips’ from the context 
menu.  

This will place the sound clip into the sound clips list with a default name of ‘New Clip’.   

The name of the clip is displayed in the waveform window so each clip is easily identifiable.  

The name of the clip can be changed from the ‘sound clips list’ by selecting the name of the clip and 
typing the new name over the selected text (see ‘sound clip list’ section). 

 

 A sound clip can be selected and manipulated just like a normal selection by right clicking over the 
sound clip and selecting “Select ‘New Clip’” from the menu (New clip is replaced with the name of 
the clip to be selected see below). 

  

Selecting a new clip 
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Selecting a clip named ‘Intro’ 

To delete a sound clip right click the sound clip waveform and select Delete [Clipname] from the 
menu. 

 

 

Enhanced player with full waveform and multiple sound clips 

 

Exporting Audio 

 

The waveform window provides a mechanism to export the call audio to either WMA or WAV file 
format. Right clicking on any part of the window will give you the option to export the whole call. 

 

Right clicking on a selected area of the call will allow you to export the selection. 

 

 

Calls can also be exported directly from the Calls View list on the main MyCalls screen. 
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If you have created a sound clip then right clicking the sound clip allows you to export the sound clip 
as a WMA or WAV file. Sound clips can be exported from the sound clips grid using mouse right click 
and selecting ‘Export sound clip’ from the menu. 

  

 

Call audio can be exported by using the right-click menu in the following locations: 

 Main call list 

 Any Playlist 

 Sound Clip list 

 Waveform window 

Selecting either ‘Export Call Audio’, ‘Export Selection’ or ‘Export sound clip’ opens a dialog box and 
you can choose where to save the file and select the format. The default filename is determined by 
the call recording configuration. The file format can be selected from the ‘Save as type’ drop down 
box. 

 

 

You can export audio for single calls or multiple calls. To export multiple calls simply select the 
required calls from the calls view or playlist, right click on the selections and click ‘Export Call Audio’. 
When exporting multiple calls the dialog will be slightly different as shown below and export 
progress will be visible in the status bar for each call (the status is also visible for single calls but only 
usually visible on longer calls). 
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Multiple selection export dialog 

 

 

Export Status 
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Playback Controls  

 

 

 

The playback controls are as follows: 

 Play/Stop: operates the playback of the call, click to start playback, click again to pause, 
playback will then continue from that point.  

 Rewind: Click and hold will rewind the cursor, single click will set the cursor back at the state 
of the call. 

 Fast Forward: Click and hold to fast forward the call. 

 Previous Section/Next Section: Calls contain various sections as follows: 

 Ring: This is at the start of the call and is determined from the ring duration 

 Answer: This is the main part of the call 

 Transfer: This is determined when a call is transferred to another extension 

NB: The sections of a call are determined from values within the SMDR and may not be available on 
all telephone switches. An option is available in the call recording configuration (see call recording 
configuration) to disable call sections, in which case these buttons are greyed out indicating they are 
disabled (as in the picture above). 

Waveform Enable: Enables or disables the display of the waveform. Disabling the waveform allows 
you to quickly scroll through a playlist without having to wait for the waveform display to update 
between each call selection. 

Loop Enable: Allows you to loop a complete call or a selection. 

Playlist controls: These buttons allow navigation of the playlist items and sound clip items (see 
playlist and sound clips section). 
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Call Player Management Panel  

 

 

The call player management panel allows you to manage Playlist, Sound Clips, Notes and Audits. 
Select the type of item you wish to manage from the tabs below. 

 

Playlists 

Playlists contain a list of calls selected from the main call records list. A playlist will remain in the 
player as long as the MyCalls client application is running. When a call is selected and played it is 
added to the current playlist. Calls can be added to the playlist using one of the following methods: 

 Double click the speaker icon 

 Right click on the call and select ‘Playback Call’, this will automatically play the call as well 

 Right click on the call and select ‘Add to playlist’ 

 Click and drag a call from the call records to the playlist. The player needs to be open in 
order to use this method. 

Only calls with a valid speaker icon can be added to the playlist.  

Calls can be removed from the playlist by right clicking the call within the list and selecting ‘Remove- 
Selected’ from the context menu.  

Calls which contain multiple transfers (multi leg calls) are shown with a plus symbol next to the call. 
Clicking on the plus symbol expands the call and allows you to select a specific call-leg. 

 

You can see in detail which extensions have participated in the call and how long each leg of the call 
lasted. 

Selecting either the main call record or any leg of the call will cause that call to be loaded into the 
player and played back from the start of the call. The currently selected call or call-leg is displayed in 
red. 
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Right clicking a call in the playlist gives the following options 

Export Call Audio: In the same way as selecting this option from the waveform menu 

Copy: Copies the call details to the clipboard for pasting into a document or report 

Select All: Select all calls in the list 

Export to File/Clipboard/Email: exports the contents of the selection to a text file, clipboard or email. 
Email recipients must be configured into the application. 

Remove Selected, Remove all: Remove items from the playlist. 

Sound Clips 

 

 

 

Any sound clips which have been created are listed under the sound clips tab. Each sound clip can 
have a name, description, start and end point, and a colour. There is also an option to show or hide 
the clip in the waveform window. 

Sound clips are associated with a specific call and will remain in the list until the associated call is 
deleted from the playlist. 

How To: Edit Sound Clip Details  

Single click on the ‘Name’,’ Description’,’ Begin’ or ‘End’ column for the sound clip.  

This will select the sound clip within the waveform window and select the text or time value for 
editing. 

For text columns Name and Description simply enter the text required. For Begin and End times 
enter the times required.  

Colour selection can be changed for a sound clip by clicking on the colour column and selecting a 
new colour from the palette. 
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Notes 

A note can be added to a call either in the playlist or from the call record view. The notes can be 
viewed by selecting the Note tab within the player. Any changes to the notes must be saved by 
clicking the save button. 

The Created by, Created date and Last modified by fields are automatically populated based on the 
logged in user. 

Audits 

It is useful to know what has happened to a particular call after it has been recorded. The MyCalls 
playback audit system logs events associated with the following aspects of a call recording: 

 Playback: Logs activity every time a call is played back 

 Export: Logs all call export activity 

 Clip: Logs Sound clip creation, name changes, deletion. 

 Configuration Changes: Logs changes to the call recorder configuration 

Each Audit record is read only and contains the following information: 

 Start/Finish date and times of the audited activity. 

 Audit Type: Identified the type of activity e.g. Playback. 

 User: The logged on user who carried out the activity. 

 Description: A pre-defined description of the activity. 

Additional Controls  

Two other panels are available with additional controls.  

Selection and Sound control start and end times can be adjusted using the Begin/End controls 

Play Selected range/Sound Clip limits playback to the currently selected area of the waveform panel 
or the currently selected sound clip. 

Auto Move to Next Call causes the player to automatically load and play the next call in the playlist 
once the current call has finished playing. 

 

 

 

Volume: Adjusts overall volume of the player. 

 Balance: Adjust the relative volume between the recording channels of the internal and external 
party can be adjusted.  

Playback Speed: Where 1X is normal playback speed and can be adjusted faster or slower + or –  
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Finding Recorded Calls  

For fast retrieval of calls for playback you can use the quick search from the calls grid options.  Quick 
search is the easiest way to find a call by CLI, DID, Extension or Note-text.   

Quick Search 

From the ‘view’ menu, click ‘Call record view’.  The quick search is highlighted below; by default it 
shows the last 50 calls for today.  To change the date to search on, select from the list in the ‘Period’ 
drop down menu.  To enter specific dates, choose custom and enter your dates and times as 
required.   

The next line down allows you to search for a particular telephone number, DID and extension. You 
can enter partial numbers to search on e.g. 01270 would find any number containing ‘01270’. 
Entering both a Number, DID and an Extension will search for calls containing all items in the one 
call.   

You can also search using the notes field. The Note search type can be set to one of the following: 

Matches Filter: Finds all notes where the note contains text matching whatever has been entered in 
the Note Filter textbox. 

Has a note: Finds all calls which have a note attached. 

No Note: Finds all calls with no note attached. 

You can also choose which call types to include and the maximum number of calls to display. 

 

If you cannot see the quick search, click ‘options’ in the call records view and select ‘Quick Search’ 
from the options. 

Having found the call or calls of interest you can add the call to the current playlist or create a new 
playlist by double clicking the speaker icon for that call. For more information on playlists see the 
playlist section. 
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Recordings which you cannot listen to  

Calls that show a speaker icon crossed out means the calls has been excluded from call recording in 
the recording rules configuration. 
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Call Recording Configuration 

Trunk Configuration 

Configuration of call recording requires the correct configuration and licensing of trunks. Whilst this 
should be taken care of during the system installation, it is possible that the call recording 
configuration could change at some point due to licensing of additional trunks.  

In order to enable recording on specific trunks they will need to be assigned as call recording trunks 
within the call recording configuration. 

Access to the Call Recording configuration  

How to: Access the Call-Recording configuration screen 

1) From the menu select - Configure -> Telephone system -> PBX -> Call 

Recording  

2) Select the ‘Edit Call Recorder’ Configuration 

3) The Edit Call recorders window will be displayed 

 

The Call recorder configuration screen allows the setting up of call recorder units, Licensing of 
Trunks and the editing of call recorder settings and recording rules.  
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How To: Add Call Recorders to the MyCalls Configuration 

1) To add a new call recorder click the ‘Add Call Recorder’ button. The window below will appear.  

 

2) Select the call recorder type from the drop down menu, and enter a name e.g. Crompton Road. 

3) Click ‘OK’ 

4) The call recorder will now appear in the ‘Installed Call Recorders’ section 

 

5) Select the required call recorder and click ‘Edit’ 

6) The Call recording configuration screen will be displayed 
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Recording Server Name: Enter the name of the call recording PC  

Playback Port, Archive Port, Playback Speed: These do not normally require changing 

Test Connection: Press this button to check the call recording PC is responding 

  

Additional Configuration options  

 

 

File export settings. 

Default Filename Prefix: Defines the file naming for exported files. This can be freetext combined 
with pre defined identifier names. Any identifier name must be surrounded by % characters with no 
spaces. MyCalls will substitute an identifier with the appropriate value for example %user% will 
substitute the logged on user name, %Date% will insert the current Date etc. 

How To: Insert an identifier into the filename prefix  

Set the cursor at the position in the prefix where you want to insert the identifier. In this example we 
have set the cursor at the end of the prefix. 
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The available identifiers are available by clicking the  button. This will display the list of 
identifiers.  

Select the identifier and the new identifier will be added to the prefix. 

 

The prefix will now be pre-pended to the filename whenever a call recording file is exported. 

 

 

Enable Transfer Leg Navigation 

This option enables the ability to display the identification of transfer legs in the waveform window. 

Trunk Licensing 

Whilst trunk licensing is an installation operation, it may be necessary for a system administrator to 
adjust or configure additional channels of call recording.  

The call recorder is licensed to record a certain number and type of channels based on what the 
customer has bought. In order to know which of the channels are to be used, the trunks in MyCalls 
need to be set to the correct type and marked for inclusion in call recording.  

Only trunks that are marked as ISDN or AN4009 are listed. Trunks that are either BRI or PRI need to 
be marked as ISDN within MyCalls 

Trunks that are analogue need to be marked as Analogue within MyCalls 

Remaining licenses for each type of trunk are indicated to the right of the Trunk Licensing grid. 

Licensed trunks need to be associated with the appropriate call recorder. If only one call recorder is 
installed then selecting a licensed trunk checkbox will automatically select the call recorder. If there 
are more than one call recoder then you will need to select the call recorder for each trunk. 
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Backup Call Recordings  

Call recordings can and should be backed up to an area that can be taken off-site for security 
purposes. The call recordings when backed up are still encrypted and can only be played using the 
MyCalls system. The backup can be scheduled to occur at set times and split into different volume 
sizes for storage on to CD or DVD. The split volumes create a new directory for each split and 
increment a number at the end of the volume name to ensure they are unique. 

Once call recordings have been archived the system can remove the actual recording from the 
computer. If you wish to play back a call recording that has been archived and deleted from the 
system you will be instructed to insert the disk that hold the archived call recording. The system will 
then restore that call recording and can then be replayed. 

How To: Configure Call Recording Backups  

1) Select the Recording Backup button from the Call Recorder Configuration Dialog. 

 

2)  
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3)  

4) The backup folder MUST be one that is local (attached) to the call recording server. 

 

How To: Manually Start a Call Recording Backup  

1) Select the Recording Backup button from Configure Call Recording Backup Dialog. 

2) Enter the dates for the backup to apply to and press the Backup button. 

3)  

 

How To: Cancel a Running Call Recording Backup  

1) Select the Recording Backup button from the Configure Call Recording Backup Dialog. 

2)  

3) Press the Cancel Running Backup, This will instruct the call recording server to cancel any 
scheduled or manually started backups that are currently running. 
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Chapter 4 

MyCalls Screen Layout 

 

The Main Display 

The main screen for MyCalls can display any combination of real time information windows you wish 
to create in any position. In addition to real time windows you can also view call logs and other 
information from the Grid Bar at the bottom of the screen.   

 

Common features of real time information windows  

The windows visible on the MyCalls main screen are individually configurable. Depending on the 
type of screen they may have a number of options available. 
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Status and statistics screens all have the option to lock, Refresh and configure using the context 
menu which is viewed by right clicking the mouse whilst hovering over the window.  

Using the mouse you can hover over any real time window and press the right mouse button to get a 
menu of window options. 

 

The single parameter window menu has the following options available. 

Lock Position 

This allows you to lock a window in place on the screen layout so that it can no longer be re-sized or 
moved.  

 When a window is locked it loses its borders and if you right click on it again you will see a tick next 
to the Lock Position option.  To unlock a window select the Lock Position option again to remove the 
tick and display the windows borders again.  You should now be able to resize and move the 
window. 

 

Refresh Data 

Data is automatically taken from the database at prescribed intervals  

You can select the refresh data option to force the data of the window to be updated. This will force 
a retrieval of the data. 

Configure  

This option allows you to configure existing window settings. The actual dialog presented will 
depend on the window type displayed.  (See ‘real time window configuration’ for more details.) 
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The View Menu 

The MyCalls main screen provides a blank area onto which you can arrange various real time 
windows. In addition to the Real Time windows you can also view popup windows to allow easy 
access to the various logs which are recorded within the MyCalls database. These Log windows 
include Calls, Unreturned calls, Alarms and Audit logs. 

To access the log windows you can either select from the View menu where you will see selection 
checkboxes to show or hide the various log windows. Selecting either Call Records, Unreturned Calls, 
Alarms or Audit Log makes the associated window visible on the screen. 

 

In addition to the logs you can also enable the viewing of the main toolbar below the main menu at 
the top of the screen 

 

The Grid bar at the bottom of the screen 

 

The Status window found at the bottom of the screen. 
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Chapter 5 

Screen Layouts 

Introduction to Layouts 

Layouts are the view of MyCalls call manager that you see when you run the application. A layout is 
made up of pages. A page contains a particular arrangement of parameter windows and can be 
stored under a specific page name as part of a layout. Changes to the arrangement of a given page is 
automatically stored and recalled when the application is closed and reopened. 

Layouts (along with their pages) can be saved as public layouts.  

Pages are normally arranged so that parameter windows relating to a particular set of information 
can be grouped and viewed together without the screen becoming overburdened with unnecessary 
information. This is especially useful if for example you want to create a grouped view of 
departmental statistics.   

Other elements of a layout which you can customize are the toolbars displayed on screen.  You can 
choose to hide or display the main toolbar, grid or status bars.  The MyCalls window can be 
repositioned on your Call Control and resized so that the next time you open the application it 
recalls these settings and positions itself accordingly.    

 

Public and Local Layouts  

Local layouts are views that you create on your local machine. They viewed only on the computer on 
which they were created   
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To share your layout with other users you need to save it as ‘public’ in a location accessible by other 
users in the MyCalls database. Should you wish to share the layout with users on other sites or 
create a layout for general distribution then you can save the layout to a disk file. Agent Desktop 
users cannot open public Layouts or create their own layouts as they have a layout pre-assigned to 
them. 
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How To: Saving a public layout 

1) You can save screen layouts as public layouts in either the MyCalls database or to an external 
file.  This means that other users can load it and use it as a starting point to create their own 
layout. 

2) When you have finished configuring your layout as you want it be viewed, from the Layout menu 
select ‘Save Public’. 

 

3) You have two options for saving your layout.  You can either save it in the MyCalls database or 
you can choose a location on your computer or network and save it as a layout file (.lay file 
extension). 

4) To save to the MyCalls database select the option ‘Save to database’ and the Layout Name drop 
down list will become active.  Enter a new name for your layout to be identified by the system.  
If you wish to overwrite an existing layout in your database then select an existing item name 
from the list. 

5) To save your layout to an external file select the option ‘Save to external file’ and the Layout 
Name field below will become active.  Enter a path into the field manually or click the ‘Browse’ 
button to select a location to save your file to.  Enter a name for your file in the File Name field 
as shown in the image below and then press the ‘Save’ button to return to the Save Screen 
Layout window. 

6) When you have entered the required information to save your layout press ‘OK’ 

 

Once saved a layout can be reopened and used as the current layout. Opening a public layout simply 
creates a local copy of the layout which you are then at liberty to change. The changes you make to 
your local copy do not affect the original public layout in any way.  

How To: Opening a Public Layout  

1) You can load a public layout that a user has saved to either the MyCalls database or an external 
file.  Opening a layout will permanently overwrite your current screen layout.  All user types 
except AGENT DESKTOP users can open public layouts. 

2) If you are not a AGENT DESKTOP user then you can open a previously saved Public Layout from 
either a server or client machine. 

3) From the Layout menu select the option ‘Load Public’. 
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4) The Load Screen Layout window will be displayed.  If there are layouts saved in the MyCalls 
database then the Load from database will be selectable but if there are not then you can only 
load a layout from an external file. 

 

5) In the Layout Name field manually enter the file path to the layout you want to load or 
alternatively use the ‘Browse’ button to locate the file from your computer or network location 
as shown below using the ‘Open dialog’. 

6) When you have located the layout file press the ‘Open’ button to return to the Load Screen 
Layout window and then press the ‘OK’ button to load the layout into the MyCalls window. 

You can also delete public layouts if required. This only affects the public layout and has no impact 
on any other layouts which may have used this public layout in the past.  

How To: Deleting a Public Layout from the Database 

1) You may delete a screen layout from the MyCalls database so that it can no longer be loaded by 
other users.  Users that have previously loaded a layout before it is deleted will not be affected. 

2) To remove a saved public layout from the MyCalls database, select from the Layout Menu the 
option ‘Delete Public’. 

3) You will be displayed with the Delete Screen Layout window. 

 

4) From the Layout Name drop down list select the name of the saved layout you want to delete. 

5) Press ‘OK’ to delete the layout from the database.  You will be prompted to confirm the deletion 
process, to confirm press ‘Yes’ or to cancel press ‘No’. 

Agent Desktop users have very limited access to MyCalls features and have no control over the 
layout. An Agent Desktop will be assigned a layout by the supervisor and that layout will appear on-
screen as soon as the application is launched and the agent has logged in. 
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How To: Assign a Public Layout to an Agent Desktop User 

1) You can assign screen layouts to Agent Desktop users.  This means that the next time these users 
log on, they will view the layout assigned to them.  The Agent Desktop users are unable to 
modify the layout. 

2) To assign a layout to an Agent Desktop user select the ‘Assign’ option from the Layout menu. 

3) The Assign Screen Layouts screen will be displayed.  

 

4) Using the Layout Name drop down list you can select the name of the screen layout you want to 
assign to the Agent Desktop users. 

5) In the Assigned Users field you will see a list of all the Agent Desktop users configured within 
MyCalls.  You can assign the currently selected layout to the users by clicking the box to the left 
of the user’s name.  This will then display a tick to show that the user is assigned the currently 
selected layout.  You can remove the tick from a user to de-assign a screen layout from them. 

6) Press ‘OK’ to save the assign layout selection to the Agent Desktop users. 

Layout Pages 

Pages are the main component of a screen layout.  They enable you to display real time window 
information and arrange it in a way that best suits your organization.   

 

You can switch between saved pages of a layout by using the drop down list of pages within the 
main toolbar 
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 Creating New Pages  

How To: Creating new Pages 

1) From the layout menu select ‘Pages’ and click the ‘New’ option. 

2) You will be prompted to provide a name for your new layout page.  Enter a name and click the 
‘OK’ button. 

 

3) Your new page will now have been created and now be displayed on screen.  The page will have 
been added to the layout page selection tool in the main toolbar. 

 

4) You can now modify the page as per your requirements with real time window parameters 
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Deleting Pages 

How To: Delete Pages 

1) Select a layout page you want to delete using the layout page selection tool on the main toolbar. 

 

 

2) From the layout menu select the Pages sub menu and then click ‘Delete’  

3) You will be asked to confirm the deletion of the currently selected page.  Press ‘Yes’ to confirm 
the deletion or ‘No’ to cancel the process. 

4) The page will now have been deleted and removed from the layout page selection tool on the 
main toolbar. 

 Save All Pages 

How To: Save all Pages 

If you have been making a number of modifications to different pages in your layout you can save 
the work you have done across all pages by clicking the ‘Save All’ option in the Pages sub menu of 
the layout menu. 

 Copying Pages 

How To: Copy pages 

1) You may wish to create a page that is similar to an existing page you have available.  To cut 
down the time it takes to setup a page layout you can use the Copy Page feature in the Pages 
sub menu of the layout menu. 

2) You will be prompted to provide a name for your copied layout page.  Enter a name and click the 
‘OK’ button. 

 

3) A copy of your existing page will now be displayed and available from the layout page selection 
tool.  This new page should have the name you previously provided and you can alter existing 
settings to your requirements. 
 

 Reloading Pages 
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How To: Reload Pages 

1) If you have made significant changes to a layouts page, but decide that you preferred the pages 
the way they were before, then you can revert them back to their previous state so long as you 
have not saved the changes in the meantime. 

2) From the layout menu select the ‘Pages’ sub menu and then click on the ‘Reload’ option. 

3) Your pages will now be restored to their previous saved state without any unsaved changes you 
have made since. 

 View Screen as Agent Desktop User 

How To: View screen as an Agent Desktop User 

1) You can view your screen as an Agent Desktop user would see it by choosing the ‘View as Agent 
Desktop option’ from the Pages sub menu of the Layout menu. 

2) This will remove any real time window control boxes and lock the windows on the screen as they 
are positioned. 

3) To come out of the Agent Desktop view in order to move and re-size real time windows you can 
select the ‘Restore from Agent Desktop view’ from the ‘Pages’ sub menu of the ‘Layout’ menu. 

Resetting Installation Defaults 

How To: Reset to installation defaults  

1) If for whatever reason, you have got to the point where you wish you could start over again, you 
can. 

2) From the Layout menu select the option ‘Reset to Installation Default’ and this will reset all your 
layouts and pages back to how they were when the application was first installed. 
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Automatic viewing of multiple pages  

Having created a multiple page layout you can then view a single page using the drop down menu on 

the main toolbar. 

 

Alternatively by setting up a display sequence you can automatically display each page. The pages to 

be displayed are added into a display sequence. Your sequence can contain any or all of the pages 

you have created and they can be displayed in any order. There is also a timer for each page in the 

sequence so that you can vary the amount of time a particular page remains on screen. 

Set up the sequence as follows 

How To: Create a playback Sequence 

1) From the layout menu select ‘Screen Layout Pages->Display Sequence  

 

 

 

2) Using the displayed dialog select each page you wish to display from the available pages list. As 
you select each page click the select  button to add the page to the selected pages list.  
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3) For each page in the selected pages list you can change the number of seconds the page is to be 
displayed for. You can also alter the order in which the pages are to be displayed using the move 
up and move down buttons. 

4) To remove a page from the list click the deselect  button  

5) When you have made your selections click OK 

6) You can view the pages now by clicking the play icon from the main menu as shown below. 
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Tools to help you layout your pages 

As seen in the previous chapter each page within a layout can be populated with various windows 
e.g. incoming calls, outgoing calls. These windows can contain statistical information, graphs, web 
content and other forms of data. To help us arrange this content on our pages MyCalls provides a set 
of alignment and sizing   tools. Initially you will need to create the windows to be placed on the page.  
Once you have your windows on the page you can change their positions and sizes. 

Manual alignment and sizing 

Any window placed on a page may be positioned by simply clicking and dragging the window to the 
new position. The windows can be resized by clicking on the frame of the window and dragging the 
window. Clicking on the side of a window will allow you to expand the window’s width and clicking 
on the top or bottom of a window will allow you to expand the window’s height. Clicking on a corner 
of a frame will allow the window to be expanded in both directions at once. 

Selecting multiple windows 

In order to align or resize multiple windows we must select the required windows on screen. To 
select multiple windows simply hold down the control (Ctrl) key on your keyboard and click on the 
windows you wish to include in the selection. Each window will be highlighted with a border. When 
multiple windows are selected the ‘format menu’ will be enabled. The automatic alignment and 
sizing tools operate on the first window selected, this means that if you were aligning two windows 
to the left, then both windows would align to the first selected window. 

Automatic alignment and sizing 

Several automatic alignment and sizing tools are available for you to use when designing your page 
layouts.  These tools are located on the top toolbar or can be accessed via the ‘format menu’.  
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The format menu and the alignment tools (shown above) are disabled unless multiple windows are 
selected.  The options available are as follows. 

Alignment: 

Align Windows left: Align all selected windows to the left hand edge of the first selected window 

Align Windows Right: Align all selected windows to the right hand edge of the first selected window 

Align Windows Top: Align all selected windows to the top edge of the first selected window 

Align Windows Bottom: Align all selected windows to the bottom edge of the first selected window 

Align Centres Horizontally: Align selected windows along the horizontal axis 

Align Centres Vertically: Align selected windows along the vertical axis 

Sizing: 

Make heights equal: Set all selected windows to the same height 

Make widths equal: Set all selected windows to the same width 

Make heights and widths equal: Set all selected windows to the same width and height 

Distribution: 

Make horizontal spacing equal : Space the selected windows equally across the width of the screen 

Increase horizontal spacing: Increase the distance between selected windows across the screen 

Decrease Horizontal spacing: Decrease the distance between selected windows across the screen 

Remove horizontal spacing: Remove spacing between selected windows across the screen 

Make vertical Spacing equal: Space the selected windows equally across the width of the screen  

Increase vertical spacing: Increase the distance between the windows top to bottom  

Decrease vertical spacing: Decrease the distance between the windows top to bottom 

Remove vertical spacing: Remove the spacing between the windows top to bottom 
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Chapter 6 
Real Time Statistics 

Real Time Statistics Windows  

Real time statistics allow you to calculate a wide range of statistical values for all the devices, users 
and groups. The groups can either be predefined system groups or user defined.  The system groups 
are automatically created and devices are assigned to these system groups according to the device 
type e.g. Digital Desk Phones. User defined groups are created by the application users according to 
how the devices and users are used in the organisation e.g. Sales, Accounts. 

Statistical periods and calculations  

Statistics can be calculated in various ways depending on how you want to view your data. Each of 
the statistics windows allow you to select the period over which the statistics are calculated.  

Historical statistics 

These statistics are calculated differently depending on how you select the period. 

Daily: calculates a daily accumulated value or average which is reset each day at midnight. 

Hourly: Calculates accumulated or averaged statistics for each hour of the day. All values are reset 
at midnight.  

Current statistics 

Last Hour: These values are calculated as a rolling statistic over the previous 1 hour period, for 
example if the time is currently 14:30 then the current value calculated will be that value between 
13:30 and 14:30 

Types of Real Time Statistics window  

There are four types of real time statistics accessible via the real time information menu; Real Time 
Statistics (Grid View) windows, Single Value windows, Combination value and miscellaneous 
windows. 
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Real time statistics (Grid View) windows display a user defined selection of statistics for one or more 
devices or groups. 

Single value windows show an individual statistic in either a Numerical or Graphical format. 

Combination value windows show comparative statistics of different statistics on the same graph. 

Miscellaneous windows can display external data from XML, Database and other data sources and 
live web pages. 

Grid View Statistics windows:  

Select View -> Real Time Information -> Real Time Statistics from the MyCalls menu. 

This type of window allows you to view many statistics in the minimum screen area. You can 
configure group or individual statistics grid views. 

 

Real time statistics displayed in the grid view allows you to display cumulative call statistics on users, 
DIDs, extensions, DID groups, extension groups and trunk groups.  Statistics included by default 
include answered calls, abandoned calls, grade of service and abandoned grade of service although 
more fields are available to be added to the view if required. 

Daily/ Hourly Single Value windows:  

Single value windows provide numeric or graphical windows showing single value statistics based 
around Call Rate and Performance. Call Rate windows display numerical values only whereas 
performance statistics can display results as numerical values or graphical values. To show these 
parameters as a numerical value select the ‘Show Single Value’ in the configuration window. 
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Numerical values appear as a single coloured window showing the parameter value and other 
associated information such as Title, Group, and the Interval over which the statistic is calculated 
e.g. daily, hourly. 

Call Rate statistics show the cumulative counts for the various call types and you can elect to 
display these values over both historical (daily, hourly) periods and current (last hour) periods. 

Call Performance statistics are either cumulative totals e.g. number of long calls, or average 
values e.g. average wait time.  

The cumulative total statistics can only display values numerically and you can select both historical 
and current calculation periods. 

The Average value statistics can be displayed in both numeric and graphical format and the 
statistical period is limited to either ‘Daily’ or ‘24 Hour’ options. If you elect to display the values in 
numerical format you will need to select the ‘Show Single Value’ Checkbox in the configuration 
screen* and this option is only be available for the daily period.  

*See detailed configuration later in this section. 

 
Numerical View of average wait time statistic   

The graphical output displays the Min/Max values for the parameter as a bar and the average value 
is shown as a line graph over the 24 hour period. 
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Graphical view of Average Wait Time 24 hour  

Unreturned calls real time windows 

The unreturned calls operate differently to other real time statistics windows in that they can be 

displayed as a list format showing all unreturned calls currently active or they can be displayed as a 

single value window showing a total number of currently unreturned calls. 

You can create an unreturned calls window for each device type allowing you to show the 

unreturned calls for a specific group of devices such as extensions, DIDs etc. 

How To: Create an unreturned calls real time window  

Select View->Real Time Information->Single Value 

Select the type of device group you wish to filter the unreturned calls on so if you want to see all the 
unreturned calls coming into a group of DIDs then select DID groups -> call rate-> unreturned calls. 

Select Single Value or Call List depending on the display type you require  

Set the Interval period either to Last 24 hours or today which shows calls from midnight previous. 

Select the device group either system or user created group 

Click OK 
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Real time calls window configuration dialog 

The resulting windows look as follows: 

 Unreturned calls single value window 

 

Unreturned calls list window 
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Combination Value windows:  

Combination value windows provide graphical representation showing call volume histograms and 
the maximum and minimum number of calls mapped against average values. 

Combination values can only be displayed for historical statistics i.e. daily and 24hour and can 
display min/max bar charts for each hour and a line graph overlay showing the average values over 
time. 

 

 

Moving the mouse over the graph will show the Average and Min/Max values in a context window. 

 

 

The Combination values work best when looking at and comparing different call types such as 
Outgoing and Incoming calls. 
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Manipulating the Graphical displays 

Single value and Combination value windows can display results in graphical format. These graphs 
are easily manipulated to allow you to zoom into the area of interest as follows. 

How To: Manipulate the graph 

1) The original graph as seen above shows the activity over a 24 hour period, from midnight to 
midnight. Generally the data you will be most interested in is during your working hours, for 
example from 9 till 6. MyCalls allows you to zoom in on these areas so that you don’t get a lot of 
space where there’s no activity. 

2) To zoom in on a selected area click the mouse and drag across. For example, click the mouse at 
6am and drag to 6pm. 

3) A shaded area will appear over the selected area. 

 

4) Click to release, and a larger, zoomed in version will appear. 

 

5) Repeat this until you have the desired selected area. 

6) To return to the original graph click the minus  icon on the bottom left side of the graph. 
Click this several times. 

Configuring Real Time Statistics windows  

Group statistics windows 
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You can view a wide variety of statistics for groups by configuring group statistics windows. You will 
need to create a separate window for each type of group from DID, Trunk and Extension groups 
depending on what you want to view. Configuring the Group statistics window is the same in each 
case.  

The device groups are arranged under the menu options: 

 DID Groups 

 Trunk groups 

 Extension groups 

 

Individual statistics windows 

If you want to see statistics for individual devices or users these can also be configured. You can view 
individual statistics for Extensions, Users, DIDs and Pilot numbers. You will need to configure a 
different window for each category and the method of configuration is the same in each case.  

Individual statistics are arranged under the menu options 

 Extensions 

 Users 

 DIDs 

 

Available statistics 

Once you have created your statistics window you can view a wide range of values by selecting the 
value from the column chooser. This gives a list of columns which can be dragged across to the 
statistics window. The available statistics are as follows: 

Average incoming duration 

Average duration for incoming connected calls 

Average outgoing duration 

Average duration for outgoing connected calls 

Average total duration 

Average duration of all calls  
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Average abandoned call wait 

Average time that incoming abandoned calls were prepared to wait  

Average incoming call wait 

Average time that incoming connected calls were prepared to wait 

Long Abandoned wait 

Number of abandoned calls where the ring time exceeded the ‘ABD Ring’ (abandoned ring time) 
defined in the Grade of Service for that specific device or group. The ABD Ring setting is specified for 
groups of devices or users in the operational grade of service configuration and can vary between 
different groups.  

Long incoming calls 

Number of connected incoming calls where the duration exceeded the ‘Inc Call’ (maximum call 
duration) defined in the Grade of Service for that specific device or group. The Inc setting is specified 
for groups of devices or users in the operational grade of service configuration and can vary between 
different groups.  

Long incoming wait 

Number of connected incoming calls where the ring time exceeded the ‘Incoming Ring’ (maximum 
ring time) defined in the Grade of Service for that specific device or group. The ‘Incoming Ring’ 
setting is specified for groups of devices or users in the operational grade of service configuration 
and can vary between different groups.  

Total calls 

Total number of incoming and outgoing calls relevant to the specific group or device 

Total duration 

Total duration of connected incoming and outgoing calls calculated for a specific group or device 

Total abandoned calls 

The number of calls where the caller terminated the call before being answered by a group for a 
defined period 
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Creating Grid View real time statistics windows  

Real time statistics windows can be configured to show groups of devices or individual devices. In 
operation grouped devices are very useful as they show an overall set of values across several 
devices or users.   

How To: Creating a group statistics window for Extensions  Groups 

1) From the ‘View’ menu select the option ‘Real Time Information’ or select the  icon from the 
main toolbar. 

2)  

3) Expand the Real Time Statistics section by clicking the ‘+’ to the left of the text and then expand 
the ‘Extension Groups’ section. Highlight the Group Statistics option by clicking it and in the right 
side of the window click ‘Create a New Group Statistics View’.  

.  

4) If your MyCalls configuration is using more than one PBX then you can select between 
configured PBXs using the PBX drop down list. 

5) Group: Select an Extension Group or multiple groups from the list of available groups in the 
group list window.  By default selections for All Desk Phones, All Digital Phones, All Extension 
Types, All Non PBX Phones, All System Phones, All User PBX Phones, All User Phones, All Voice 
Mail Ports and Unassigned Extensions will be available.  Additional entries are configured 
through telephone configuration. 

6) Display Values: You can select to display either historic of current values.  If you choose 
historical then the intervals available will be either Daily or Hourly.  Daily will display statistics for 
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the current day whilst hourly will display the statistics for the current hour of the day.  If current 
only is selected then the intervals available are Last hour and this is rolling time period for the 
previous 60 minutes from the current time. 

7) Interval Period: After selecting the display values in instruction 6 choose the interval period 
from the interval period drop down list. 

8) Refresh Time: You can set the refresh time for when you want the statistics in the window to 
refresh.  By default this is set to 60 seconds. 

9) You can change the style of the title and statistics fonts for the window by using either the Edit 
Title Font button or Edit Status Font button and configuring the various style options. 

10) When you have completed the configuration of your windows settings then press the OK button 
and your window will be placed on the currently selected layouts page.  Press cancel at any time 
to abort the setup.  

 

11) Once the window is created you can add additional columns to what is setup using the Column 
Chooser.  If you want to remove any columns from the window then hold down the left mouse 
button on the column header you want to remove and drag the column out of the window area. 

Creation of individual device statistics window is a similar process to configuring a group window but  

How To: Creating an Extension statistics window 

1) From the toolbar click ‘View’ 

2) Select the option for Real Time Information or select the  icon from the main toolbar. 

3) Expand the Real Time Statistics section and then expand the Extensions section. Highlight the 
Extension Statistics option by clicking it and in the right side of the window click the task ‘Create 
a New Statistics View.’  

4) The real time extension statistics configuration screen will be displayed. (Note: in order for 
extensions to show up you need to enable real time statistics) 
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5) PBX: If your MyCalls configuration is using more than one PBX then you can select between 
configured PBXs using the PBX drop down list. 

6) Extensions: Select Extensions from the list of available devices in the Extensions list window.  If 
your extension does not appear here then it may need to be configured through telephone 
configuration. 

7) Display Values: You can select to display either historic of current values.  If you choose 
historical then the intervals available will be either Daily or Hourly.  Daily will display statistics for 
the current day whilst hourly will display the statistics for the current hour of the day.  If current 
only is selected then the intervals available are Last hour and this is rolling time period for the 
previous 60 minutes from the current time. 

8) Interval Period: After selecting the display values in instruction 6 choose the interval period 
from the interval period drop down list. 

9) Refresh Time: You can set the refresh time for when you want the statistics in the window to 
refresh.  By default this is set to 60 seconds. 

10) You can change the style of the title and statistics fonts for the window by using either the Edit 
Title Font button or Edit Status Font button and configuring the various style options. 

11) When you have completed the configuration of your windows settings then press the OK button 
and your window will be placed on the currently selected layouts page.  Press cancel at any time 
to abort the setup.  

 

12) Once the window is created you can add additional columns to what is setup using the Column 
Chooser.  If you want to remove any columns from the window then hold down the left mouse 
button on the column header you want to remove and drag the column out of the window area. 
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Single Value Windows 

Single Value windows are designed to display a statistic that is calculated in real time as each call is 
processed.  These values can either be displayed as a current value or as a range of values over a 
defined time period or interval, such as number of calls answered in each hour. Single value 
windows can only display information relating to a whole group of devices or users including account 
code groups, DDI groups, extension groups, organization groups and trunk groups. 
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 Account 
Code 

Groups 

DID 
 Groups 

Extension 
Groups 

Organisation 
Groups 

Trunk 
Groups 

Call Rate 

 

     

Incoming 
Calls 

          

Outgoing 
Calls 

         

Internal Calls         

Abandoned 
Calls 

          

 

Performance 

  

     

Avg. 
Incoming 
Call Wait 
Time 

          

Avg. 
Incoming 
Call, Call 
Time 

          

Avg. 
Outgoing 
Call, Call 
Time 

         

 Account 
Code 

Groups 

DID Groups Extension 
Groups 

Organisation 
Groups 

Trunk 
Groups 

Avg. Internal 
Call, Call 
Time 

        

Avg. 
Abandoned 
Call, Wait 
Time 

          

Avg. General 
Service Level 

          
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Avg. 
Abandoned 
Service Level 

          

No. Of Long 
Waiting 
Incoming 
Calls 

          

No. Of Long 
Incoming 
Calls 

          

No. Of Long 
Outgoing 
Calls 

         

No. Of Long 
Internal Calls 

        

No. Of Long 
Waiting 
Abandoned 
Calls 

          

Service Level           

Abandoned 
Service Level 

          
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How To: Creating a single value window 

1) Select the group you wish to show statistics for from the single value window list 

2) Select ‘Call Rate’ or ‘Performance’ 

3) Select the statistic that you wish to view from the list  

4) Click ‘Create a New Real Time Parameter Window’ 

5) In the dialog window that appears, you can alter the interval period, choose a group, alter the 
time and tick if you want to show a single value. 

 

6) The window will appear on the screen 

 

7) Click ‘OK’ 

Combination Value Windows 

A combination window displays several statistics at the same time.  These can be used to see how 
one value affects another, like a difference in call volume might result in customers receiving longer 
waiting times.  In this example more people are needed to answer calls to keep the wait time the 
same. 
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How To: Creating Combination Value Real Time Parameter windows  

1) Click to expand ‘Combination’ 

 

2) Select the group you wish to expand e.g. DIDs 

3) You are now presented with two options: clicking ‘call rate’ or ‘performance’ 

4) If you click call rate you will be presented with a call volume chart 

5) If you click performance, you will be presented with a chart of call wait time ranges. 

6) On both occasions the following window will appear: 

 

7) You can alter the interval period, the group and the refresh time. 

8) Click ‘OK’ 
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Removing a Real Time window 

To remove a real time window from your layout page, Press the  in the top right of the window 
and it will be deleted. 

How To: Configuring an existing Real Time window 

1) To change the configuration settings of a real time window, right click over the selected window 
with your mouse and select the ‘Configure’ option from the menu that appears near your cursor. 

2) You will then be presented with the configuration screen for that type of window and can 
amend the configuration settings to your requirements.  

 

3) Press ‘OK’ to apply the changes and view the newly configured window.   

4) Pressing the ‘cancel’ button at any time will abort the changes and revert back to the existing 
settings. 
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Viewing External data 

From the ‘View->Miscellaneous’ menu we can configure windows to view web based information or 
information stored in XML files or data sources such as a database. 

External Data from an XML source 

Viewing external data from an XML file allows you to display XML content either as a single item or 
as a grid. The system verifies the XML is valid and is capable of monitoring (watching) the file for any 
changes which occur within the file and updating the window with the latest data. This allows you to 
monitor such items as daily sales figures for instance. Alternatively you can set a timer which can 
update the window at preset intervals. 

The same principles apply to data extracted from a data source. Data sources can be conventional 
databases such as Microsoft SQL Server or ODBC based data sources such as spreadsheet files, 
accounts applications etc. 

Irrespective of whether you derive your data from an XML file or a data source the displayed 
information will be in tabular form (grid) or a single value.  

  

External data displayed as a grid 

 

External Data displayed as a single value 
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Using a Data Source for your data  

Where external data is derived from a data source the contents will be determined by an sql query. 
The query controls the source of the data and any ordering and filtering which needs to be applied. 
For a grid the column names will be determined by the column names of the query and the number 
of rows will match the rows returned from the query. It is reccomended that care be taken to ensure 
that the number of rows is kept to a small number to maintain performance. Where external data is 
displayed as a single value then the value displayed from a data source will be the first column of the 
first row returned in the SQL query.  

How To: Configuring an external  data source window 

1) Select View->Real Time Information->Miscellaneous->External data 

2) Select ‘Create a New External Data View’ from the right hand panel  

3) Set up the configuration options as follows: 

4)  

5) Import From: Data Source 

6) Display Type: select Single value or Grid dependent on the type of window required 

7) Database Type: Select SQL Server; OLE DB; ODBC; according to the type of data source you 
are deriving the data from. 

8) Refresh Time: determines the time interval between database queries.  

9) Connection String: Enter the text used to connect to your particular data source. 

10) SQL Statement: Enter your SQL query here 

11) Clicking the test button will check the connection and the query. If there is a problem then 
an error will be displayed, alternatively a message box will confirm the test was successful. 
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12) Title: If ‘Single Value’ has been selected then you may enter a heading for the window here. 
This will be overwritten by the column name if the test button is clicked. 

13) Click ‘OK’ to view your external data window 

 

Example: Viewing the contents of an SQL Server database 

To view data from an SQL server database you will neeed to enter a valid connection string and SQL 
query. The details of the connection string varies according to requirements but as a guide the 
following string contains the essential requirements 

Data Source=[SERVER NAME]; Initial Catalog={DATABASE NAME]; User ID=[USERNAME]; 
Password=[PASSWORD] 

The dialog below shows a typical setup.  

 

Example: Viewing the contents of an Excel file  

Excel files can be used as a data source using an ODBC connection. You will need to generate an 
system ODBC connection using the windows ODBC data source utility (See Microsoft documentation 
on creating an ODBC connections). This defines the Excel file to be used as a data source. 

Having created the ODBC connection you simply need to specify the DSN name you have created as 
the connection string as follows. 

DSN=[DSN NAME] 
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The sql query is specific to the excel data source but accessing a specific spreadsheet is as simple as 
specifying the following SQL 

Select * from [sheet1$] 

Where sheet1 is the name of the particular spreadsheet within the excel file. 

 

 

Using an XML file for your data  

If you are going to use an XML file as a source of data for your external data window then you will 
need to ensure that the file contains the correctly formatted and valid XML. The XML file cn contain 
both single value data definitions and multiple column data definitions. 

The file must commence with a valid XML definition: 

<?xml version="1.0" encoding="utf-8" ?>  

 All XML files must contain the following element 

<DataValues> 

If you are storing single values then the file must contain the following element  

<SingleValue> 
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For each parameter which can then be viewed as a single value within a window you must define a 
<Param> Node as follows   

 

<Param> 

   <name /> 

   <value /> 

   <minvalue /> 

   <maxvalue /> 

  </Param> 

There can be one or more <param> nodes the sub-nodes are: 

Name: defines the name of the parameter.  

Value: defines the value of the parameter. 

Minvalue and Maxvalue: define the limits of the parameter value if the value is numeric 

 

The Single value definition would look like this: 

<DataValues> 
 <SingleValue> 
     <Param> 
         <name>Top Sales</name> 
         <value>Tom</value> 
         <minvalue>-1</minvalue> 
         <maxvalue>-1</maxvalue> 
     </Param> 
     <Param> 
         <name> Sales Value</name> 
         <value>1000</value> 
         <minvalue>-1</minvalue> 
         <maxvalue>-1</maxvalue> 
     </Param> 
     <Param> 
         <name>Number of Orders</name> 
         <value>31</value> 
         <minvalue>-1</minvalue> 
         <maxvalue>-1</maxvalue> 
     </Param> 
</SingleValue> 
</DataValues> 
 

The resulting display could look like this. 
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You could also create separate windows for’ Sales Value’ and ‘Number of Orders’ 

 

 

 

 

Multiple Column XML values 

Multiple columns must contain the following nodes 

First define the columns 

<GridValue> 

  <Param> 

   <name>Sales</name> 

     <columns> 

 <column minvalue=”-1” maxvalue=”-1” /> 

  <name>Operator</name> 

 </column> 
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 <column minvalue=”-1” maxvalue=”-1” /> 

  <name>Sales Value</name> 

 </column> 

 <column minvalue=”-1” maxvalue=”-1” /> 

  <name>Orders</name> 

 </column> 

     </columns> 

 Then define the row content 

     <rows> 

       <row> 

           <value>Tom</value> 

           <value>9200</value> 

           <value>7</value> 

       </row> 

       <row> 

           <value>Andy</value> 

           <value>8100</value> 

           <value>5</value> 

       </row> 

       <row> 

           <value>Wendy</value> 

           <value>5630</value> 

           <value>4</value> 

       </row> 

     </rows> 

  </Param> 

 </GridValue> 

 The resulting grid would look like this. 
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How To: Configure an XML external data window 

1) Select View->Real Time Information->Miscellaneous->External Data  

2) Select Create New External Data View 

3)  

4) Select the parameters in the dialog as follows: 

5) Import From: XML 

6) For a single value windows select the following settings 

7) Display Type: Single Value 

8) File Name: Browse for the XML file you are using as your data source 

9) Watch File: Select if you wish changes to the file to be reflected in the window 

10) Check File: select this if you want to refresh the file contents at intervals specified in the 
Refresh time setting 

11) Single Item to Display: Select the Item to display in the window. This will be one of the 
‘param’ names defined in the file. 

12) Title: Define the window title 
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For a multiple column grid select the following values 

1) Display Type: Grid 

2) File Name: Browse for the XML file you are using as your data source 

3) Watch File: Select if you wish changes to the file to be reflected in the window 

4) Check File: select this if you want to refresh the file contents at intervals specified in the 
Refresh time setting 

5) List to display: Select the list of values to display. The XML file may contain several 
<gridvalue> node sets. 

6) Click ‘OK’ 

 

Web Browser 

External Data Windows can be used to view websites which can be used to enhance the information 
visible on your wall board by displaying data from external websites or internal company intranets. 

Configuration is very simple and you can include basic navigation which allows you to go back to 
your home page or track backwards or forwards between pages you have visited. 

How To: Configure a web browser window 

1) Select View->Real Time Information->Miscellaneous->Web Browser  

2) Select ‘Create New Web Browser’ 

3) Home Page: Enter the web address of the page you wish to view  

4) Allow Navigation: displays back, forward and home navigation 

5) RefreshType: Automatic refreshes the page according to the refresh time setting, Manual 
requires user to manually refresh the page. 
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A Configured Web Browser window 
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Chapter 7 

 Telephone System Configuration 

Configuration options 

Before you can use MyCalls applications you will need to run the configuration utility. To do so you 
will need to gather, at a minimum, the following information about your telephone system: 

Trunks: The type and number of trunks connected to the PBX switches that MyCalls will be 
monitoring. For example are your trunks ISDN (BRI or PRI), analogue, mobile gateway etc. 

Extensions: An itemized list of extensions along with their groupings either by location or business 
function.  Ideally identify who is the regular user for each extension (Default User)   

DID Numbers: If your organization uses DID numbers, you will need a list of them and their function 
or the name of the person who will be receiving calls to that DID. In most cases it is better to specify 
a business function to a DID e.g. Sales enquiries, Support etc. 

If you are planning to configure organizational information such as users and user-groups then you 
will also need to gather information about who will be using the telephone system and how their 
roles are organized. 
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Quick tip:  

Managing devices properly 

Setting up devices properly can sometimes prove difficult especially if you have a large 
configuration to deal with. Some tips for finding and managing devices and groups are:  

Look for devices in their System groups as well as their logical groups. If you know a 
device is a specific type then look in the system group for that type. 

Make your groups as small as possible so making individual devices easier to locate  

Name your groups so they make sense to you and your users  

Only enable statistics for devices if you really need to as it impacts on system 
performance 

 Regularly check for unassigned devices and remove them from the configuration if 
possible 

Use device import as the preferred method of configuring your devices and users  

 

 

Accessing configuration options using the menu  

Using the MyCalls configuration menu you can access the configuration screens using: 

Configure -> Telephone Systems -> PBXs  

To configure Devices, Call Recording and Groups Double click the PBX (in most cases there will be 
only one). 

 

 

Configuration Essentials  

Accessing configuration options  using toolbar shortcuts  

On the MyCalls toolbar Click on the  Icon 
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What to Configure 

The available options will vary depending on the level of product you have purchased. The 
following guide covers all possible configuration options.  

Essential features 

In order to configure MyCalls you must be logged on as a PBX Administrator (for more details on 
user privileges see the section on Organisation and Users).  

The MyCalls Configuration menu provides the following configuration selections: 

Telephone System: Configure details for your PBX switches, Telephone extensions, Trunks, DID’s 
Account codes, call recording agent. 

Organisation: Configure the users and departments within your organization and set user 
privileges. 

Callers: Define people who call you, or conversely people who you call on a regular basis. Identify 
callers according to organization or purpose of call e.g. business or personal callers and create your 
own caller groups so you can monitor how much time is spent dealing with various organizations. 

Costs: Configure a wide range of call costing parameters to allow you to track the costs incurred, 
specify least cost routing and deal with multiple carriers for your call routing. 

Alarms: Manage your business effectively by configuring alarms to alert you when an exception 
condition occurs. You can generate reports to show where and when these alarm conditions have 
occurred. You can monitor call rates, performance, emergency calls, disallowed calls etc and assign 
these to; groups, devices and users. Alarms can be flashed up on the screen and distributed via 
email. 

System Settings: Allow setting up of an email and FTP server for distribution of alarms and reports. 

Operational settings: Grace periods allow you to ignore invalid ring times or call lengths and can 
be configured differently for each Group of devices. Grade of service settings allow you to specify 
when a call has lasted too long or when the ring time was too long.  

Minimum Configuration 

At the minimum you will need to configure: 

 Trunks:  Carry all calls to and from your organization and are the key mechanism employed by the 
application when recognizing calls.   

Extensions: These represent the physical telephones available in your organization. Extensions 
come in a wide variety of types ranging from traditional, analogue phones, digital phones, VoIP 
phones etc.   

DID’s: If you use DID numbers within your organization you will need to configure them so that 
MyCalls is able identify and group calls to each DID or DID group. 

Call recording: If you are using call recording then you will need to configure your call recording 
settings before you can match your calls against their recordings. 

Optional features 

Alarms: You will need to configure the alarm conditions relevant to your organization dependent on 
what you want to monitor 
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Automatic Device Configuration 

MyCalls will automatically configure devices as they become visible on the system. If a call appears 
on an extension then that extension will be added to the list of devices if: 

 The device does not currently exist 

 The device has not been manually deleted from the list. 

The devices which can be automatically configured are: 

Extensions, DIDs, Account Codes, Trunks. 

Following an install of the system it may be advisable to allow a period of several hours whilst the 
system auto-configures the most regularly used devices. You can regularly check for devices which 
have been auto-configured by running the system report – ‘Auto Configured Devices’. However, 
don’t rely on Auto-Configuration, create them upfront if possible. 

Quick tip:  

Automatic configuration of devices 

MyCalls will automatically add new devices to its list of configured items if they appear as a result of a  
call. These devices will be added to the appropriate list of devices if the particular value does not already 
appear in the list. For example any extension numbers which appear as a result of calls will be added to 
the extensions list.  

If you delete a particular instance of a device from the list then it will not be added to the list in future.  

This applies to all devices but the information for that device must also be available from the PBX sw itch. 
For further details on which features are supported by your PBX switch please contact your switch 
maintainer.  

All devices added due to auto-configuration will have the type of ‘unassigned’ and a created user of ‘auto 
configuration’ 

General Configuration Tasks for devices  

Configuration of devices follows a similar set of operations for each type of device: 

 Decide on what devices you are going to configure 

 Arrange you devices into functional groups to allow more meaningful reporting or screen 
displays 

 Create the device groups 

 Create the devices 

 Assign an identifier to the device e.g. extension number or DID number, specify device 
specific information, assign users to the device and configure all device options. 

 Assign the devices to their respective groups. 
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Ranges of items 

How To: Creating an item or range of items 

1) From the device configuration window e.g. Configure -> Telephone systems ->Devices -
>Extensions select the ‘Create a range of’ option 

 

2) Select the number of devices to create 

3) Enter the start value for the device number e.g. create 100 extensions starting at 201 will create 
extensions 201 to 301 

Optional steps 

4) Assign a type to the device e.g. Digital Desk Phone 

5) Assign the devices to a group  

6) Add any relevant notes 

7) Click ‘OK’ 
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Deleting an item or range of items 

How To: Deleting an item or a range of items 

1) Deleting an item or a range of items requires the same process for Extensions, Trunks, DIDs, 
Account Codes. The steps below will describe the deletion process with the example of 
extensions. 

2) From the MyCalls Telephone System Configuration screen, click ‘Extensions’ 

3) Click ‘Delete a Range of Extensions’ 

4) In the dialogue box that appears, select the extensions you wish to delete in the extension list.  
You can select multiple extensions by holding down the control key (ctrl) as you click on the 
rows.  

 

5) Click ‘OK’ to complete the deletion process.  Be aware that you will not be prompted to confirm 
this process once you press the OK button so please make sure you have the right codes 
highlighted before pressing OK to continue.  
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PBX Configuration 

Single PBX configurations 

 

PBX Configuration takes place during the system installation. The Application has been set up to 
recognise the PBX which controls your telephone system. MyCalls links to the PBX and records the 
telephone call data and for most installations there will probably be one PBX. 

How To: Alter the PBX configuration  

1) Select the PBX from the telephone system configuration. Configure->Telephone System -> PBXs -
>head office 

2) Click ‘Edit PBX Configuration’ 

 

3) You are presented with a dialog panel which allows the editing of various parameters (not all 
these parameters can be changed). 

 

4) PBX Code: (read only) Displays the PBX Code (name) assigned to the PBX. 

5) Area Code: your local area code allows MyCalls to recognize local calls. 

6) International Code: Enter your international code  

7) Country (read only) 

8) Edit Country numbering plan – (see next section) 

9) Admin User: Allows you to set a default admin user for the PBX as follows 

10) Click ‘Select’ – Select User dialog appears. 

11) Type the initial of the user you wish to set as the admin user 
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12) Select the user from the list and click ‘select’ 

13) Click ‘OK’  

14) Setting an Admin user creates a default email address to which various admin level reports such 
as audit logs will be automatically sent. 

Country Numbering Plans   

How To: Creating Country Numbering Plans  

1) To cater for numbering systems in different countries, MyCalls allows the entry of various parts 
constituting a telephone number.    

 

2) Costing Type: defines the country costing schema used for this PBX 

3) Trunk Prefix: First digit of a non local number 

4) The minimum and maximum number of area code digits 

5) Minimum and maximum number of subscriber digits 

6) Specify whether the numbers are fixed format i.e. the same number of digits for all numbers 

7) Click ‘OK’ 

  

Device Configuration 

Types of devices 

Devices configurable within MyCalls are as follows: 

 Trunks 

 Extensions 

 DIDs – Direct Inbound Dial numbers 

 Account codes 
 

Trunks 

Trunks (Lines) are devices that connect the PBX to other switching devices such as the PSTN or 
another PBX.  Trunks come in various types ISDN, Analogue, TCP-IP or Q-SIG depending on what the 
PBX is connecting to. 
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 Organising and Naming Trunks      

We need to define trunks for the following reasons: 

 We can report on trunk usage.  

 Analyzing overall performance of our telephone system helps us to identify weaknesses in 
the system at the physical level e.g. have we enough trunks. 

 We can view the overall call statistics of our entire telephone system 

 Required to configure Call recording which is licensed on a trunk by trunk basis 

 Helpful when Identifying faults on your telephone system if, for example, a trunk is showing 
abnormally low usage 

 

Assigning and grouping Trunks  

Generally the MyCalls installer would create the trunk configuration as they would know the types of 
trunks available in the telephone system. It is important that the trunks are assigned correctly as this 
will allow you to correctly configure your statistics windows and reports. In addition your call 
recording configuration is assigned to record on specific trunks. 

For Example; You have a 30 trunk PRI connection, a 2 trunk BRI connection linked to a GSM gateway 
for mobile calls and 2 Analogue lines linked to the company fax machines.  

You could create several groups as follows 

 BRI group – contains all BRI trunks 

 PRI group – contains all PRI trunks 

 Faxes group – contains all analogue fax lines 

With this configuration you could report on usage in the following ways 

 Overall calls in and out on all trunks 

 Call statistics for the PRI trunks (main telephone traffic) only 

 Call statistics for GSM gateway (mobile) calls 

 Detect any mobile calls being routed via the PRI trunks 

 View real time call data for each group of trunks 

Creating and editing Trunks 

How To: Creating a single Trunk 

1) From the MyCalls Telephone System Configuration screen, click ‘Trunks’  
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2) Click ‘Create or Edit a Trunk’ in the Trunk configuration area.  The Edit Trunk screen appears.  

3) Click ‘Add New Trunk’.  

4) In the dialogue window that appears a number of fields are available for entry.  Some are 
mandatory fields* for successful setup whilst others are optional inputs as outlined below. 

 

5) Number*: Enter here the trunk number you wish to create.  This must be a valid trunk 
configured on your telephone system. 

6) Name*: Enter a name for your trunk to identify its use.  If left blank the system will populate this 
field with the number 

7) Trunk Group: You can select a trunk group to group this trunk number under.  The values in this 
list are configurable under Trunk Groups.  The default value is set as none. 

8) Type: Select a trunk type from the drop down menu 

9) Alternate Carrier: An alternate carrier can be assigned to a trunk.  This means that calls made on 
this trunk can have different costings applied to the standard one. 

10) Click ‘OK’ 

 

Creating a range of Trunks 

How To: Creating a range of Trunks 

1) From the MyCalls Telephone System Configuration screen, click ‘Trunks’ 

2) Click ‘Create a Range Trunks’ in the Trunk Configuration area. 

3) In the dialogue window that appears, a number of fields are available for entry.  Some are 
mandatory fields* for successful setup whilst others are optional inputs.  
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4) Number of trunks*: Enter the number of trunks you wish to create in the range.  

5) Start Trunk Number*: Enter the number to start your trunk range from here.   

6) Trunk Group: Select the trunk type from the drop down menu 

7) Alternate Carrier: Assign an alternate carrier to the trunk range.  This means that calls made on 
this trunk can have different costings applied. 

8) Click ‘OK’ 

 

A block of trunks will now have been inserted into the Configured Trunks list box. You should 
configure these trunks with appropriate name and options using procedures described later in this 
topic before clicking the ‘OK’ button to complete your trunk creation process.  Note that the trunks 
you create should correspond to those configured in the telephone system. 

Editing existing Trunks  

How To: Editing existing Trunks 

1) From the MyCalls Telephone System Configuration screen, click ‘Trunks’. 

2) Click ‘Create or Edit a Trunk’ in the Trunk configuration area. The Edit trunk screen appears. 

 

3) In the dialog box that appears click the ‘Edit…’ button to the right of the trunk you want to edit. 

4) In the second dialog box that appears, configure a Name for the trunk and if required, select a 
trunk Group, trunk Type and assign an alternate carrier. 

 

5) Click ‘OK’  

6) Repeat these stages for as many trunks as you need to configure. 

7) Click ‘OK’ to save all the changes you have made. 

 

Extensions 

An extension (station) is setup to be a pre-defined type.  A user extension would be typically setup as 
a desk phone, cordless phone or cellular phone type.  A system installer also uses extensions to 
configure devices such as auto-attendants, voice mail ports, and announcement ports. 
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Organising and Naming Extensions  

Creating and Editing Extensions  

How To: Creating a single Extension 

1) From the MyCalls Telephone System Configuration screen  Click on ‘Extensions’ 

2) Click ‘Create or edit an extension’. The edit Extensions screen appears. 

3) Click ‘Add new extension’   

4) In the dialog window that appears a number of fields are available for entry.  Some are 
mandatory fields* for successful setup whilst others are optional inputs as outlined below. 

 

5) Number*:  Enter the number of the Extension you wish to create.  This must be for a valid 
extension number configured on your telephone system. 

6) Name*: Enter a name for your extension to identify its use.  If left blank the system will populate 
this field with the Number.   

7) Extension Group: You can select an extension group to group this device under.  The values in 
this list are configurable under Extension Groups.  The default value is set as None.   

8) Enable real time statistics: This option should be enabled if you want call data collected from 
the telephone system for this extension to be included in the real time statistics.  It is good 
practice for extensions not used to have this option disabled so as to minimize unnecessary 
processing. 

9) Enable for Hot Desking: Makes the extension available for inclusion in list of available extensions 
when logging in to MyCalls 

10) Default User:  Specify a default user using the select button (See default user section). You can 
assign a default user to an extension to enhance reporting.  A default user is someone who 
regularly uses the extension.  

11) Type: Select the extension device type from the drop down menu.   

12) Voicemail Timeout: If the Type field is set to either auto attendant, voice mail or announcement 
port then setting a voice mail timeout will cause any incoming calls to the extension connected 
for less than the voicemail timeout to be marked as abandoned. 

13) Click ‘OK’ 
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How To: Creating a range of Extensions  

1) From the MyCalls Telephone System Configuration screen Click ‘Extensions’ 

2) Click ‘Create a range of extensions’. 

3) In the dialogue window that appears a number of fields are available for entry.  Some are 
mandatory fields* for successful setup whilst others are optional inputs as outlined below:  

 

4) Number of extensions*: Enter here the number of extensions you wish to create in the range.   

5) Start Extension*: Enter the number to start your extension range from here.   

6) Extension Group: You can select an extension group to group this range under.  The values in 
this list are configurable under extension Groups.  The default value is None.   

7) Click ‘OK’ 

 

How To: Editing existing Extensions  

1) From the MyCalls Telephone System Configuration screen, click ‘Extensions’ 

2)  Click ‘Create or Edit an Extension’ in the Extensions configuration area. 

3) In the dialog box that appears click the ‘Edit…’ button to the right of the Extension you want to 
edit. 
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4) In the second dialog box that appears, configure a Name for the Extension, and if required select 
an Extension Group and Extension Type. 

 

5) Click  ‘OK’  

6) Repeat these stages for as many Extensions as you need to configure 

7) Alternatively, you can edit the rows without clicking ‘edit’. Click in the name column and enter a 
name, click in type column and select a type from the drop down menu, and click in the group 
column and assign the person to a group. If you would like to enable statistics for a particular 
person, tick the box in the enable statistics column. 

8) Click ‘OK’ to save all the changes you have made 

 

How To: Importing Extensions 

Browse to the import template under Start>Computer>C:>Program Files*>NEC 
Infrontia>MyCalls>Import.xls 

*If you are running on a 64-bit operating system, the correct folder will be ‘Program Files (x86) 

Click on the ‘Extensions’ tab at the bottom 

 

Copy and paste the headers into a new Excel spreadsheet. 

Enter the appropriate information under each header. These headers are: 

Number: The number of the extension. 

Name: The name of the extensions. This is usually the name of the user that the extension is 
assigned to. 

Hot Desking: Whether or not the extension is enabled for hot desking. To enable hot desking, input 
TRUE into the field. If hot desking is not going to be enabled with this extension, input FALSE. 

Statistics: Whether or not the extension is enabled for statistics. To enable statistics, input TRUE into 
the field. If statistics are not going to be enabled with this extension, input FALSE. 

Computer: The name of the computer that the extension is assigned to. In order to work, the 
computer name needs to be complete with the network that he computer is connected to e.g. 
Kelmar-Software\Training1. This field is not mandatory and can be left blank. 
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Once you have entered all of the required information, click ‘Save’ 

From the ‘Save as type’ drop-down menu box, select ‘CSV (Comma delimited) (*.csv)’ 

Give the file an appropriate name e.g. ‘Extensions Import File’ 

Save the file in a memorable location 

 

Open MyCalls 

Log in as a user with administrative privileges. Otherwise, log in as ‘Installer’. 

Click ‘Configure’>’Telephone System’>’PBXs’>’Head Office’>’Devices’>’Extensions’ 
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Select ‘Import Extensions’ in the right hand panel  
 

 

Browse to the CSV file  

Check the ‘First line contains column headers’ box 

If you wish to create basic users from this information, check the ‘Create Users for named 
extensions’ box 

Select the group that you wish to add the users to 

Click ‘Load’ 
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Click ‘OK’ 

Click ‘Create or Edit an Extension’ in the right hand panel 

Here you will see the extensions that you have imported.  

 

 

 

DIDs 

DIDs (Direct Inbound Dials) are numbers that customers dial to reach either an individual (personal 
DID) or a specific group.  DIDs can be published to customers and reports can be generated to 
identify which DIDs are the most effective. 
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Creating and Editing DIDs 

How To: Creating a single DID 

1) From the MyCalls Telephone System Configuration screen, click ‘DIDs’. 

2) Click ‘Create or Edit a DID’ in the DID configuration area.  The Edit DID screen appears. 

3) Click the ‘Add New DID’ button. 

4) In the dialogue window that appears a number of fields are available for entry.  Some are 
mandatory fields* for successful setup whilst others are optional inputs as outlined below. 

 

5) Number*: Enter here the number of the DID you wish to create.  This must be for a valid DID 
number configured on your telephone system 

6) Name*: Enter a name for the DID to identify its purpose. If left blank the system will populate 
this field with the Number.   

7) DID group: You can select a DID group to group this number under.  The values in this list are 
configurable under DID Groups.  The default value is set as None.   

8) Enable real time statistics: This option should be enabled if you want call data collected from 
the telephone system for this DID to be included in the real time statistics.  It is good practice for 
DIDs not used to have this option disabled so as to minimize unnecessary processing. 

9) Click ‘OK’ 

 

How To: Creating a range of DIDs  

1) From the MyCalls Telephone System Configuration screen, click ‘DIDs’ 

2) Click ‘Create a Range of DIDs’ in the DID configuration area. 

3) In the dialogue window that appears a number of fields are available for entry.  Some are 
mandatory fields* for successful setup whilst others are optional inputs 
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4) Number of DIDs*: Enter here the number of DIDs you wish to create in the range.  

5) Start DID*: Enter the number to start your DID range from here.  This must be the starting 
number for a valid DID range configured on your telephone system. 

6) DID group: You can select a DID group to group this range under.  The values in this list are 
configurable under DID Groups.  The default value is None.   

7) Click ‘OK’ 

 

A block of DIDs will now have been inserted into the Configured DIDs list box. You should configure 
these DIDs with appropriate names and groups using procedures described later in this topic before 
clicking the ‘OK’ button to complete your DID creation process.  Note that the DID numbers you 
create should correspond to those configured in the telephone system. 

How To: Editing existing DIDs 

1) From the MyCalls Telephone System Configuration screen, click ‘DIDs’ 

2) Click ‘Create or Edit a DID’ in the DID configuration area. The Edit DID screen will appear. 

3) In the dialog box that appears click the ‘Edit…’ button to the right of the DID you want to edit. 

4) In the second dialogue box that appears, configure a Name for the DID and if required select a 
DID Group and enable or disable the real time statistics option for this DID. 

 

5) Click ‘OK’ 

6) Repeat these stages for as many DIDs as you need to configure 

7) Click ‘OK’ to save changes 

 

Account Codes 

Account codes are numbers entered by the person answering the call and are usually assigned to a 
customer, a project, department, marketing campaign or any other business function.  Reports can 
then be run against these account codes to identify the calls assigned to that particular code. 



Telephone System Configuration 

 

   Chapter 7-20  
 

Create/Edit Account Codes 

How To: Creating a single Account Code 

1) From the MyCalls Telephone System Configuration screen, click ‘Account Codes’ 

2) Click ‘Create or Edit an Account Code’.  The Edit Account Codes screen appears. 

3) Click ‘Add New Account Code’. 

4) In the dialogue window that appears, a number of fields are available for entry.  Some are 
mandatory fields* for successful setup whilst others are optional inputs as outlined below. 

 

5) Number*: Enter here the number of the account code you wish to create.  This must be for a 
valid account code configured on your telephone system. 

6) Name*: Enter a name for your account code to identify its purpose.  If left blank the system will 
populate this field with the Number.   

7) Account Code Group: You can select an account code group to group this code under.  The 
values in this list are configurable under Account Code Groups.  The default value is set to None.   

8) Click ‘OK’ 

 

How To: Creating a range of Account Codes  

1) From the MyCalls Telephone System Configuration screen, click ‘Account Codes’ 

2) Click ‘Create a Range of Account Codes’  

3) In the dialogue window that appears a number of fields are available for entry.  Some are 
mandatory fields* for successful setup whilst others are optional inputs. 
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4) Number of Account Codes*: Enter here the number of account codes you wish to create in the 
range.   

5) Start Account Code Number*: Enter the number to start your account code range from here.  
This must be the starting number for a valid account code range configured on your telephone 
system. 

6) Account Code Group: You can select an account code group to group this range under.  The 
values in this list are configurable under Account Code Groups.  The default value is set to None.   

7) Click ‘OK’ 

A block of account codes will now have been inserted into the Configured Account Codes list box. 
You should configure these account codes with appropriate names and groups using procedures 
described later in this topic before clicking the ‘OK’ button to complete your account code creation 
process.  Note that the account code numbers you create should correspond to those configured in 
the telephone system. 

How To: Editing existing Account Codes  

1) From the MyCalls Telephone System Configuration screen, click ‘Account Codes’ 

2) Click ‘Create or Edit an Account Code’ in the Account Codes configuration area. 

3) In the dialogue box that appears click the ‘Edit…’ button to the right of the account code you 
want to edit. 

4) In the second dialog box that appears, configure a Name for the account code and if required 
select an Account Code Group. 

 

5) Click ‘OK’  

6) Repeat these stages for as many account codes as you need to configure 

7) Click ‘OK’ to save all the changes you have made 
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Group configuration 

Grouping devices allows you to monitor and report on overall performance of areas of your business 
rather than individuals. You can also analyse individuals within a given group and ignore other 
devices or compare one group against another. 

The first step in creating a group of devices requires you to gather information regarding groups of 
devices such as extensions or DIDs. Once you have done this, creating a group of devices is 
straightforward. 

Creating and organising your groups is similar regardless of the device type being grouped  

You can create and populate groups of any device type and name that group according to function 
e.g. Sales, or to location, e.g. Dave’s office or to indicate a device type e.g. BRI trunk 1. Some devices 
have some predefined groups namely Extensions and Trunks. Having predefined groups for these 
devices is a convenience but normally you will expect to create your own user defined groups 

Viewing groups 

To view the members of a group click on the Group required and select ‘View or Edit the group’. The 
group members are listed in a grid. You can sort the members in different ways by selecting the 
column header. For example, to list the extensions in an extension group in order of extension 
number click on the ‘Number’ column, alternatively to list by Name in alphabetical order click on the 
‘Name’ column and so forth. 

Identifying stray devices using ‘Unassigned’ groups  

It is good practice to assign you various devices to custom groups that you have created. Any devices 
that are not specifically assigned to a group will remain in the unassigned group. By viewing the 
unassigned group for a particular device or by running a report to list the unassigned devices you can 
quickly track down any devices that have not been accounted for. These devices may be either 
unused, incorrectly configured or have been automatically configured and not yet assigned. 

You can also identify infrequently used devices by running the system report designed for that 
purpose (See reporting). 

User Defined Groups 

Creating a user defined group 

To configure Groups Double click the Configure -> Telephone Systems ->PBX (in most cases there will 
be only one). Click on the ‘Groups’ icon and select the group type. 
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The instructions of how to create a group are the same for extensions, trunks, account codes etc. 
The following examples are with the use of extensions: 

How To: Creating a group 

1) From the MyCalls Telephone System Configuration screen, click ‘Extension Groups’ 

2) Click ‘Create an Extension Group’ in the Extension Groups configuration area.  The Create a New 
Extension Group screen appears. 

3) In the dialog window that appears, a number of fields are available for entry.  Some are 
mandatory fields* whilst others are optional as outlined below. 

 

4) PBX Code: This field is filled with the assigned name of the PBX currently being configured. (Read 
Only) 

5) Name*: Enter a name to identify the Extension group for reporting on. 

6) Click ‘OK’ 

Once the device group has been created you should add devices to it. You can either, open the 
group editing- view and add new devices or you will need to edit existing devices in order to add 
them to your new group. 

How To: Adding an existing device to a group 

1) From the MyCalls Telephone System Configuration screen, click to expand ‘Extensions’ 

2) Click on ‘Create or edit an extension’ 

3) A dialog showing existing extensions will appear 

4) From the list of extensions find the extension you wish to add to the group 

5) Click in the group column and select the group you wish to add the extension to 

6) Repeat this for any other extensions   

7) Click ‘OK’ 

8) Your extensions are now assigned to the user defined groups 

 

Having added devices to a group you can then go back and edit the device attributes from within the 
group window. 
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How To: Editing devices within a group 

9) From the MyCalls Telephone System Configuration screen, click to expand ‘Extension Groups’ 

  

10) Select the group you want to edit. Click ‘View or Edit the Group’ in the Extension Group 
configuration area.  

11) If the group already contains devices then you can edit each device as described below. 
Alternatively you can press the ‘Add New Device’ button and this will display the device 
configuration dialog as described previously. Once configured press ’OK’ and the new device will 
be added to the group. 

 

12) In the dialog box that appears you can change the extension name, choose the type of device, 
change group membership, edit the device and choose whether to enable statistics. 

13) Clicking on the ‘Edit’ button allows you to modify the default user and set a voicemail timeout if 
the device is assigned a type of auto-attendant, voicemail or announcement port. 

 

14) If you have clicked ‘Edit’ to edit the device settings then Click ‘OK’ to close the dialog 

15) Finally once you have finished editing the devices within the group click ‘OK’ 
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You may also wish to delete a group 

How To: Delete a group 

1) From the MyCalls Telephone System Configuration screen, click ‘Extension Groups’ and select 
the group you want to delete.  

2) Click ‘Delete Extension Group’ in the Extension Group configuration area.  

 

3) You will be prompted to confirm deletion of the selected group. 

4) Click ‘OK’ 

 

Quick tip:  

When a group is deleted all of the member devices of that group will have their user defined group set 
to ‘none’ 

When a group is deleted all of the member devices of that group will have their user defined group set 
to ‘none’ 

Alarms will be deleted if they are configured to a group that is going to be deleted  

System groups cannot be deleted 

 

You can also remove a device from a group. 
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How To: View or Edit group membership  

1) From the MyCalls Telephone System Configuration screen, click ‘Extension Groups’ and select 
the group you want to configure.  

2) Click ‘View or Edit the Group’ in the Extension Group configuration area.  

3) In the dialog window that appears you will see a list of group members which have already been 
created, alternatively you can create new members for the group by clicking on the ‘Add new 
extension’ button and creating a new member directly in the group. 

4) Each group member will show details of the member for example extension number, name, 
device type group and whether or not real time statistics are enabled. 

 

5) You can edit the Device Name, Type, Group, Enable statistics. You can also edit the default user 
for the device by selecting the ‘Edit’ button. Changing the group will remove the device from this 
group once the ‘OK’ button is selected. 
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Miscellaneous configuration 

How To: Configuring colours 

1) The colours can be changed to represent the various extension states and call types. 

2) To change the colours click Configure -> Colours 

3) To alter the colours, click ‘Edit’ next to the section you wish to change, for example, logged off 
end colour. 

 

4) Click ‘OK’ 

5) Colours apply to all users and are system wide. Colours for different call types tend to be similar, 
Reds for abandoned, Greens for incoming, Blues for outgoing, Neutral colours for User related 
status. 

System settings 

In order for reports and alarms to be distributed to various people in your organization you will need 
to configure one or more mechanisms to transport the information to the intended recipient. 

NB: You will normally require the assistance of an IT administrator to set up system related settings 

Email 

Information can be sent to one or more email address. To achieve this, the system needs to be set 
up with an email sending mechanism via an smtp service.  
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How to: Set up an Email server. 

1) SMTP mail server: name of your email sending server e.g. mail.myco.com or smtp.myco.com 

2) Email address of sender: This will appear in the ‘from’ field of any emails sent by the system. 
This should be a valid email address on the server and ideally will relate to MyCalls e.g. 
MyCalls@my.com. 

3) Login Username: username if required to access your SMTP service 

4) Login Password: password if required to access your SMTP service  

5) Test: this will send a test email to a known email address to check your system is capable of 
sending emails using the settings you have specified 

FTP 

Information can be deposited as a file on an FTP server for later retrieval by an FTP client application 
or web browser. 

How to: Set up an FTP server.  

1) Configuration -> System settings 

2) FTP server hostname: name of your ftp server e.g. ftp.myco.com  

3) Anonymous: Defines if the account on the ftp server is capable of handling uploads from an 
anonymous user in which case a username and password are not required 

4) Login Username: username required to access your FTP service 

5) Login Password: password required to access your FTP service  

6) Test: this will  test the connection to the FTP server specified 
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Grade of service and Grace periods 

What is Grade of Service (GOS) 

You may specify the limits after which a call is treated as having rung or lasted too long. You can also 
configure the relative importance of these limits.  

General ‘Grade of Service’ is used to measure the percentage of calls which were answered within 
the target ring time for that department or group compared with the total number of answered calls 
for that department or group. The total number of calls can include long wait calls where the ring 
time extends beyond the target ring time configured.   

Long Waits = number of answered calls which rang for longer than the target maximum ring time  
 

 

   

Abandoned ‘Grade of Service’ measures the percentage of calls which were answered within the 
target ring time for that department or group compared the total answered calls plus the long 
abandoned calls.  

Long abandoned calls are those calls which were abandoned after the minimum abandonment time 
i.e. genuine abandoned calls. 

 

Service levels can be displayed as single value performance statistic, included in custom reports and 
also set alarms based on call performance. 

Long Calls  

The Grade of service configuration allows us to set the Incoming call duration limits, outgoing call 
duration limits and internal call duration limits. These allow us to define the limits for long calls. 

Long calls can be displayed as Single value performance statistics, included in custom reports and 
also set alarms based on call performance. 

To access grades of service and grace periods:  

Click ‘Configure’ -> ‘operational settings’ and then either ‘grade of service’ or ‘grace periods’. 

Grade of service configuration 

Grade of service can be configured across the whole organization or specified on a group by group 
basis. Within the Grade of service configuration screen you add the groups required to the list of 
Active groups.   

Specify for each group the settings for the following: 

Incoming ring time: If a call rings for longer than this period then the call will be treated as a long 
ring. 

Abandoned ring time: If a call was abandoned after ringing for more than this time then the 
abandoned ring will be treated as too long. 
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Incoming call duration, Outgoing and internal call durations: Specified the maximum length of call. 
Any call lasting longer than this time is considered a long call.   

How To: Configure Grade of Service:  

1) Configure -> Operational Settings -> Grade of Service 

2) Select the device from the ‘available’ list on the left side e.g. Extension 

3) Click ‘Add’. This will transfer the available device group to the list of active groups for which 
limits can be set. Each group defined for that device will be listed in the grid. You can then define 
a set of limits for each specific group. 

4) The’ Move up’ and Move Down buttons allow you to define which limits will be used for a call. If 
for example a call has both DID and Extension information then the Grade of Service group 
higher up in the list will be used to calculate the Grade of Service for that call. 

 

5) Click ‘OK’ 

6) To remove a device, simply select the device in the ‘active’ section on the right side, e.g. 
extension and click ‘remove’ 

7) Click ‘OK’ 

 

Grace periods 

What are grace periods? 

Grace periods allow you to specify the minimum ring time an abandoned call must have, and the 
minimum call time incoming, outgoing and internal calls must have, to be regarded as true calls. 
Only true calls will be used in the call statistics. 
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You can define grace periods on the following 

 Abandoned Wait Time 

 Incoming Call Duration 

 Outgoing Call Duration 

 Intercom Call Duration 

 

Grace periods configuration 
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Chapter 8 

Highlighting 

Introduction to highlighting 

Real time status and real time statistics windows can use visual highlighting as a way of bringing 
operational issues to the attention of users, supervisors and the management team.   

Visual highlighting changes the background or foreground colour of a value when the value being 
displayed meets certain conditions. This allows you to change the window colour if the value 
exceeds or dips below a required performance level. 

The Highlighting can be configured to draw attention in the following ways: 

 Changing the foreground colour of a value 

 Changing the background colour of a window 

 Flashing a value or background colour 

Visual highlighting can be applied to both real time statistics and if available, real time status 
windows.   

The following table lists the types of windows which can be configured for highlighting: 

 

Real Time Statistics 

All Real Time Statistics 
Windows 

Current & Historical 
Numeric values only 

Statistic Value 

Single Value 

All Single Value 
Windows 

Current & Historical 
Numeric values only 

Statistic Value 
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Setting Conditions 

In order for the system to provide the correct highlighting indications the various statistical values 
and states shown in the real time windows will need to have conditions applied to them. You set the 
conditions as part of the real time window configuration. 

Each condition will define: 

 When highlighting is to occur based on the value being displayed 

 Whether the Highlighting affects the text colour or the background colour 

 Which colour is to be used for highlighting 

 Will the value flash when highlighted 

An example might be the length of time an extension has been on a call. We might decide that any 
calls lasting less than 5 minutes are displayed in Green whereas any calls which have been in 
progress for between 5 and 8 minutes will display in Amber and any calls lasting more than 7 
minutes need to be displayed in Red. 

We would start by setting up an extension status window which would display all the extensions we 
want to monitor and then set up the highlighting conditions.  

For this example we would set up two conditions  

1. Calls with a duration of less than 5 minutes are displayed in Green 

2. Calls with a duration of 5 to 7:59 minutes are displayed in Amber 

3. Calls lasting 8 minutes or over are displayed in flashing Red 

Note: we cannot overlap our conditions so we cannot set condition 1 to read ‘less than 5 minutes’ 
and condition 2 to read ‘4 minutes or more’  

For each condition you set a required colour and whether the colour is applied to the text or the 
background you can also define if the value is to flash.  

A typical set of state conditions might read as follows: 

Status Criteria Text Colour Flashing 

Call Duration Less than 5 minutes Green No 

Call Duration  5 minutes or over Amber No 

Call Duration 8 minutes or over Red Yes 

 

The above conditions produce the results illustrated below. 
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Highlighting Real Time Statistics  

Statistics windows which show single values or statistics windows displaying data in a grid view can 
be highlighted. There are no highlighting options for Graph based statistical windows. Single value 
statistics can be highlighted and miscellaneous data windows can also have values highlighted. 

The highlight colour can be applied to either the numeric value or the background of the window or 
in the case of a grid display the cell value or background. 

Windows displaying a single statistic have only one value whereas grid displays contain many 
statistical values and separate highlighting conditions can be set for each statistic. 

 

How To: Configure a ‘Trunk Group Statistics’ Highlighting  

From the MyCalls main screen, click View > Real Time Information 

Navigate to Trunk Group Statistics by clicking the ‘+’ symbol next to Real Time Statistics, then click 
the ‘+’ symbol next to ‘Trunk Group’  

Click ‘Queue Group Statuses.  

 

Click ‘Create a New Group Statistics View’ on the right hand panel. 

Select the PBX. 

Select the trunk groups that you wish to include in the table. 

Click the ‘Highlighting’ button. 



Highlighting 

 

   Chapter 8-4  
 

 



Highlighting 

 

   Chapter 8-5  
 

 

A new window will appear where you can start adding conditions.  

 

 

Select a data value from the drop down menu. This determines which parameter you set the 
highlighting conditions for. You can set separate conditions for each parameter. 

 

 

Click ‘Add new condition’  

 

The Edit Condition window will be presented. 
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Click the ‘Name’ textbox and enter a name for the condition (up to 15 characters). 

 

Select the condition operator (Type)  

 

Selecting ’Equal To’, ‘Greater Than Or Equal To’ or ‘Less Than’ will cause a single box labelled ‘Value’ 
to appear. 

Enter your data value. 

 

If you select ‘Range’ two boxes labelled ‘To’ and ‘From’ will appear. Enter the start and end of your 
range in these boxes.  

 

Select which attribute of the parameter you wish to highlight. You can highlight the ‘Background’ or 
the ‘Value’. 

 

Click the colour ‘Edit’ button to select a colour for the highlighted item. This will bring up a colour 
editing panel.  
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Select the desired colour and click OK. 

 

Click the ‘Flash’ checkbox if you want the value to flash when this condition is true. 

 

Click ‘OK’ to close the   

The condition windows will now display your newly created condition. Your condition will appear in 
the list of conditions for the selected parameter. 

If you wish to add another condition, for the same or different data value, repeat the process by 
clicking ‘Add New Condition’ 

Once you have added all of the conditions you need, click OK  

Your conditions will now have configured. 

Click OK to view the status window. 
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Highlighting Single Value windows 

 

How To: Configure ‘Single Value’ Highlighting  

From the MyCalls main screen, click View > Real Time Information 

Navigate to Trunk Groups by clicking the ‘+’ symbol next to ‘Single Value’, then click the ‘+’ symbol 
next to ‘Trunk Groups’, ‘+’ symbol next to ‘Call Rate’.  

Click ‘Incoming Calls’.  

 

Click ‘Create a New Group Statistics View’ on the right hand panel. 

Select the PBX 

Select the trunk groups that you wish to include in the table. 

Click the ‘Highlighting’ button. 
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A new window will appear where you can start adding conditions.  

 

 

Click ‘Add new condition’  

 

The Edit Condition window will be presented. 

 

 

Click the ‘Name’ textbox and enter a name for the condition (up to 15 characters). 

 

Select the condition operator (Type)  
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Selecting ’Equal To’, ‘Greater Than Or Equal To’ or ‘Less Than’ will cause a single box labelled ‘Value’ 
to appear. 

Enter your data value. 

 

If you select ‘Range’ two boxes labelled ‘To’ and ‘From’ will appear. Enter the start and end of your 
range in these boxes.  

 

Select which attribute of the parameter you wish to highlight. You can highlight the ‘Background’ or 
the ‘Value’. 

 

Click the colour ‘Edit’ button to select a colour for the highlighted item. This will bring up a colour 
editing panel.  

 

Select the desired colour and click OK. 
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Click the ‘Flash’ checkbox if you want the value to flash when this condition is true. 

 

Click ‘OK’ to close the   

The condition windows will now display your newly created condition. Your condition will appear in 
the list of conditions for the selected parameter. 

If you wish to add another condition, repeat the process by clicking ‘Add New Condition’ 

Once you have added all of the conditions you need, click OK  

Your conditions will now have configured. 

Click OK to view the status window. 
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Chapter 9 

Organisation and Users 

Organisation view 

Companies are generally arranged in a hierarchical structure be it a complex one that has multiple 
sites, divisions, departments and teams or a simpler scenario where there are groups of people that 
are arranged in groups to reflect their functions. 

It is possible to emulate this structure within MyCalls and then run reports and gather statistics on 
how different areas of the business are performing and using the telephone system. The structure 
you create is intended to allow you to recreate business groupings rather than sometimes forced 
groupings when looking at the type of extension that the call came in on. These two approaches are 
intended to complement each other and allow you to produce reports on exactly what you want to 
see.  

The organisation is created as a series of groups and users within those groups. There are no limits 
on the number of users, groups or levels of groupings that can be created. 

The organisation configuration can be shown by selecting the Organisation option from the 

Configure menu or by pressing the icon  from the main toolbar. 

 

Under the item "Organisation" the hierarchical structure is shown. Expand each item to see the 
other sub-groups that form part of the selected group.  

Under the item "All Users" the users are grouped by their role within the MyCalls system. 
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Why Configure Users 

Whilst it is permissible to only configure MyCalls to use devices e.g. extensions, in order to track and 
report calls it is always advisable to create a user configuration for several reasons 

Users can be organised hierarchically thus reports can group information in terms of groups and 
subgroups. For example if you have several sales groups then a hierarchical view will allow you to 
create several subgroups under an overall group called Sales. Reports can then be performed on the 
overall performance of sales as well as each sales group within the sales department. 

Users can be responsible for more than one extension thus reports can be generated to record the 
user rather than the extension activity. 

Understanding User Roles 

Assigning the appropriate roles to users will allow control of the system to be carefully governed and 
thus reduce the risk of untrained users making damaging configuration changes or running reports 
that they should not see. 

 Agent 
Desktop 
User 

WB 
User 

User Supervisor PBX 
Admin 

Enterprise 
Admin 

View Agent 
Desktop Layout 

            

Create Real 
Time windows 

           

Save/ Load 
screen layouts 

           

View Live Call 
Records/ 
Alarm/ Audit 
Entries 

           

Configure/ Run 
Reports 

         

Configure 
Collectors 

        

Configure 
Telephone 
System/ 
Organisation/ 
Callers/ Costs/ 
Alarms 

        

Backup/ 
Restore 
database 

        

Remove 
unwanted 

        
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information 

Import Bill         

Re-Cost Calls         

 

Organisation Group Configuration  

Organisational Groups are the logical groups of employees that exist within the organization.  They 
are arranged in a hierarchy and groups can exist within other groups.  It is typical that an 
organization be split up into different departments and then maybe different teams. 

How To: Creating a new Organisation group 

1) From the Organisational Groups Configuration screen, click ‘Organisation’ 

 

2)  click ‘Create a New Group’ 

3) In the ‘Create a New Organisational Group’ window you must enter a name for the group, and 
you can enter notes to describe the group. 

4) Name*: Enter a name to describe the organisation group you are creating. 

5) Click ‘OK’ 
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How To: Editing organisation group configuration  

1) From the Organisational Group Configuration screen, click to expand ‘Organisation’ and select 
the group you want to edit. 

  

2) Click ‘Edit Organisation Group’ in the Organisational Group Configuration area 

3) In the ‘Edit an Organisational Group’ window that appears you can enter notes to describe your 
selected group.  In the Group Members window you will see members currently assigned to the 
organisation group.  If you have sub groups below this group then you can include those 
members by selecting the ‘Include Sub Groups’ option.  If members are displayed in this window 
then you can choose whether to collect real time statistics on the member in the group by 
selecting the ‘Enable Statistics’ option. 

 

4) Click ‘OK’ 
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Deleting Organisation Groups  

How To: Delete Organisation group configuration 

1) From the Organisational Configuration screen click to expand ‘Organisation’ 

2) Select the group you want to delete e.g. office admin. 

 

3)  Click ‘Delete Group’ in the Organisational Group configuration area.  

4) You will be prompted to confirm deletion of the selected group. 

5) Click ‘OK’ 

 

User Configuration 

Users are generally people employed by the organization.  By configuring users it will be possible to 
report on the activity of people rather than extensions.  This is very useful where a person may move 
between several desks and telephones. 

How To: Creating a new User 

1) At the Organisational Configuration screen, click ‘Create a New User’. 

2) The Create a New User screen is displayed.  

3) In the dialog window that appears a number of fields are available for entry.  Some are 
mandatory fields* for successful setup whilst others are optional inputs as outlined below. 

 



Organisation and Users 

 

   Chapter 9-6  
 

4) Name*: Enter the users name here that will be used to identify them in the system. 

5) Abbreviation: If the user has an abbreviated name or nickname they would like to be known by 
then you can enter it here in this field. 

6) Job Title: Enter a job title to describe the users’ position within the organization.  

7) User Role*: Select a user role for your user from the pre-defined list.   

8) Email Address: You can enter an email address for your user so that if they are configured as an 
Administrative User of an organization group then they receive reports and alarms on that 
groups activity directly. 

9) Password: If the user is required to enter a password to login then enter one in here. 

10) Enable Call Playback: If the user is going to need to listen to recorded conversations then they 
will need to enable this option to do so. 

11) Enable Real Time Statistics: For real time statistics to be collected for the user this option needs 
to be enabled.  If you no longer with to collect info on the user then turn this option off.  

12) Click ‘OK’ 

13) The caller should now be visible in Configure Organisation Structure window. 

Once a user has been created there needs to be at least one PBX administrator created as these are 
the only users that can do further modifications to the configuration. If you do not create a PBX 
administrator then contact your maintainer who can fix it for you. 
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How To: Editing an existing User 

1) From the Organisational Configuration screen, click ‘Organisation’ 

2) Select the user you want to edit by expanding the group the user is in and clicking on the user. 
E.g. If you want to edit Max, select Max from the organization hierarchy. 

3) Click ‘Edit User Configuration’ in the Users configuration area. 

4) In the dialog window that appears a number of fields are available for entry.  Some are 
mandatory fields* for successful setup whilst others are optional inputs as outlined below. 

 

5) Name*: Enter the users name here that will be used to identify them in the system. 

6) Abbreviation: If the user has an abbreviated name or nickname they would like to be known by 
then you can enter it here in this field. 

7) Job Title: Enter a job title to describe the users’ position within the organization.  

8) User Role*: Select a user role for your user from the pre-defined list.   

9) Email Address: You can enter an email address for your user so that if they are configured as an 
Administrative User of an organization group then they receive reports and alarms on that 
groups activity directly. 

10) Password: If the user is required to enter a password to login then enter one in here. 

11) Enable Call Playback: If the user is going to need to listen to recorded conversations then they 
will need to enable this option to do so. 

12) Enable Real Time Statistics: For real time statistics to be collected for the user this option needs 
to be enabled.  If you no longer with to collect info on the user then turn this option off.  

13) Once you are happy with the changes you have made, click ‘OK’ 
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How To: Deleting a User 

1) From the Organisational Configuration screen expand ‘organisation’ 

2) Select the group that the user you want to delete belongs to and select the user 

3) Click ‘Delete user’  

4) You will be prompted to confirm deletion of the selected User. 

5) Clicking ‘Yes’ will delete the user whilst clicking ‘No’ will cancel the action. 

How To: Assigning Users to a group 

1) If you have configured User Groups then you can group individual users within a group to 
enhance real time statistics and make reporting easier. 

2) The easiest method to assign a user is to simply drag and drop them from the organization 
structure to the group.  From the Organisational Configuration screen, select the user you want 
to assign to a group and drag across to the group and release the left mouse button. 

3) You can also use the ‘Edit User Configuration’ window to change the organisation group. 

 

4) When you are happy with your users selected groups click ‘OK’ to save your changes. 
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How To: Removing a User from a group 

1) The easiest method to remove a user from a group is to drag them from the group they are in 
and drop them in another group in the organizational hierarchy. Simply select the user by 
hovering over them and clicking the left button on the mouse, drag them over to the group you 
want to move them to and release the left mouse button. 

2) For example, move John from office admin into sales. 

   

3) If you want to remove the user from all groups, you can put them in the top level of the 
hierarchy by hovering over the Organisation group and releasing the mouse.   

4) You can also use the ‘Edit User Configuration’ window to change the organisation group.  

5) Select the user you wish to remove from a group 

6) Click ‘Edit User Configuration’ 

 

7) In the window that appears simply use the drop down menu ‘group’ and assign them to a 
different group. 

8) Click ‘OK’ 

 

Importing users:  

You can import a csv (comma separated values) file directly into MyCalls to speed up user setup.   
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How To: Import Users 

1) From the Organisational Configuration screen, click ‘Import Users’ 

 

2) In the window that is displayed, select a valid .csv file by clicking the ‘Browse’ button, navigating 
to the file then selecting it, and clicking ‘Open’. 

3) On the Import Callers window click ‘Load’ to populate the Users to Import list box with any valid 
entries from the CSV file that have been found. 

4) Further editing is possible in the grid before committal. 

5) Click ‘OK’ 
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Chapter 10 

Callers 

Introduction to Callers  

 

Within MyCalls people or companies external to the organisation that you call or who call you, are 
referred to as callers. Callers can be categorised by a type as either: 

 Business Callers 

 Personal Callers 

 Unassigned Callers 

Callers can also be placed into user groups, so all the contacts within a particular company can be 
grouped together. Personal numbers can also be placed into a user group, such as "Terry Breen’s 
Personal Callers". Setting the type of caller and placing them into a user group allows reports to be 
generated that are filtered to only show those callers, and thereby identifying if someone is taking or 
making too many personal calls. 

The callers configuration screen can be shown by selecting the ‘Callers’ option from the ‘Configure’ 

menu or by pressing the callers icon   from the main toolbar. 

 

Creating and editing callers  

How To: Creating a new Caller  
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1) At the Configure Callers screen, click ‘Create or Edit a Caller.’ The Edit Callers screen appears. 

 

2) Click ‘Add new caller’ to begin adding a new caller. 

3) The Create a Caller screen is displayed. 

4) In the dialogue window that appears a number of fields are available for entry.  Some are 
mandatory fields* for successful setup whilst others are optional inputs as outlined below. 

 

5) Number*: Enter the callers’ main incoming number here that will be used to identify them. 

6) Alternate Number: If the caller has different incoming and outgoing numbers, a DID for 
instance, then use the alternate number field for this. 

7) Name: Enter a name for your caller to identify them clearly on real time windows and reporting. 

8) Type*: You can choose whether a caller is a Business or Personal caller by selecting the option 
from this field.  If you wish to create the caller but not assign them as either of the above then 
you can use the final option Unassigned until you decide on the most suitable type for the caller. 

9) Caller Group: You can select a caller group from this field to group the caller with in order to 
enhance real time statistics and reporting.  Caller groups are created by users and tailored to the 
organizations requirements.  Default is set to None. 

10) Notes: Use the notes field to log any useful information about the caller for other users to see. 

11) Click ‘OK’. 

12) The caller should now be visible in the caller list of the Edit Callers window. 

How To: Editing an existing Caller  

1) From the Callers Configuration screen, click ‘Create or Edit a Caller’ 

2) In the Edit Callers window that appears click the ‘Edit…’ button to the right of the Caller you 
want to modify. 

 

3) In the ‘Edit’ window that appears, you can modify the following fields; Alternate Number, Name, 



Callers 

 

   Chapter 10-3  
 

Type, Caller Group and Notes.  You cannot change the Number field as this is the main identifier 
of the caller.  To change this you would have to create a new caller record and delete this record 
if necessary. 

 

Click the ‘OK’ button when you have completed making your changes. 

Click the ‘OK’ button on the Edit Callers window to save the changes you have made. 

 

Deleting callers 

How To: Delete a single or a range of Callers  

1) From the Callers Configuration screen, click ‘Delete a Range of Callers’. 

2) In the window that appears, select the callers you want to delete in the callers list.  You can 
select multiple callers by holding down the control key (ctrl) as you click on the rows. 

 

3) Press ‘OK’ to complete the deletion process.  Be aware that you will not be prompted to confirm 
this process once you press the ‘OK’ button so please make sure you have the right callers 
highlighted before pressing ‘OK’ to continue.  

 

Importing Callers 

You can import a csv (comma separated values) file directly into MyCalls to speed up caller setup.  
This file should include the following columns: Number, Alternate Number, and Name, in that order 
to be imported successfully. 

For more detailed information see the section on importing data. 

Caller Groups 

Caller groups are groups that contain callers that are related in some way within a business.  By 
using Caller Groups it is possible to report over a range of callers such as all business callers or all 
personal callers. 
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System and User defined groups  

User defined groups are custom groups that have been created by users, whilst system groups are 
those that are pre-installed with the application and cannot be removed.  There are four system 
groups that can be used which are: 

 All business callers - Holds callers that are of  type Business 

 All Callers - Holds all callers defined in the system. 

 All Personal Callers - Holds callers that are of type Personal. 

 Unassigned Callers - Holds callers where there type has not been specified. 

How To: Creating a new Caller group 

1) From the Callers Configuration screen, click ‘Create a Caller Group’.    

2) In the ‘Create a New Caller Group’ window that appears, a number of fields are available for 
entry.  Some are mandatory fields* for successful setup whilst others are optional inputs as 
outlined below. 

3) Name*: Enter a name to describe the caller group you are creating. 

4) Notes:  Enter here any relevant details you wish to save about the caller group  

5) When you have entered the necessary information click the ‘OK’ button to create the caller 
group. 

 

How To: Editing Caller group configuration 

1) From the Caller Group Configuration screen, click ‘Caller Groups’ and select the group you want 
to edit. Click ‘Edit Caller Group Configuration’ in the Caller Group configuration area.  

 

2) In the ‘Edit a Caller Group’ window that appears you can enter notes to describe your selected 
group. 

3) Click ‘OK’ to save your changes. 
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How To: Delete Caller group configuration 

1) From the Caller Configuration screen, click ‘Caller Groups’ and select the group you want to 
delete.  

2) Click ‘Delete Caller Group’  

3) You will be prompted to confirm deletion of the selected group. 

4) Click ‘OK’ 

 

How To: View or Edit group membership 

1) From the Callers Configuration screen, click ‘Caller Groups’ and select the group you want to 
configure.  

2) Click ‘View or Edit the Group’   

3) In the ‘Edit Group Membership’ window that appears you will see a list of callers in the group 
which will have been configured using the methods described in the manual, sections 6.1.1, 
6.1.2 or 6.1.4 or by clicking on the ‘Add new caller…’ button and creating a new caller directly in 
the group. 

4) You can edit the Alternate Numbers and Names of the callers in this group.  Select a new Type 
using the Type Column.  And you can also change group membership for a member by selecting 
another available option in the Group field. 

 

5) Press ‘OK’ to close the window and save any changes you have made. 

 

How To: Assigning Callers to a group 

1) If you have configured Caller Groups then you can group individual callers within a group to 
enhance real time statistics and make reporting easier. 

2) On the Edit Callers window that is displayed you can either click ‘Edit’ next to the caller you wish 
to edit the group for and alter the group in the window that appears, or you can do it here by 
selecting a new group in the Group column.  You can change as many callers as you wish before 
saving your changes. 
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3) When you are happy with your callers selected groups press the ‘OK’ button to save your 
changes. 

 

How To: Removing a Caller from a group  

1) From the Callers Configuration screen, click ‘Create or Edit a Caller’  

2) On the ‘Edit Callers’ window that is displayed you can either go to the Edit a Caller window to 
change the callers group to or you can do it here by using the ‘Group’ column. Select the option 
‘None’ to remove the caller from any previously selected groups. You can change as many callers 
as you wish before saving your changes. 

 

3) When you are happy with the changes you have made and want to save them press the ‘OK’ 
button. 

Deleting a Caller group 

How To: Delete a Caller group configuration  

1) From the Caller Configuration screen, click ‘Caller Groups’ and select the group you want to 
delete. Click ‘Delete Caller Group’ in the Caller Group configuration area.  

2) You will be prompted to confirm deletion of the selected group. 

3) Click ‘OK’ 
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Chapter 11 

Alarms 

Managing by exception using the MyCalls Alarm System 

We believe that people should not have to spend a long time analyzing report information just to 
find that everything is OK. This has historically been the case in companies that use call accounting 
or other telephone management software for many years. 

MyCalls is designed to be used with management by exception. That is, the system is configured to 
watch for specific conditions and only inform users when one of those conditions has been broken. 
This then leaves the supervisors and PBX administrators free to do other activities. 

Specify when Alarms are active:  

To facilitate the automated notification of alarm conditions MyCalls is provided with an alarm 
scheduler which allows you to specify when alarms can be active. You can create as many alarm 
schedules as required e.g. Daytime, Night time, Weekends and apply the schedules to the different 
alarms that you create. For example you may want to activate alarms from certain extensions out of 
hours to catch any unauthorised usage. 

Specify who receives Alarm notifications: 

Generating alarms is only one part of the equation. In order to make the MyCalls system really work 
for you the alarms need to be sent to the people in the organisation who need to know about it. 
MyCalls provides distribution lists to do just that. You can set up multiple distribution lists which 
allows you to specify different recipients for different types of alarms. For example System alarms 
may be sent to your IT specialists (possibly outside the organisation) whereas Fraud Alarms may be 
sent to supervisors. 

Alarm Categories 

MyCalls currently has the following different types of alarm with more added on each release of 
software. 

System Alarms:  

These are triggered when either no data is received from the PBX for a certain period or if the free 
disk space on the disk that the database is situated on is below a specified level. 

Call Rate Alarms:  
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Measures the rate at which calls have been handled in a one hour period. This can occur if there are 
either too few or too many calls handled. Too few indicates that calls are taking too long and too 
many indicates that calls may too short. There are several types of call rate alarm: 

 Abandoned Call Rate Alarms:  

 Outgoing Call Rate Alarms:  

 Incoming Call Rate Alarms:  

Wait Time Alarms:  

Determined by what is an acceptable minimum and maximum average wait time for a one hour 
period. An average wait time that is less than the minimum value can indicate that you have too 
many free staff and they are just waiting for the phone to ring. An average wait time that is more 
than the maximum value indicates that there may not be enough staff available. Wait time alarms 
include: 

 Incoming Wait Time Alarms 

 Abandoned Wait Time Alarms 

Call Time Alarms:  

Determined by what the acceptable minimum and maximum average call times should be in a one 
hour period. An average call time that is less than the minimum value can indicate that you may be 
rushing your calls. An average call time that is more than the maximum value indicates that the calls 
are taking too long and you may need to speed up the conversation. 

 Outgoing call time Alarms 

Service level alarms 

 

General Service Level Alarms: Are triggered when the general service level drops below the 
defined minimum service level setting for the alarm. A value below the minimum average can 
indicate that there are not enough staff members available to take all of the calls. Conversely, if the 
value is above the maximum value it might indicate that there are too many people available to 
answer calls. 

Abandoned Service Level Alarms: Are determined by the minimum and maximum average 
Abandoned Grade of Service (GOS) in a one hour period.  

Emergency Alarms: These are triggered when a call is made to an emergency number.  You 
can specify what constitutes an emergency number.  

Toll Fraud Alarms: These alarms are used to detect misuse of the phone system. These 
alarms can detect if a call is too expensive or lasts for too long or is to/from a specific 
destination which is considered to be unauthorised. 

Caller Alarms:  

These alarms are used to determine if a caller has been contacted within a specified time period. 

Viewing the alarms 

When an alarm is triggered, an alarm record is generated and stored in the database. These can be 
seen in the Alarms Real Time list View. See; Real Time List Views 
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An alarm icon  is also displayed in the system tray when an alarm is triggered. This icon will 
remain in the system tray until the alarm window has been clicked with the mouse button, to 
indicate it has been viewed. 

Audible alarms 

Audible alarms can be configured on a severity level; Information, Warning, Severe, Critical. 

When an alarm is triggered, if a sound has been assigned to the severity of the alarm, then that 
sound will be played. The sound can be configured to be played repeatedly until either an alarm of a 
higher severity is triggered, or until the alarm window has been clicked on with the mouse button, to 
indicate it has been acknowledged. 

Accessing Alarm Options 

Using the MyCalls menu you can access the alarm screens using: 

Configure –> Alarms –> PBXs 

OR, you can click the alarm icon in the toolbar  

Configuring Real Time Alarms 

MyCalls alarms are generated in real time. You can have the alarms pop up on screen to warn 
operators of alarm conditions as they occur. Alarms are also recorded in the Alarms grid accessible 
from the toolbar at the bottom of the main screen. 
 

When you configure an alarm you will invoke an alarm configuration wizard. The wizard will require 
you to enter the name for the alarm and select both a distribution list and an alarm schedule. The 
distribution lists will ensure the alarm reaches the appropriate people and the schedule limits the 
time periods when the alarm is active so before you can configure an alarm you will need to have set 
up your alarm schedules and distribution lists. These topics are covered in more detail toward the 
end of this section. 

System Alarms 

System alarms monitor the status of the system. This falls into two parts: 

 PBX data monitoring 

 Disk space monitoring 

PBX Data Monitoring 

The MyCalls system regularly receives call data from the PBX. If MyCalls does not receive data from 
the PBX it could mean there is a fault on the PBX. This alarm checks to see how long ago the last call 
record has been received from the PBX. This can indicate that the link between the PBX and the call 
processor has failed. 

Setting this alarm to be active on an alarm schedule which covers only the working hours, will mean 
that this alarm is not triggered in the middle of the night when there are likely to be no calls anyway. 

Disk Space Monitoring 

A minimum amount Disk apace is required for correct operation of the operating system and the 
MyCalls-database. This alarm checks the current disk space available. 
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Call Rate Alarms 

Call rate alarms are triggered if the number of calls is either lower than a specified value or higher 
than a specified value for the last hour. 

The call rate alarms can be set up for both: 

 Incoming calls 

 Abandoned calls 

 Outgoing calls 

The wizard allows you to set minimum and maximum calls per hour for Trunks, Extensions, DIDs, 
Organisational groups. You can specify all the device groups of a particular type e.g. ‘All Trunks’ 
or you can select individual device groups. 

 

 

Performance Alarms 

Performance alarms are designed to measure the effectiveness of the people answering or making 
the telephone calls.  

Performance alarms can be set for 

 Incoming Wait Time 
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 Abandoned Wait Time 

 Incoming Call Time 

 Outgoing Call Time 

 Abandoned Call Time 

 General Service Level 

 Abandoned Service Level 

The setup of these alarms is identical to the call rate alarms described in the previous section. You 
select which alarm type you wish to generate e.g. wait time, call duration etc and specify the device 
or user groups to which this alarm applies. You can only specify one of each device group per alarm 
setup but you can set as many of each type of alarm as required.  For example, to set a wait time 
alarm for the extension group called ‘Sales’ with different wait times to the extension group called 
’Service’ then you would need to create two wait time alarms, each with different settings, which 
you could call ‘Sales’ and ‘Service’ to easily identify each alarm. 

  

Incoming Wait Time Alarm 

These alarms can be set to trigger if the average wait time for answered calls over the last hour was 
too low or too high. 

Answering a call too quickly can mean that you may have too many people available to answer the 
phone or that you customers may perceive that you are just waiting for the phone to ring. It is usual 
for people to expect to wait 2-3 seconds before the phone is answered. 

Answering too late can mean that you do not have enough people to answer the phones and may 
risk calls being abandoned.  

Abandoned Wait Time Alarm 

These alarms can be set to trigger if the average wait time for abandoned calls over the last hour 
was too low or too high. 

If you base your staffing on the fact that your customers will wait a certain amount of time, then this 
alarm can tell you if your assumptions are correct or not.  

If the alarm is triggered because the average has fallen below the minimum value, then your 
customers will not wait on average as long as you think, and you may need to either answer the 
phone quicker or employ more people. 

If the alarm is triggered because the average has risen above the maximum value, then your 
customers are prepared to wait longer than think they will and you may not need as many people to 
answer the calls. 

Incoming Call Time Alarm 

These alarms can be set to trigger if the average time taken to handle incoming calls over the last 
hour was too low or too high. 

Outgoing Call Time Alarm 

These alarms can be set to trigger if the average time taken to handle outgoing calls over the last 
hour was too low or too high. 
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General Service Level Alarm 

These alarms can be set to trigger if the average service level over the last hour was too low or too 
high. 

Setting a maximum value of 99% rather than 100% can be useful, a 100% value can mean that the 
people handling the calls are not fully occupied. A definition and configuration guide to Service 
Levels is covered under Grade of Service configuration. 

 Abandoned Service Level Alarm 

These alarms can be set to trigger if the average abandoned service level over the last hour was too 
low or too high. 

It is quite normal to have a minimum value of 97% and a maximum value of 100%. It is widely 
accepted that you should not expect to have more than 3% of your calls abandon outside of the 
acceptable wait time. 

 

 

Emergency Alarms 

Emergency alarms are triggered whenever a call is made to an emergency number. 
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Toll Fraud Alarms 

Toll fraud alarms are designed to trigger if a call has been made that breaks one of your calling 
policies. The policies available are. 

 Calls that are longer than a specified amount time 

 Calls that ring for more than a specified amount time 

 Calls that cost more than a specified amount of money 

 Calls to certain numbers or types of call 

 Calls to/from certain caller groups 

 Calls that have a specific account code 

The toll fraud alarm can be set to be active on extensions and users.  

One alarm can be set to be active on all groups, a specified group or all except a specified group. 

Specifying an alarm to be active on all except a specified group is useful if you only want for 
example, to have one group that can make international calls and the others cannot. 

Specifying Outgoing Numbers 

When setting up a toll fraud alarm you will probably need to define a set of numbers to identify the 
calls that you wish to trap within the alarm conditions. For example calls to mobiles beginning with 
07 or calls to a specific area code or even call outside a specified set of area codes. When setting 
these conditions (see example below) you will need to enter either complete or partial numbers.  

A number can be specified in the full such as 01260519221. 

Partial numbers can either be with one or more specific digits and entered with a '?' or as a starting 
number followed by any digits and entered with a '*' 

012607230?2 will trigger on  01260723002, 01260723012, 01260723022, 01260723032 ... 
01260723092 

01260* will trigger on any number beginning with 01260. 

International numbers from the United Kingdom can be detected by 00*. 

Example Restricting Personal Mobile Calls 

Problem: Create a toll fraud alarm that has incoming and outgoing calls selected and traps any non 
Business calls to a mobile number. 

Create a new Toll Fraud Alarm and name it ‘Mobile Calls’ – Click ‘Next’ 

 

Specify the Alarm Schedule associated with this alarm type, in this case we only want to monitor 
these calls during the daytime so we associate the alarm with the schedule ‘Daily Alarms’. You can 
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also associate the alarms with an Alarm Distribution List to define who will receive notification of 
this alarm. For this example we choose the Managers list.  

 

Next you need to specify which Extensions, Users and you wish to include or exclude from these 
rules. In this example we exclude Reception and Customer Service from the alarm list. This is 
because these groups may well make legitimate calls to mobiles during the day. You may need to 
reconsider how you have organised your groups as any extension can only belong to one group. You 
may need to split the groups into smaller units for example Customer Service Staff and Customer 
Service Mobile Callers so that you can ensure only the Customer Service supervisors can call out to 
mobile numbers. 

 

You can specify full or partial numbers to include in the alarm conditions. At this point you are only 
specifying the numbers list. How these numbers are used to determine an alarm condition is defined 
in a later step. However the number list can only be used to either 

 Generate the Alarm if the Number appears in the list 
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 Ignore the alarm if the number appears in the list 

This means that all the numbers in the list need to have the same purpose. In this case we want to 
generate an alarm if any mobile numbers are called or received. So we specify a list of numbers 
which represent all the possible number combinations. We specify that any numbers beginning with 
07 are mobile numbers there may be other combinations of course.  

 

In the next screen we specify any caller groups that we wish to include in the alarm conditions. Again 
we can either specify that the alarm be generated if the calls are going to or received from the caller 
group or we can specify that the alarm is to be ignored if the call is to or from the specified caller 
group.  

Click ‘Next’ and a similar screen is displayed to allow the inclusion of a list of account code groups.  

Having specified our groups to include or exclude from the alarms, our lists of Numbers to identify 
and our lists of Callers and Account codes we can then specify the Conditions for the alarm based on 
these settings.  

Clicking ‘Next’ displays the final screen of the wizard 

 

First configure which call type we wish the alarm to trap, in this case incoming and outgoing calls are 
included 
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Then specify timing or costing conditions for the alarm. You can specify the maximum ring time* 
beyond which an alarm will be generated, the maximum call duration and the maximum call cost. To 
set any or all of these limits simply select the appropriate checkbox and using the numeric setting 
specify the time in seconds.  

 

*Ring time alarms only apply to incoming calls. 

Next we can specify how the Number list, Caller list and Account code list affect the alarm 
generation. For an alarm to occur the conditions must be met for all three lists. 

For list parameter we can specify: 

Never alarm on items in the list – effectively ignore this list. 

Alarm if the item is in the list – your list should only contain members on which you want to 
include for alarm purposes. This means you have created a list of prohibited members e.g. any 
member of the list is not allowed to make mobile calls. 

Alarm if the item is not in the list  – The list should only contain members which you wish to 
ignore for alarming purposes. This means you have created a list of allowed members e.g. anyone in 
the list is allowed to make mobile calls. 

And for numbers only  

Alarm on any number or no number (the default value) - Generate an alarm irrespective of the 
presence or absence of a number in the call. This ensures that if any of the three lists; Numbers, 
Callers, Account Codes are used then the alarm will still be active.  

NB: If you set ‘Never alarm on numbers’, ‘Never alarm on callers’, ‘Never alarm on account codes’ all 
at once the alarm will not be generated. 
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Finally once you are happy with your settings you can click ‘Finish’ which will save the new alarm you 
have created. The new alarm will now appear in the Toll Fraud alarm list. 

 

Caller Alarms 

Caller alarms allow you to define an alarm that will trigger if a caller has not contacted you or you 
have not contacted them within a specified time. 

The check can be made on a recurring basis as either on a specified day in a week at a specified time 
or on a specific day in a month at a specified time. 

Calls that are too short in length can be excluded, for example if a call was answered by voice mail or 
answer phone.  
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Alarm Schedules 

An alarm schedule is a named configuration that allows you to specify when an alarm will be active. 

Alarms schedules can be configured to be: 

 Active for all dates or for a fixed date range 

 Active for all times of the day or for a fixed period of time 

 Active for all days of a week or for a selection of days 

 

It is very useful to create alarm schedules for out of hours times as well as alarm schedules for 
working hours. This allows you to configure multiple alarms of the same type but with different 
schedules so they act differently. For example, you may desire that calls cannot last more than 60 
minutes during a week and no outgoing calls out of hours. In this case there would be three alarm 
schedules created; one that covers the working week 08:00 to 18:00, one that covers out of hours 
during the week and one that covers weekends. The toll fraud alarm with a 60 minute call duration 
alarm would be assigned the working week alarm schedule and the toll fraud alarm with a 0 minute 
call duration would be assigned the out of hours and weekend schedules.  

Alarm schedules can also be configured to trigger every time the condition is broken or every ‘X’ 
times.  

Useful if you have an operating value that is very close to an alarm limit and the figure quite often 
breaks the limit. These types of limits have worked very successfully when connecting to a PBX that 
uses a very unstable WAN connection. In this scenario the ‘no data from PBX’ was set to 10 minutes 
and on occasions the link would be down for 20 - 30 minutes at a time and unfortunately there was 
little that could be done about that, by placing an occurrence threshold on the schedule that was set 
to 4 it meant that if the alarm fired three times then it was connected then the alarm didn't trigger 
but if it happened four times in a row then the alarm was raised. 

Alarm schedules can also be limited to a fixed amount of notifications per hour 
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Alarm Distribution Lists  

Alarm Distribution Lists determine who should be informed if an alarm condition is broken. There 
are four mechanisms for informing people that an alarm has been triggered. All running copies of 
MyCalls client application will be informed by default. See Real Time List Views 

The user can then specify one or more of the following types of distribution mechanism 

 Email 

 Computer 

 Process 
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Email 

 
Make sure that you have set up the mail server configuration correctly in the Operational Settings. 
See Operational Settings 

Each email address added will get an email describing the alarm condition that has been broken 
including the current parameter value and the trigger point value. For example, a system alarm that 
monitors free disk space and triggers when it is lower than 10GB would send a mail 

Subject: MyCalls Real Time Alarm: <Alarm Name> 

The free hard disk space on your system drive has fallen below 10GB (7GB) 

Computer 

 

Each computer name entered will receive a "net send broadcast message" describing the alarm 
condition that has been broken. 

Windows XP Service Pack 2, disables the messenger service by default. If you wish to use this 
distribution method on your corporate network and you have XP Service Pack 2 installed on any of 
the computers that will receive the message, you will need to discuss your requirements with your IT 
department. 
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Process 

 

Any number of external applications can be invoked when an alarm condition has been broken. The 
application is passed as a single parameter the string of the alarm message. For the example above 
the command line for the application would be:  

pageralert.exe "The free hard disk space on your system drive has fallen below 10GB (7GB)" 

This is very useful if you wish to implement some extra functionality that is not available within 
MyCalls yourself. Examples of this may be that you run an application that calls a pager or sends an 
SMS message to a cell phone. 

 

Alarm Severity Levels  

Not all alarms need to be problem alarms that you must act on immediately. It is useful to be given a 
warning that if this persists then the problem will escalate. 

MyCalls supports four levels of alarm severity: 

 Information 

 Warning 

 Severe 

 Critical 

The meaning of each of these is up to the company. An example of how these may be used is when 
looking at the Grade of Service. It might be useful to generate an Information alarm if the average 
Grade of Service drops below 95%, a warning alarm if it drops below 90%, a severe alarm if it drops 
below 85% and a critical if it drops below 80%. 

Each alarm can be configured to do something different. For example, the information alarm may 
send a message to each of the users. A warning alarm may send an email to a supervisor. A severe 
alarm may run a report and email it to a supervisor. A critical alarm may run an external program 
that has a paging interface and pages the alarm details to the President of the company. 
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Real Time Notifications 

You can notify specified users of given call events (Incoming ring, Incoming call, Outgoing call) in real 
time.  

You can either: 

Send a message to the configured users by typing in the message contents. You can use special 
placeholder codes  

%1% - Insert the DID present on the call 

%3% - Insert the caller 

%4% - Insert the extension 

%5% - Insert the time the call rang before connection 

Show a web page: A locally available web page can be invoked in a browser. 

Go to this web address: Invoke a web URL for display in a browser. 
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Chapter 12 

Call Costing 

Call Costing in MyCalls provides a comprehensive costing facility. 

The cost of a phone call can be broken down into four parts: 

Actual cost = telephony call cost + fixed costs + handling costs + taxes 

In its simplest form the telephony call cost will be the only one used as the other parts are set to 
zero if they are not configured. 

Profit margins can be added to each call and added to the actual cost of a call. This profit margin can 
be expressed as either a fixed amount or as a percentage of the actual call cost. 

For each call record the costs are broken down into three values, call cost, handling costs (which 
include the fixed costs) and profit. Reports can then be run and filtered to show the information that 
matches any of the three value types. 

Fixed Costs 

Fixed costs are costs that are allocated to capital expenditure items such as extensions and trunks. 
Each type of extension and trunk can carry its own fixed cost. In addition to the cost types, an 
individual extension or trunk can be assigned an additional cost ,which can be used to cover any 
other costs that the type costs does not cover. 

Fixed costs are not call dependant, as the cost of running an extension or a standing charge on a 
trunk still applies whether there are any calls on that trunk or extension. As such these do not 
appear on call detail type reports. 

 

Editing Fixed Trunk Type Costs  

Trunk types can be assigned a fixed cost. The amount entered can be specified as an amount for a 
period defined as hourly, daily, weekly, monthly, quarterly or yearly. The fixed cost amount will 
always apply regardless of whether or not the trunk received or made any calls and will be shown on 
reports as a pro-rata figure.   
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How To: Editing fixed Trunk type costs  

1) Select the ‘Costs’ option from the Configure menu or click the  icon on the toolbar 

2) Expand the ‘Fixed Costs’ category in the left pane of the window.  This will display all available 
PBXs in your enterprise.  Then expand the PBX you want to configure costs for. 

3) Select the ‘Trunk Type Costs’ option.  

 

4) Click ‘Edit Fixed Trunk Type Costs’ 

 

5) You can configure the costs for the different trunk types configured on the system including 
Analogue, ISDN, Private Wire, TCP/IP, and any unassigned trunks.  To configure a cost for a trunk 
type enter a costing value in the Cost (£) column and then select one of the costing periods from 
the Cost Period column.  Periods selectable are hourly, daily, weekly, monthly, quarterly and 
yearly.  

6) Click ‘OK’ 
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Editing Fixed Extension Type Costs  

Extension types can be assigned a fixed cost. The amount entered can be specified as an amount for 
a period defined as hourly, daily, weekly, monthly, quarterly or yearly. The fixed cost amount will 
always apply regardless of whether or not the extension received or made any calls and will be 
shown on reports as a pro-rata figure.   

How To: Editing fixed Extension type costs  

1) Select the ‘Costs’ option from the Configure menu or click the  icon on the toolbar 

2) Expand the ‘Fixed Costs’ category in the left pane of the window.  This will display all available 
PBXs in your enterprise.   

3) Click ‘Extension Type Costs’ 

4) Click ‘Edit Fixed Extension Type Costs’  

 

5) You can configure the costs for the different extension types configured on the system including 
Analogue Desk Phones, Analogue System Phones, Analogue User Phones, Announcement Ports, 
Auto Attendant, Cordless Phones, Digital Desk Phones, IP Desk Phones, Non PBX Phones, 
Operator Consoles, Voicemail and Unassigned extensions.   

6) To configure a cost for an extension type, enter a costing value in the Cost (£) column and then 
select one of the costing periods from the Cost Period column.  Periods selectable are hourly, 
daily, weekly, monthly, quarterly and yearly.   

7) Click ‘OK’ 
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Editing fixed Additional Costs  

Fixed additional costs are any other user configured cost that may apply to a trunk or extension 
device types. This could be to include premiums for feature phones over normal phones for 
example.  Additional costs must be configured with a unique name.  You can enter negative 
additional costs that will be subtracted from any other costs.  The amount entered can be specified 
as an amount for a period defined as hourly, daily, weekly, monthly, quarterly or yearly.    

How To: Editing fixed additional costs  

1) Select the ‘Costs’ option from the Configure menu or click the  icon on the toolbar 

2) Expand the ‘Fixed Costs category’ in the left pane of the window.  This will display all available 
PBXs in your enterprise.  Then expand the PBX you want to configure costs for. 

3) Click the ‘Additional Type Costs’ option. 

4) Click ‘Edit Additional Costs’  

5) This window will list all existing additional fixed costs in the system.  To add a new additional 
cost click ‘Add’.  

6) Enter a unique name at the next screen for the new additional cost item. 

7) The new additional costing item will appear in the listing of cost items.  

 

8) Enter a costing value in the Cost (£) column and select one of the costing periods from the Cost 
Period column.  Periods selectable are hourly, daily, weekly, monthly, quarterly and yearly.   

9) You can continue to add further additional costs or edit the existing costs.   

10) To remove an additional cost item you have created, select the item from the list of additional 
costs and click ‘Remove’. 

11) Click ‘OK’ 
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Editing Fixed Trunk Costs  

 

Fixed trunk costs are the total cost associated with the trunk’s type and one other user defined 
additional cost if you wish to apply it also to the overall costing of the trunk.   

How To: Editing fixed Trunk costs  

1) Select the ‘Costs’ option from the Configure menu or click the  icon on the toolbar 

2) Expand the ‘Fixed Costs’ category in the left pane of the window.  This will display all available 
PBXs in your enterprise.  Expand the PBX you want to configure costs for. 

3) Click the ‘Trunk Costs’ option. 

4) Click ‘Edit Fixed Trunk Costs’ window. 

 

5) This window will list all trunk line numbers along with their, names and their defined trunk type 
as set through the telephone configuration or auto learned from the PBX.  You can select one of 
the additional costs from the drop down list which can be accessed for each trunk in the 
Additional Cost column.  These will need to have been previously created through the Additional 
Costs under Fixed Costs.  

6) Click ‘OK’ 
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Editing Fixed Extension Costs  

Fixed extension costs are the total cost associated with the extension type and one other user 
defined additional cost if you wish to apply it also to the overall costing of the extension.  For 
example you could put in an additional cost which could be applied to desk phones with a larger 
screen.  

How To: Editing fixed Extension costs  

1) Click the ‘Costs’ option from the Configure menu or clicking the  icon on the toolbar. 

2) Expand the ‘Fixed Costs’ category in the left pane of the window.  This will display all available 
PBXs in your enterprise.   

3) Click ‘Extension Costs’ 

4) Click ‘Edit Fixed Extension Costs’  

 

5) This window will list all extension numbers along with their, names and their defined device type 
as set through the telephone configuration or auto learned from the PBX.  You can select one of 
the additional costs from the drop down list which can be accessed for each extension in the 
Additional Cost column.  These will need to have been previously created through the Additional 
Costs under Fixed Costs.  

6) Click ‘OK’ 
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Handling Costs 

Handling Costs are costs that can be attributed to a call that are based on the labour costs involved 
in handling it. It is also possible to add further handling costs for each account code, DID. These 
handling costs allow calls taken on different account codes, DIDs to be charged differently, which 
can be useful if you operate a bureau service for other companies and wish to charge your 
customers differently. 

The labour costs involved with handling calls still apply to incoming calls as well as outgoing calls. 
The handling costs can be configured to include incoming calls as well as outgoing calls. This can be 
useful to do when you wish to see the how much it is actually costing you for your staff to take 
personal calls. 

 

Editing User Costs  

User Costs are the labour costs involved when employing an individual user.  Each user can be 
configured to have an associated user cost.  

Applying a user role of "user" or "supervisor" to most users would be very beneficial if user costs are 
defined, as these roles do not allow users to view or edit the configuration and hence see the 
handling rates entered for each person. 

How To: Editing User costs 

1) Select the ‘Costs’ option from the Configure menu or clicking the  icon on the toolbar. 

2) Expand the ‘Handling Costs’ category 

 

3) Click ‘User Costs’ 

4) Click ‘Edit User Handling Costs’  

 

5) This window will list all users along with their job titles and organisation groups as set through 
the organisation setup.  In the Hourly Cost (£) column you can assign per user a pro-rata hourly 
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rate.  You can copy a value to multiple users by right clicking the mouse button and copying, 
then selecting and pasting onto the other users. 

6) Click ‘OK’ 

 

Editing Handling Rules  

Handling Rules are used to specify when handling costs are applied.  You can choose to apply 
configured handling costs to incoming answered calls, outgoing calls or both. 

 

How To: Editing Handling rules 

1) Select the ‘Costs’ option from the Configure menu or click the  icon on the toolbar. 

2) Expand the ‘Handling Costs’ category in the left pane of the window.  This will display all 
available PBXs in your enterprise.  Expand the PBX you want to configure the rules for. 

 

3) Click the ‘Handling Rules’ option. 

4) Click ‘Edit User Handling Rules’  

 

5) This window will give you the option to select and apply handling costs to incoming answered 
calls, outgoing calls or both.  By default both options are enabled but to de select an option 
remove the tick in the option box to the left of the text.  

6) Click ‘OK’ 
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Editing Extension Handling Costs  

Extension handling costs are used to specify pro-rata hourly rates that will be applied and charged to 
an extension whilst handling a call. 

How To: Editing Extension handling costs 

1) Select the ‘Costs’ option from the Configure menu or click the  icon on the toolbar 

2) Expand the ‘Handling Costs’ category in the left pane of the window.  This will display all 
available PBXs in your enterprise.  Expand the PBX you want to configure the costs for. 

3) Click the ‘Extension Costs’ option. 

4) Click ‘Edit Extension Handling Costs’ 

 

5) This window will list all extension numbers along with their, extension names, defined device 
type and extension group their associated with, as set through the telephone configuration or 
auto learned from the PBX.  In the Hourly Cost (£) column you can assign per extension a pro-
rata hourly rate.  You can copy a value to multiple extensions by right clicking the mouse button 
and copying, then selecting and pasting onto the other extensions. 

6) Click ‘OK’ 
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Editing Account Code Handling Costs  

Account code handling costs are used to specify pro-rata hourly rates that will be applied and 
charged for an account code whilst handling a call. 

How To: Editing Account Code handling costs 

1) Select the ‘Costs’ option from the Configure menu or click the  icon on the toolbar 

2) Expand the ‘Handling Costs’ category in the left pane of the window.  This will display all 
available PBXs in your enterprise.  Expand the PBX you want to configure the costs for. 

3) Click the ‘Account Code Costs’ option. 

4) Click ‘Edit Account Code Handling Costs’  

 

5) This window will list all account codes along with their, account code names, and their account 
code groups as set through the telephone configuration or auto learned from the PBX.  In the 
Hourly Cost (£) column you can assign per account code a pro-rata hourly rate.  You can copy a 
value to multiple account codes by right clicking the mouse button and copying, then selecting 
and pasting onto the other account codes.  

6) Click ‘OK’ 

Editing DID Handling Costs  

DID handling costs are used to specify pro-rata hourly rates that will be applied and charged for a 
DID number whilst handling a call. 

How To: Editing DID handling costs 

1) Select the ‘Costs’ option from the Configure menu or click the  icon on the toolbar 

2) Expand the ‘Handling Costs’ category in the left pane of the window.  This will display all 
available PBXs in your enterprise.  Expand the PBX you want to configure the costs for. 

3) Click the ‘DID Costs option’. 

4) Click ‘Edit DID Handling Costs’ 

 

5) This window will list all DID numbers along with their, DID names, and their DID groups as set 
through the telephone configuration or auto learned from the PBX.  In the Hourly Cost (£) 
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column you can assign per DID a pro-rata hourly rate.  You can copy a value to multiple DIDs by 
right clicking the mouse button and copying, then selecting and pasting onto the other DIDs.  

6) Click ‘OK’ 

Location Specific Costs  

Location Specific Costs are additional costs that are dependent on the location of the PBX where the 
outgoing calls will be made from. These include the following: 

 Local Area Codes 

 Carrier Associations 

 Profit Margins 

 Taxes 

Edit Local Area Codes 

Local Area Codes are the area codes that will incur a local rate call charge.   They are dependent on 
the location of the PBX, and by default are governed by the area code entered for the PBX when it 
was created. 

The system will automatically assign the local area codes for you when the PBX is created.   If, 
however, these are incorrect for you then they can easily be modified manually. 

Area codes must be specified without the trunk access code. 

The list of local area codes can also be imported from a file, which can be easier if you have the 
information available from another source. The format of the file is very straight forward, one area 
code on one line followed by carriage return 

1270 

1260 

1606 

United Kingdom Local Area Codes  

The United Kingdom defines its local area codes by the area codes that are adjacent to the one that 
is specified for the area code of the exchange the PBX is connected to. 

javascript:kadovTextPopup(this)
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How To: Editing Local Area codes  

1) Select the ‘Costs’ option from the Configure menu or click the  icon on the toolbar 

2) Expand the ‘Location Specific’ category in the left pane of the window.  This will display all 
available PBXs in your enterprise.  Expand the PBX you want to configure the costs for. 

 

3) Click the ‘Local Area Codes’ option 

4) Click ‘Edit Local Area Codes’ 

 

5) The displayed area codes are those that can be dialled from the location of the PBX incurring just 
a local charge. You can add a new local number by clicking ‘Add’ or import a local number by 
clicking ‘Import’ 

6) Click ‘OK’ 
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Edit Carrier Associations 

Carrier associations are the rules by which the correct carrier for each outgoing call type is 
determined.  A carrier can be directly specified which means that the same carrier will always be 
used for those types of call, or least cost routing could be specified which means that the carrier will 
be automatically selected using the least cost routing digits.  If least cost routing is specified as the 
carrier, but no match is found in the least cost routing numbers, then the call will not be costed. 

How To: Editing Carrier associations  

1) Select the ‘Costs’ option from the Configure menu or click the  icon on the toolbar 

2) Expand the ‘Location Specific’ category in the left pane of the window.  This will display all 
available PBXs in your enterprise.  Expand the PBX you want to configure the costs for. 

 

3) Click ‘Carrier Associations’ option. 

4) Click ‘Edit Carrier Associations’  

 

5) This window will list all the call types used by the system and for each call type the carrier being 
used to provide the costing information.  You can select pre-installed carrier information which 
by default will include BT Business and Least Cost Routing.  If additional carriers are required 
then they will have to be configured through the carrier setup screen. 

6) Click ‘OK’ 
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Edit Profit Margins  

A profit margin can be applied to a call for each class of call type.  The profit margin is calculated 
after the call costs and handling costs have been applied. The margin can be specified as either a 
fixed amount or as a percentage of the total cost. 

How To: Editing profit margins 

1) Select the ‘Costs’ option from the Configure menu or click the  icon on the toolbar 

2) Expand the ‘Location Specific’ category in the left pane of the window.  This will display all 
available PBXs in your enterprise.  Expand the PBX you want to configure the costs for. 

3) Click the ‘Profit’ option. 

4) Click ‘Edit Profit Margins’  

 

5) This window will list all the call types used by the system and for each call type you can enter a 
‘Profit’ value in the Profit column.  Then you can select from the ‘Apply as’ column whether you 
want to apply the profit as a percentage of the calls total cost or as a fixed amount. 

6) Click ‘OK’ 
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Edit Taxes 

The taxes that are applied to calls are intended to be used when invoice styled reports are generated 
to be used to bill external customers.  The cost of a call that is subject to taxes is the call cost + 
handling cost + profit. Up to four separate taxes can be defined and are added together and applied 
to all calls.  

How To: Editing Taxes 

1) Select the ‘Costs’ option from the Configure menu or click the  icon on the toolbar 

2) Expand the ‘Location Specific’ category in the left pane of the window.  This will display all 
available PBXs in your enterprise.  Expand the PBX you want to configure the costs for. 

3) Click the ‘Taxes’ option. 

4) Click ‘Edit Taxes’  

 

5) This window will give you four entries to define four separate taxes.  You can provide a 
description for each tax entry and also the rate of taxation as a percentage. 

6) Click ‘OK’ 

Carriers 

Carriers are also known as operators, and are the telephone companies that provide the telephone 
service to your company. It is possible to have multiple carriers supply a single company. Each carrier 
is responsible for connecting one or more types of calls. It is quite common to have one carrier 
supply your local calls and another that supplies your national calls. 

If when you make a call you do not prefix the number you are dialling with another series of digits, 
then you will be using Carrier Pre-Select where the carrier is set for that type of call at the exchange. 

If you prefix the number you are dialling with another series of digits, then you will most likely be 
using Least Cost Routing. It is possible to have several Least Cost Routing carriers handle calls for the 
same call type. The carrier used is determined by the prefix entered before the number. 

MyCalls supports both Carrier Pre-Select and Least Cost Routing, and any number of carriers can be 
configured. 
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Add a New Carrier  

How To: Add a new Carrier 

1) Select the ‘Costs’ option from the Configure menu or click the  icon on the toolbar 

2) Select the ‘Carriers’ option. 

 

3) Click ‘Add Carrier’ in the right pane. 

 

4) In the window that appears you can enter a name for the carrier, the country and the least cost 
routing digits. You can enter multiple sets of least cost routing digits by separating with a comma 
and leaving no spaces. 

5) Click ‘OK’ 

 
 

 

Import a Carriers Settings  

You can use the import carrier wizard to import a carrier and its settings from a previously exported 
or created carrier file. 
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How To: Import a Carriers setting 

1) Select the ‘Costs’ option from the Configure menu or click the  icon on the toolbar 

2) Select the ‘Carriers’ option. 

3) Click ‘Import Carrier’ in the right pane 

 

4) You will be presented with a screen that allows you to browse to the carrier configuration file 
saved in a location on the local computer or a network location.  If the carrier details in the file 
already exist the carrier in MyCalls will be updated otherwise a new carrier will be created and 
listed under the Carriers area of the Configure Costs window. 

5) Click ‘OK’ 

Edit an Existing Carrier  

You can use the edit carrier wizard to modify the country the carrier is in and the least cost routing 
digits the carrier uses. 
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How To: Editing an existing Carrier  

1) Select the ‘Costs’ option from the Configure menu or click the  icon on the toolbar 

2) Click ‘Carriers’ 

3) Select the carrier you wish to edit e.g. BT Business 

 

4) Click ‘Edit Carrier’ in the right pane. 

 

5) You can change the name, modify the country the carrier is in and modify the least cost routing 
digits the carrier uses. You can enter multiple sets of least cost routing digits by separating them 
with a comma, but leaving no spaces. 

6) Click ‘OK’ 

Delete a Carrier  

You can delete an existing carrier at any time by following this procedure: 

How To: Delete a Carrier 

1) Select the ‘Costs’ option from the Configure menu or click the  icon on the toolbar 

2) Expand the ‘Carriers’ option and select the carrier name of the configuration you want to delete. 

3) Click ‘Delete Carrier’  

4) You will be asked to confirm deletion. 

5) Click ‘Yes’ to confirm, ‘No’ to cancel 

Duplicate a Carrier  

You can duplicate an existing carrier in order to customise its configuration settings but leaving the 
original configuration as it is. 
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How To: Duplicate a Carrier  

1) Select the ‘Costs’ option from the Configure menu or click the  icon on the toolbar 

2) Expand the ‘Carriers’ option and select the carrier name of the configuration you want to 
duplicate. 

3) Click ‘Duplicate Carrier’  

4) Click ‘OK’ 

Carrier Costing Periods  

Carriers offer different tariffs for calls dependent on the time of day the call was made. The number 
of time bands provided by a carrier varies from carrier to carrier though there is usually some form 
of daytime, evening and weekend rate. The daytime rate tends to be more expensive as that is when 
most business calls are made. 

The time bands used by carriers never overlap and together they must cover a complete week. 

MyCalls can have any number of time bands for a carrier. The system will automatically check if 
there are any overlapping time bands and flag an error if any overlap. 

By default, 4 different costing periods are defined.  Depending on the carrier you are creating, there 
may be different charges made for different time of the day and on different days of week. 
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How To: Editing Costing Periods 

1) Select the ‘Costs’ option from the Configure menu or click the  icon on the toolbar 

2) Expand the ‘Carriers’ option and select the ‘Costing Periods’ option under the carrier you want 
to configure the settings for. 

3) Click ‘Edit Costing Periods’  

 

4) In this window by default you will have periods pre-defined for Daytime, Evening, Morning and 
Weekend.  You can modify the values for each period including the period start time, period end 
time and the days the costing period will apply on.  To change the days, click the box in the 
column of the day you want to configure and if a tick is filled then the day is enabled otherwise 
the day is excluded from the period. 

5) You can add further costing periods by clicking the ‘Add’ button which will prompt you to 
provide a unique name for the new period.  

 

6) Enter the new costing period name and click ‘OK’.  The new costing period will now appear in the 
Editing Costing Period window for you to configure the period values as explained earlier.  

 

7) If you want to remove a costing period then simply select it from the list to highlight it and click 
‘Remove’.  You will not be prompted to confirm and the costing period will be deleted from the 
system 

8) Click ‘OK’ 

 



Call Costing 

 

   Chapter 12-21  
 

Carrier Rates 

Carrier Rates are specified by carriers in order to determine the cost of a call. A rate consists of a 
charging scheme and a period for which the rate is applied. The charges applied to a call depend on 
three factors  

1. The number dialled which in turn determines the rate to apply to the call 

2. The time at which the call was made or charging period, this determines which charging 
scheme to apply. 

3. The Rate charging scheme which defines the various cost elements for that rate during that 
period.  

These rates appear as a list of carrier rates in the ‘Carrier Rates’ table and each rate will have several 
entries, one for each costing period defined. For each rate/period we then define the charging 
scheme  

Finally, having defined the carrier rate, we relate the rate to the dialled numbers which will cause 
that rate to be applied to a call. A given rate can relate to more than one dialled number pattern e.g. 
a mobile rate may apply to numbers beginning with 071,072,073 etc. 

 

Carrier rate periods 

In order to create a set of carrier rates you must first define a set of costing periods as described in 
the previous section.  

For our example we define three periods  for all days of the week. 

Daytime 09:00:00 to 17:59:59 

Evening 18:00:00 to 23:59:59 

Morning 00:00:00 to 08:59:59 

 

Carrier Rates 

MyCalls creates the following predefined rates: 

 Local 

 National 

 International 

 Special Numbers. 

These are the default system defined rates for the MyCalls costing system and these rates cannot be 
deleted. By default costs will be applied to calls according to these rates when a carrier is added. It is 
quite rare that carriers will have such a simplistic costing structure and the user is generally required 
to create rates that match those provided by their carrier. 

User Defined Carrier Rates 
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User defined rates are created in order to match the way in which the carrier charges a call. This will 
for example require rates to be created for calls to specific Mobile networks or premium rate 
numbers.  

When a rate is added to the Carrier rates table each rate will have an entry for each of the periods 
you have defined. 

 

 

Defining Rate Charges  

Each rate applies a charging scheme which can contain one or more of the following elements. 

 Connection charge: The initial charge for connecting the call 

 Minimum charge: A minimum call charge irrespective of call duration 

 Initial Period Tariff: A period defined at the start of the call 

 Second Period Tariff: A period immediately following the first period 

 Thereafter period Tariff: Any call time following the second period 

If the Rate scheme has only one price and it does not vary by the length of the call then you must 
use the ‘There after’ element. 

Each of these elements will have a cost, duration and a charging interval. As an example the initial 
period tariff may be £0.05 (50p) for the first 5 minutes so the rate would be set up as below: 

First period cost (£) First period duration First period Interval (hh:mm:ss) 

0.05 5 00:01:00  

 

The following describes how to set up the rates. 
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How To: Add or Import a new Carrier Rate  

1) Select the ‘Costs’ option from the Configure menu or click the  icon on the toolbar 

2) Expand the ‘Carriers’ option and select the ‘Carrier Rates’ option under the carrier you want to 
configure the settings for.  

 

3) Click ‘Add or Edit Carrier Rates’  
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4) To add, click ‘Add’ and enter a name for the carrier rate –e.g.  Mobile Calls 1 

 

5) Click OK 

6) A new set of rate entries will appear referenced by the new name you have specified. 

 

7) To edit an entry click the ‘Edit’ button on the far right for the rate required. 
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8) Enter the charging scheme values.  

 

9) Charging periods can be specified as interval or fixed. If interval is specified then an interval and 
a duration must be specified. If fixed is selected then only the duration can be set 

.  

10) Click OK 
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Importing Rates 

If you need to input a set of rates into MyCalls on a regular basis then it makes sense to create a CSV 
file from which you can import the rates. Importing rates can offer several advantages. 

 Quickly import rates to multiple installations of mycalls 

 Import rates directly from a file provided by the carrier reducing errors 

 Easy to keep your rates up to date. 

If the carrier rates are complex as is often the case then you can import the rates from a 
preconfigured CSV (comma separated value) file. This file may have been supplied by the carrier in a 
particular format or it may be created manually. MyCalls provides a mechanism for relating the fields 
in a CSV file to the rate values in the MyCalls  carrier rate table as described above. 

If the carrier provides rates in a  particular format then you may be able to extract the rates directly 
from the file. If this is not possible it may be that you can adapt that file quite easily to produce a file 
ready for import. Whilst a carrier supplied file may contain information you do not need this is not a 
problem because the import process allows you to define a   

As an example of a CSV file may contain the following fields. 

Column Name Meaning Values 

Rate Name The name of the rate that will created or 
amended in MyCalls. 

Should be text or numerical 

Common Costing 
Period 

The name of the costing period that the cost 
will be associated with 

Any name from the list of 
costing periods 

Initial Cost Any connection fees associated with making 
a call 

Should be entered as a number 
(£0.00p) 

Minimum Cost The minimum that a call should cost, if the 
call cost is greater than this value then it will 
be ignored 

Should be entered as a number 
(£0.00p) 

First Period Cost Call cost for the first period Should be entered as a number 
(£0.00p) 

First Period 
Duration 

The duration that the first period will last for 
before looking at the second or Thereafter 
charges 

Enter a value in seconds 

60 Secs = 1 minutes 

3600 – 1 Hour 

First Period 
Interval 

Enter the time that the units are charged in 
i.e. per minutes / per hour 

Enter a value in seconds 

60 Secs = 1 minutes 

3600 – 1 Hour 

Second Period Cost Call cost for the second period Should be entered as a decimal 
number in £ e.g. 0.05 

Second Period 
Duration 

The duration that the Second period will last 
for before looking at the Thereafter charges 

Enter a value in seconds 
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60 Secs = 1 minutes 

3600 – 1 Hour 

Second Period 
Interval 

Enter the time that the units are charged in 
i.e. per minutes / per hour 

Enter a value in seconds 

60 Secs = 1 minutes 

3600 – 1 Hour 

Thereafter Period 
Cost 

Call cost for the thereafter period Should be entered as a number 
(£0.00p) 

Thereafter Period 
Interval 

Enter the time that the units are charged in 
i.e. per minutes / per hour 

Enter a value in seconds 
60 or 3600 

 

When preparing the CSV file, If possible set the first row of the file to contain the field names. Here 
is an example of the csv file data. 

Mobile1,Morning,0,0.042,0,0,0,0,0,0,0.02,60 

Mobile1,Daytime,0,0.042,0,0,0,0,0,0,0..05,60 

Mobile1,Evening,0,0.042,0,0,0,0,0,0,0.02,60 

Some points to note. 

 If the rate already exists then the rate name must be identical to the one already defined in 
MyCalls otherwise a new rate will be created. 

 The costing periods must be identical to the periods defined in MyCalls 
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How To: Import Carrier Rates  

When editing the carrier as in the previous section, click the import button.  

 

 

Browse to the CSV file and click next. 
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In the next step of the wizard, check the option that says ‘The First row contains column names’ this 
will ensure the column names are not imported as a rate record. If your CSV File does not contain 
field names then do not select this option. 

Set ‘Start the import at row’ to the row number in the csv file containing the first rate record to 
import. If you have selected ‘The first row contains column names’  row ‘1’ will be the row following 
the headers. So if the first row of the csv file contains the column names and the second row 
contains data set this value to ‘1’. 

 

Usually you will be importing a comma delimited file so set the file format to Delimited and the 
Delimiting Character is set to , (comma.) . Some CSV files use a different character as a delimiter thus 
the option to select any delimiting character. 

In some circumstances you may encounter a fixed format file where each value takes up a 
predefined number of characters in a fixed position in the row. In this case select ‘Fixed’ format and 
set up the position and length of each field accordingly. 

Once you have set up the file format click next. 

 

 

You will now need to link up the fields in the CSV file to the MyCalls carrier rate values. The carrier 
rate name and rate scheme elements will need to be individually assigned to fields in the file.  

To help you do this the wizard provides a ‘Assign the Values’ feature which allows you to select the 
related column in the CSV and associate it with the relevant Mycalls value.  

To do this select the ‘Column’ entry which gives a drop down list of all the columns in the CSV file.  

If the CSV file contains the column names then these names will appear in the list alternatively the 
column number will appear in which case you will need to work out the column numbers from the 
file starting at 0 for the leftmost column.. 

If the Rate type is based on variable charge per unit time format then set the Rate Type to Per and 
set the rate interval accordingly.  
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Set the ‘Call Costs are give in:’ value to represent the call cost units of 1 (£1 units), 0.1 (10 pence 
units) or 0.01 (1 pence units). 

At this point it may be worthwhile saving the settings so they can be reused with this file later. These 
settings will only work with a file of exactly the same format. Click the ‘Save Import Template’ button 
and save the settings to a file. 

 

 

Then click ‘Preview and Import Carrier Rates’ 
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Uncheck any records you do not wish to include in the import and click ‘OK’ 

 

Click ‘Yes’ to confirm and the import will complete.  

A confirmation dialog will appear when the import has completed. Click ‘OK’ 
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How To: Delete a Carrier Rate 

1) Select the ‘Costs’ option from the Configure menu or click the  icon on the toolbar 

2) Expand the ‘Carriers’ option and select the carrier name of the configuration you want to delete 

3) Select the ‘Carrier Rates’ option under the carrier you want to configure the settings for. 

4) Click ‘Delete Carrier Rates’ 

 

5) Select the carrier rates you wish to delete. You can select multiple carrier rates by holding down 
control (Ctrl) while you select with the mouse. 

6) Click ‘OK’ 

How To: Edit Carrier Rates  

1) Select the ‘Costs’ option from the Configure menu or click the  icon on the toolbar 
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2) Expand the ‘Carriers’ option and select the carrier name of the configuration you want to edit 

3) Select the ‘Carrier Rates’ option 

4) Click ‘Add or Edit Carrier Rates’ 

 

5) To edit the carrier rate you can either select the row (as shown above) and edit by selecting each 
column and altering the data. 

6) Alternatively, you can click the ‘Edit...’ button to the right of the carrier rate you want to edit. 

7) The ‘edit a carrier rate’ window appears, where you can alter the rate name, period name, 
minimum costs, initial cost, first and second charging periods and thereafter charging periods. 
You can select whether the charges are fixed or not. 

 

8) Click ‘OK’ 

 

Adding or importing Carrier Number ranges  

As mentioned previously in order for MyCalls to correctly cost a call it must relate the number 

dialled (OLI) to the call rate. This is accomplished by associating a number dialling code to a rate 

name created in the carrier rates table. Using this relationship MyCalls can determine the rate to use 

for any given call and by applying the appropriate call period (dependent on the time the call was 

made) MyCalls can calculate the call cost from the rate scheme for that period.  

Carrier Mobile, International and Special Numbers  
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Each carrier can have a selection of  

 mobile number dialling codes. 

 International dialling codes.  

 special number dialling codes e.g. emergency or premium rate.  

The system allows general codes to be assigned to a general rate e.g. 77 for a mobile number might 

be assigned to a rate called mobile1 whereas more specific numbers e.g. 7701,7702 can be assigned 

to other rates.  

Specifying a number as one of the ‘mobile’ numbers or a ‘special’ number allows extra flexibility 

when reporting. 

 

For international numbers the international countries are identified and you will need to assign a 

rate to each country in the list.  

Any numbers not entered into one of the lists e.g international codes not assigned or premium 

numbers not recognised etc will not be costed. If this occurs then once the number is added to the 

Mycalls number lists then calls can be re-costed using the system->recost calls option. 

Setting up the numbers simply requires the entry of the number and selection of the associated rate 

from the drop down list.  

How To: Add Special or Mobile Number  

Select the appropriate (Mobile or Special) Numbers from the carriers menu 

Click ‘Add’ 

Enter the number code and select the rate 
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How To: Reassign a rate to a number  

Select the Mobile or special number from the carriers menu 

Select the rate dropdown for the required number 

 

Click ‘OK’ 

 

 

How To: Assign International numbers  

Open the International numbers from the carriers menu 

The list will show all recognised countries for which standard dialling codes are available. The 
country name is shown rather than the actual dialling codes. 

Select the appropriate rate for the country selected.  
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How to: Importing numbers. 

If numbers are to be imported then for mobile and special numbers all that is required is a csv file 
containing the two fields ‘Number’ and ‘Rate’. It is important that the rate name specified in the csv 
file is the same as a rate name which exists in the carrier rates table. 

Select Mobile or special numbers from the carriers menu 

Click Import 

Specify the file format. This is the same procedure as described when importing carrier rates 



Call Costing 

 

   Chapter 12-37  
 

 

Click ‘Next’ 

Specify which columns in the csv file relate to the number and rate values in MyCalls 
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You may save the template at this point if required 

Click ‘Preview and Import’ 

The numbers and rates will be imported however if the rates cannot be found from the carrier rates 
then a warning dialog will appear and you will either have to change the rate name in the CSV or add 
the rate to the carrier rates. 

 

How To: Import International numbers  

To Import International numbers there is a file with the country names already configured. You will 
need to edit this file and add the various rate names to the second column of the file appropriate to 
the country. 

The file is found in the Mycalls installation folder and is called 

 ‘international rate assignments.csv’ 

Again the rates must exist in the carrier rates table and the country names in column 1 must not be 
edited. 

Once the file has been edited then open the International numbers dialog from the carrier rates 
menu and click ‘import assignments’ 

Proceed through the wizard in the same way as the mobile and special numbers import process. 
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Chapter 13 

Reporting 

MyCalls provides a comprehensive reporting facility. The reports can be run manually or scheduled 
and automatically distributed. Whilst having on screen statistics is useful for daily activities for more 
detailed planning and monitoring you need to use the reporting engine.  

When to run reports  

MyCalls offers a large selection of pre-defined reports that can be configured to look at every aspect 
of your call usage. There are two main types of report, Lists and Summaries. A list report will display 
individual call details, showing the time, date, CLI and other information relating to the call. A 
summary report will display the number of calls totalled up as well as other statistics. The reports 
can be easily renamed, copied and customised. 

Selecting which reports to run 

Reports can be either run in an ad-hoc manner where they are configured and run as they are 
required or as a saved report item. Saved reports can be run on demand or grouped together and 
run as a report schedule at a specified time  

Creating and Using Report items from a template 

Report templates are the definitions that form the basis of all reports. The report templates are 
organised into categories of: 

 Performance: Used to show general performance indicators such as grade of service and 
responsiveness.   

 System: Details alarms, audit logs, auto configured devices and unused or infrequently used 
devices 

 Usage: Wide ranging reports showing phone system usage grouped and filtered by any 
combination of parameters. Reports can contain itemised details or summarised data. 

The actual report templates are as follows  

Performance 

 Grade of service 

 Response times 
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System 

 Alarms Raised 

 Auto Configured devices 

 System Audit 

 Unused devices 

Usage 

 Call Summary  

 Call Details 

 Call Type Summary 

 Group Summary 

 For each member 

 Time Profile 

 Top Calls 

 Trunk Utilisation 

 Directors Report 

The Usage reports also provide a set of custom reports which allow you to configure the result 
columns of the report to suit your requirements. Custom reports are available for: 

 Call Details 

 Group Summary 

 Group Summary for each member 

 Group Summary profile 

  

Running a report Template 

 

Quick tip:  

Whilst you can configure and run a report template directly it is not the recommended approach. 
The correct way to configure a report is to take a report- template and save it as a report item first. 
This allows you to configure a variant of the template with specific configuration parameters. The 
report can then be rendered at any time. 

How To: Run a Report Template immediately 

1) You can do this by clicking the ‘Configure and Run Now’ link in the right pane of the reporting 
area. You will have first had to select the relevant report you wish to run in the left pane of the 
configure reports window to make it the active report. 

2) You will then need to configure the reports options before the report will be run and displayed 
in the report viewer. 

 

 

Using Report Items 
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Report Items are report templates that have been configured and saved. They are created from the 
‘Create Saved Report Item’ option from the report template. Each report item must be uniquely 
named and once created they can be:  

 Run in the same way as a template report  

 Edited  

 Deleted.  

 Placed into report schedules and run at a predefined time 

By default, MyCalls, when installed, will have a number of pre-configured report items available to 
be run. The report items available will depend on the version of MyCalls being run, being either the 
Basic or Call Manager version. 

Pre defined Report items 

Custom Reports 

 

Daily Agent Activity: Provides a summary set of values for all agents of a group for any given type 
of device. The information included on the report is user selectable, along with the headings and 
widths of the columns used to display the information. 
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Daily Costs by Telephone Number: Provides a list of detailed calls that are grouped by a specified 
device type, such as extension or account code. The report can be further filtered so it only applies 
to a certain range of devices such as a specific extensions group or organization group. The 
information included on the report is user selectable, along with the headings and widths of the 
columns used to display the information. 

 

 

Daily Incoming Abandoned Calls: Provides a list of detailed abandoned calls that are grouped by a 
specified device type, such as extension or account code. The report can be further filtered so it only 
applies to a certain range of devices such as a specific extensions group or organization group. The 
information included on the report is user selectable, along with the headings and widths of the 
columns used to display the information. 
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Daily List Misdialled Outgoing Calls: Provides a list of misdialled outgoing calls that are grouped 
by a specified device type, such as extension or account code. The report can be further filtered so it 
only applies to a certain range of devices such as a specific extensions group or organization group. 
The information included on the report is user selectable, along with the headings and widths of the 
columns used to display the information. 

 

 

Daily List of Personal Calls: Provides a list of personal calls that are grouped by a specified device 
type, such as extension or account code. The report can be further filtered so it only applies to a 
certain range of devices such as a specific extensions group or organization group. The information 
included on the report is user selectable, along with the headings and widths of the columns used to 
display the information. 



Reporting 

 

   Chapter 13-6  
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Daily Incoming Performance: Provides a summary of incoming call performance. The information 
included on the report is user selectable, along with the headings and widths of the columns used to 
display the information. 

 

 

Daily Outgoing Call Performance: Provides a summary of outgoing call performance. The 
information included on the report is user selectable, along with the headings and widths of the 
columns used to display the information. 

 

 



Reporting 

 

   Chapter 13-8  
 

 

List: All Abandoned Calls: Provides a list of abandoned calls that are grouped by a specified device 
type, such as extension or account code. The report can be further filtered so it only applies to a 
certain range of devices such as a specific extension group or organization group. 
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Monthly Reports 

 List: Most Dialled Numbers: Provides a list of numbers that were most frequently dialled or 
answered. The list can be filtered to a specific type of call such as incoming or abandoned, or to 
devices such as the extension group that handled the call or the trunk group. All the device types 
can be used to provide very detailed filtering. The results can then be ordered by the total length 
of calls for that number, the call cost for the number or the call handling cost for that number. 

 List: Most Frequent Incoming Callers: Provides a list of callers that were most frequently dialled 
or answered. The list can be filtered to a specific type of call such as incoming or abandoned, or 
to devices such as the extension group that handled the call or the trunk group. All the device 
types can be used to provide very detailed filtering. The results can then be ordered by the total 
length of calls for that number, the call cost for the number or the call handling cost for that 
number. 

 Summary: All Calls: Provides a summary of the volumes and handling times of different call 
types for any given type of device. 

 Summary: All Calls by Costing Type: Provides a summary of the volumes and handling times of 
different call types for any given type of device. 

 Summary: All Calls by Extension: Provides a summary of the volumes and handling times of 
different call types for all the members of a group for any given type of device grouped by 
extension usage. 

 Summary: All Calls by Trunk: Provides a summary of the volumes and handling times of 
different call types for all the members of a group for any given type of device grouped by trunk 
usage. 

Weekly Reports 

 List: Most Dialled Numbers: Provides a list of numbers that were most frequently dialled or 
answered. The list can be filtered to a specific type of call such as incoming or abandoned, or to 
devices such as the extension group that handled the call or the trunk group. All the device types 
can be used to provide very detailed filtering. The results can then be ordered by the total length 
of calls for that number, the call cost for that number or the call handling cost for that number.  

 List: Most Frequent Incoming callers: Provides a list of callers that were most frequently dialled 
or answered. The list can be filtered to a specific type of call such as incoming or abandoned, or 
to devices such as the extension group that handled the call or the trunk group. All the device 
types can be used to provide very detailed filtering. The results can then be ordered by the total 
length of calls for that number, the call cost for that number or the call handling cost for that 
number. 

 Summary: All Calls: Provides a summary of the volumes and handling times of different call 
types for any given type of device. 

 Summary: All Calls by Costing Type: Provides a summary of the volumes and handling times of 
different call types for any given type of device. 

 Summary: All Calls by Extension: Provides a summary of the volumes and handling times of 
different call types for all the members of a group for any given type of device. 

 Summary: All Calls by Trunk: Provides a summary of the volumes and handling times of 
different call types for all the members of a group for any given type of device. 

Daily Reports 

 List: All Calls: Provides a list of detailed calls that are grouped by a specified device type, such as 
extension or account codes. The report can be further filtered so it only applies to a certain 
range of devices such as a specific extension group or organization group. 
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 List: All Calls by Telephone Number 

 List: All Calls to Voice Mail 

 List: All Outgoing Calls 

 List: Calls to International Numbers 

 List: Calls to Mobile Numbers 

 List: Calls to Special Numbers (Premium) 

 List: Calls Under 1 Minute Long 

 List: Call Costs by Most Expensive Call: Provides a list of calls that are ordered by either their 
duration, call cost, handling cost, ring or held times and above a certain level, such as calls over 
ten minutes long. The report can be further filtered so it only applies to a certain range of 
devices such as a specific extension group or organization group. 

 List: Grade of Service: Provides a list of the 30 minute interval periods that did not meet the 
specified grade of Service. 

 List: Most Dialled Numbers: Provides a list of numbers that were most frequently dialled or 
answered. The list can be filtered to a specific type of call such as incoming or abandoned, or to 
devices such as the extension group that handled the call or the trunk group. All the device types 
can be used to provide very detailed filtering. The results can then be ordered by the total length 
of calls for that number, the call cost for that number or the call handling cost for that number. 

 List: Most Frequent Incoming Callers 

 Summary Profile: All calls by Half Hour: Provides a summary of the volumes and handling times 
for any collection of device groups, split into time intervals. 

 Summary profile: ANS/ Abd Calls by Ring Time: Lists the number of calls that have a time 
parameter within a specified time period. By using a Ring Time Parameter on abandoned calls 
this report can show at what point most callers abandon their calls. 

 Summary: All Calls by Account Code: Provides a summary of the volumes and handling times of 
different call types for all members of a group for any given type of device. 

 Summary: All Calls by DID 

 Summary: All Calls by Extension 

 Summary: All Calls by trunk 

 Summary: All Calls by Costing Type: Provides a summary of the volumes and handling times of 
different call types for any given type of device. 

 Summary: All Incoming Calls 

 Summary: All Outgoing Calls 

 Summary: Grade of Service: Provides a summary of the percentage of 30 minute intervals for 
which the Grade of Service exceeded a specified value. 

 Usage: Trunk usage by Half Hour: Lists the number of trunks that were concurrently busy for 
each interval. The total duration of all the calls for that time interval and a percentage of the 
trunks busy against the number of trunks available is also shown. This report allows you to 
identify times where your lines are being used most and whether you have too many or too few 
lines available. 
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Using Report items 

 

How To: Creating a Report item 

1) Select ‘Report Template’ on the left side of the configure reports window 

2) Select ‘Create Saved Report Item’ in the right pane. You will be asked to provide your report with 
a name and choose a destination directory to save the report in. You can choose a pre defined 
report group from the drop down list or you can enter a new report group manually. 

3) Next you will need to configure the report options before the report item will be saved and 
available to run from the report group you saved it in.  

How To: Editing a Report item 

1) Each report item can be edited as required and the resulting changes saved 

2) Open the report item by clicking ‘Edit Report item’ 

3) Go through the report wizard and make the required changes to the report 

4) Click ‘Finish’  

5) Your changed have now been saved 

6) If the changes to the report are extensive it is recommended that you copy the report item first 
and then rename the copy and edit that. 
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How To: Creating a Report item group 

1) Click ‘Reports’ 

2) Click ‘Report Items’ on the left side of the configure reports window 

3) Select the item you wish to create a group for e.g. Daily Agent Activity 

4) Click ‘Change Group’ in the right side of the configure reports area 

 

5) Enter the name of the new group you wish to create 

6) Click ‘OK’ 

How To: Moving a Report item to a different group 

1) Click ‘Reports’ 

2) Click ‘Report Items’ 

3) Select the item that you wish to move 

4) Click ‘Change Group’ in the reports configuration area 

 

5) Select the group you wish to move the item to from the drop down menu 

6) Click ‘OK’ 

7) The item will now be in the new group 

 



Reporting 

 

   Chapter 13-13  
 

 

How To: Copying an existing Report Item as the basis for your new Report  

1) Click ‘Reports’ 

2) Click ‘Report Items’ 

3) Click ‘Copy Report Item’ 

 

4) Enter the report name e.g. Daily Incoming Performance 

5) Click ‘OK’ 

6) The report will have been copied. 

How To: Customising a copied Report item 

1) Click ‘Reports’ 

2) Expand ‘Report items’ 

3) Select the item that you wish to customise, e.g. Daily Reports - ‘List: All Calls to Voicemail’ 

4) It is recommended that you copy the report item first. Click ‘Copy Report Item’ 

5)  This item, once copied, will appear in the list. Select this newly copied report to edit. 

6) Click ‘Edit Report Item’  

7) A new window will open where you can change the settings. Click ‘Next’ to navigate through and 
click ‘Finish’ when you have made the changes. 

How To: Deleting a Report item 

1) Click ‘Reports’ 

2) Click ‘Report Items’ 

3) Select the item you wish to delete 

4) Click ‘Delete Report Item’ 

5) Click ‘Yes’ 
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General operations for configuring report templates and report items 

In order to create a report item you will need to configure the report so it renders the information 
you require. There are a number of steps involved and the exact sequence is dependent on the 
specific report and also on the selections you make during the configuration process. There are a 
number of operations common to many of the report templates and these operations such as 
setting the reporting period, filtering etc are described generally below. All configurations of reports 
are accomplished via the report wizard.  

The Report wizard 

Creating and editing report items will involve using the report wizard. The wizard takes you through 
various pre-defined steps and allows you to construct your report.  Each step deals with a distinct 
aspect of producing the report and whilst the details of each step will vary, dependent on the 
specific report being produced, the general type of information being configured fall into the 
following categories: 

Reporting period 

 Defines the period for which the report collates data. This can be for as small a period as a few 
hours to a complete report covering a year or more. 

Grouping 

 Define the way in which the report groups the results. For example you may wish to break down 
your report by extension or extension group, you may wish to break down the report by grouping 
together calls of a specific type such as outgoing or incoming. 

Consolidation of transferred calls  

 Each segment of a transferred call (either incoming or outgoing) can be logged as a separate 
statistic. When viewing a call as a whole it may be preferable to collect all the call segments and 
present the call statistics as a single call. This allows you to decide which way you want to see the 
call statistic for transferred calls   

Filtering 

When setting up a report you usually don’t want to see all the possible information relating to a 
particular aspect of the call data. If you are viewing extension statistics for example you might want 
to see only a particular range or group of extensions or even an individual extension. To accomplish 
this you can specify a set of filters for the report. The exact filtering available depends on the type of 
report being generated. 

The initial filter screen will allow you to specify groups of devices or data that you wish to filter on. 
When you have done that you will then be presented with a series of screens which allow you to 
specify detailed filtering information.  

 

Quick tip:  

Detailed reports covering long time periods can result in delays whilst the reports are generated.  

Scheduling these sorts of reports to run out of hours is recommended. 
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Setting the Reporting period 

The reporting period is defined as the first stage of the report creation wizard. There are various 
parameters available dependent on the complexity of the required report. The different forms 
presented by the wizard can include the following settings. 

Basic Time and Date Entry 

You will be presented with the options to select a ‘Regular’ period or a ‘Custom’ period.  

 

Regular: Select the report period from the drop down menu e.g. this week, last week etc. 

 

Custom: Specify the Start/End date and times. Clicking on the Date displays a calendar control to 
make selection of Dates easier. 
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Include calls for the following days: A series of check boxes allowing you to select which days of the 
week are included in the report. 

Define periods: Certain reports allow the setting of up to two periods e.g. 9:00 – 12:00 , 14:00 – 
18:00. This allows you to include or exclude certain periods during the day e.g. Shift periods, Lunch 
breaks etc.  

 

Limiting the report length  

You may specify the maximum number of records a report can contain or specify that you wish to 
see all records matching the criteria defined in the report configuration. To limit the number of 
items simply type the number of records into the textbox. 

 

Ordering Results  

You can specify how you wish the results ordered in the report. Specifying ‘Time of call’ for instance 
will display your results in order from the earliest time through to the latest time; alternatively 
specifying ‘Duration’ would display calls from the shortest to the longest call. 
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Grouping results  

Grouping results allows you to specify which results need to be kept together in the report. The 
grouping options depend on the type of report being produced.  

Example: Grouping by extension 

You wish to report on extensions showing the number of calls made by each extension within a 
certain group. Group by extension which means that each extension will be shown with all the calls 
associated with that extension listed in a group below it.  

 

Extension 2462 is shown with two calls, 2471 has 1 call, 2578 has 2 calls and 2541 has 4 calls. Calls 
are ordered by ascending ‘time of call’ (earliest first). 

 

Types of Grouping screens found in the reporting wizard  

Different report templates provide varying levels of grouping complexity or format dependent on 
the type of report. The simplest type of grouping comprises a drop down menu of device types. 
More complex reports allow you to select the device and select groups and types of device. 

Grouping in ‘Call Detail’ reports 

The simplest type of grouping allows you to select the grouping item from a drop down menu. 
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Grouping in ‘Group Summary’ reports 

More advanced grouping gives you the option to select a group of devices, Extensions, DDIs etc and 
then pick from the list of groups defined for that device.  

Filtering results  

Setting the filter groups 

To ensure the reports you are configuring only produce the information you require you will need to 
apply filters to the results. 

Filters allow only the specified information to be processed in the final report.  

For example you may want to produce a report grouped by class of call i.e. incoming, outgoing etc 
but only detailing the calls to and from the sales department. To accomplish this you would specify a 
call detail report specifying the class of call i.e. Incoming, Outgoing etc, as the grouping field but 
applying an extension group filter and selecting the sales group in the filter details. 
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Setting filters is a two stage process 

1. Specify which devices, users, call types etc you wish to apply filters to 

 

2. Select the detailed information for each of the types of filtering selected in stage 1. Each of 
the device filters defined in the first stage will cause a detail filter screen to be displayed. 
This detailed screen will appear as part of the sequence of screens for configuring the report 
and will present you with the detailed information appertaining to that device. For example 
the screenshot shown below illustrates the detailed selections for extension devices. 

 
The detailed filter screens are similar in operation. You choose which groups of device to include in 
the report and /or individual devices to include in the report. So in the example above you could 
include a complete group or a single extension. Any items not included in the filter are excluded 
from the report. 
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Deleted devices 

The option to include deleted devices enables correct reporting of historical data In the event that a 
report is required for some period in the past and devices had been deleted since then. 

Including an individual device 

With reference to the screenshot above, type a part of the extension you wish to include until you 
can locate the extension(s) required from the individual extension list. Select the extension(s) 
required and click the Add button. The extensions to be included in the report will appear in the 
right hand, ‘Included Extensions’ box. Click the remove button to remove the extensions if they are 
not required. 

Specifying Call types to include in a report  

Many of the report templates allow you to specify call types for inclusion in the reports. This means 
you can analyse only incoming call types or only outgoing call types or even down to specific types of 
call such as incoming abandoned, outgoing transferred etc.  

For more detail on available call types see the detailed list in Appendix A. 

You can select the call types from the list of ‘Call Types to Include’ . This list includes a breakdown of 
all the possible call types available or you can simplify the list by deselecting the ‘Show Advanced call 
types’ checkbox 

Alternatively you can select the three basic call types; Incoming, outgoing and internal by checking 
the appropriate ‘Call Type Group’ checkbox. 

 

Configuring the call types for comparison 

When configuring reports which compare call types for specified intervals (see next section) you are 
asked to provide call type information for two sets of call types. This is exactly the same procedure 
as for defining call types described above (see ‘Specifying Call types to include in a report’) with the 
additional requirement to select two sets of call type. Typically you might want to compare incoming 
versus incoming abandoned or incoming versus outgoing.  
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The available MyCalls usage reports include: 

 Detail and summary reports 

 Time distribution and profiling  

 Frequent calls 

 Top Calls 

 Trunk Utilisation 

 Custom reports 

Standard Report 

For the purposes of this manual a basic report configuration would contain one or more of the 
following configuration steps. 

 Reporting period 

 Grouping 

 Ordering 

 Transfer Consolidation 

 Filtering 

 Call type selection 

Most reports contain these steps plus in most cases additional report specific screens. These 
standard configuration steps are explained in the previous section. The following sections describe 
the specific report templates and any special report specific configuration screen. 

Performance Reports  

Grade of service Group detail  

This report shows a breakdown of the percentage of groups which met or exceeded target grade of 
service for duration and abandoned calls in half hour intervals throughout the reporting period.  
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Grade of service group summary 

This report shows a summary of the percentage of groups which met or exceeded target grade of 
service for duration and abandoned calls 

 

 

Response times 

Lists for each extension the number of answered calls, abandoned calls and a relative percentage of 
how each extension response time compares with the rest of the group. 

 

 

System Reports 

Alarms Raised 

A list of Alarms raised during the reporting period, can be filtered by PBX 



Reporting 

 

   Chapter 13-23  
 

 

Auto Configured devices 

A simple report showing all automatically configured devices during the reporting period 

 

System Audit  

This report shows a record of system audit entries for the duration of the reporting period. Audits 
are generated by the system when an event occurs such as starting or stopping of a service. 

 

Unused or infrequently used devices 

Allow you to keep track of devices which are infrequently used.  
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Usage Reports 

Detail and Summary reports  

Call detail and Group summary reports produce individual detailed statistics or cumulative statistics 
for calls over a defined reporting period. The standard reports can be grouped and filtered to give 
whatever calls or subsets of calls you require. 

Call Detail reports give a breakdown of individual calls grouped by device or user  and filtered as 
required 

 

Group Summary reports show cumulative information on device groups or user groups by call type 
and filtered as required 
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Group Summary by Member shows cumulative call information for each member of a group or 
groups and filtered as required                     

 

 

How to: Configure a call details or group summary Report  

1) Select the report item or template 

2) Configure the reporting period 

3) Configure the grouping and ordering settings according to the specific report being configured  

4) Configure the filtering settings 

5) ‘Save’ and run the report 

 

Call detail reports show the following statistics  

 Time of call 

 User 

 Call type 

 Total Duration* 

 TFR** 

 Caller Name 

 Dialled Number 

 Location 

 Ring time 

 Handling cost 

 Call cost 

 Total cost 

*Total Duration shows duration of each leg of a transferred call. If transfers are consolidated then 
this indicates the cumulative total of all transfers for that call. 

**TFR indicates the leg of the transferred call where the initial leg of the call is TFR=1. If the transfers 
are consolidated then this column indicates the count of transfer legs. 
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Group Summary reports show the following statistics  

 Number of calls: Answered, Abandoned, Outgoing, Transferred 

 Average Duration: Answered, Outgoing 

 Average Ring time: Answered, Abandoned 

 Number of Long waits 

 Number of long calls 

 Number of short calls 

 Costs: Call costs, Taxes, Fixed costs, Handling costs, Total costs, Profit 

 

Reports involving time intervals and profiles  

Several report templates have been specifically designed to provide statistics broken down and 
analysed in definable time periods. 

There are three basic report templates which do this  

 Summary Time Distribution 

 Summary over same time interval 

 Summary comparison 

Time Intervals v Reporting period 

The reports for time distribution, time interval and profile require two distinct settings related to 
time intervals 

The reporting period: Defines the start and end date during which the data for the report was 
recorded. For example we may want to view a report for the month of August or for the past six 
months or for the past two days. These are all reporting periods and they are configured as the first 
part of the report wizard as described in the relevant section above. 

The statistical interval(s) describe the intervals of time over which the summarized results are 
calculated. An example might be where we show a breakdown of incoming calls for each day for the 
month of August. The statistical interval would therefore be ‘Daily’ whereas the reporting period 
would be 1st to 30th of August. 

More specific detail on the interval periods employed are explained in the following sections which 
describe the configuration of each type of report.  

Call summary over same interval  

This report gives a comparison of two call types. The example here shows Incoming and Incoming 
abandoned for the same period split up into day of week totals. The reporting period is over 1 
month (August 2008) so the totals for each ‘Monday’ represent a total of all calls received on all 
Mondays during the reporting period. 
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Configuring the call types and interval periods requires you to select two sets of call types. Each set 
of call types can have more than one call type selected but the resulting totals will add all values for 
the selected call types into one total e.g. if you select incoming and incoming transferred these calls 
will be added together to produce a single total value for the call-type-set. 

 The Interval period e.g. Day of Week is selected from a drop down menu during configuration of the 
report and includes: 

 Minute of hour: 1 to 60 

 Half hour of day:  00:00 – 00:30, 00:30 – 01:00 etc 

 Hour of day: 0-1, 1-2, 2-3 etc 

 Day of week:  Mon, Tue, Wed etc 

 Day of month:  1 – 31 etc 

 Day of year:   1 – 365 (6) 

 Week of year: 1 - 52 

 Month of year:  1 – 12 

selecting the call-type sets and Interval 
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Ordering the results 

 
Setting the order of results 

Ordering of the resulting report can be adjusted by selecting one of the order by values. This means 
that the results are no longer determined by the time interval but by the field specified in the group 
by box. This can result in confusing results if you are not aware of the purpose for the ordering. If 
you were to select ‘Max Ring Time’ as the order by column and ‘Day of week’ as the interval then the 
first result in the report will be the day of week with the longest total ring times recorded. This 
means that the days of the week will probably appear out of order as example below. 

 

Note in the report shown the days of the week appear out of order however if we view it from the 
perspective of wanting to know which days of the week during August are giving the longest wait 
times then this report will tell us very quickly, in this case it is Saturday, with Sunday having the 
shortest response time. 

Call Summary Time Distribution Report  

In many cases you may have a set of markers which define what the minimum, maximum and 
optimum times are for ring time, held time and duration of calls. You may wish to analyse how many 
of your calls fall inside and outside these time slots. You can use the ‘Time Distribution’ report to do 
just that. 

The time Distribution report allows us to define a set of time slots starting at a particular value e.g. 
10 seconds and repeating up to a final value e.g. 60 seconds at 5 second intervals. This would give us 
time slots as follows: 

10-15 seconds 
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16-20 seconds 

21-25 Seconds 

26-30 seconds  

And so on up to 60 seconds 

This report will then tell us how many calls over a given reporting period fall into each of these time 
slots. Obviously this allows us to determine what our current operating times are and if we are 
operating in the target times. If not then we can use other reporting tools to determine if our target 
times are realistic or not. 

 

To set up the above report we would set the configuration shown. 

 

 

Call type summary comparison 

This report allows comparison of two different calls types at regular intervals. The intervals can be 
multiples of: 

 Minute 

 Hour 
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 Day 

 Week 

The report collates statistics for the specified intervals for the duration of the reporting period.  

 

Configuration requires you to set the Interval count and the interval value. For example an interval 
count of 4 and an interval setting of Hour will give a report statistic calculated every 4 hours. 

Ordering can be based on: 

The specified interval (Default) 

Number from 1st or 2nd call type 

Maximum ring from 1st or 2nd call type 

Maximum Duration from the 1st or 2nd call type 

Average duration from 1st or 2nd call type 
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Group Summary time profile  

This report gives a group summary presented at specified time intervals. The time interval settings 
are specified as the interval count and the interval value (as per the previous ‘call type summary 
comparison’ report. 

The difference with this report is that you specify a group of devices to report against as shown 
below. 

  

 

 

 

 

Special Usage Reports  

Directors Report 

This report gives a general summary of call activity for daily, Weekly and Monthly periods. Select 
Directors report from the usage templates and select the reporting period from the wizard screen. 
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Click Finish and the report will be generated 

 

The report includes the Number of calls, Average Duration and Average ring time statistics along 
with the longest waiting periods for incoming and incoming abandoned calls as well as the most 
expensive call made during the period. 

 

Playback Audit 

This report will provide a list of playback activity audits over a given reporting period.  
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The report is configured using the wizard screen above. 

Included Organisation groups: Define the groups of users you wish to see the audits for. 

Include sub groups of selected groups: Includes all users belonging to sub groups of the groups you 
have selected. 

Group according to: Results can be grouped together based on either the user who performed the 
operation or the user whose calls were listened to or exported. 

You can define the type of audits to be included by selecting the appropriate checkbox. 

There is also an option to eliminate calls which were listened to for less than a specified amount of 
time which can be expressed as a percentage of the call length or as an absolute time in hours, 
minutes and seconds. 
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Trunk Utilization Report 

Provides statistics on trunk utilization over specified time intervals during the reporting period 

Statistics displayed are 

Interval period: set in the configuration 

Maximum trunks: Maximum number of trunks used at any one time during the interval 

First time at maximum: When the maximum number of trunks was first reached 

Duration: Total call duration across all trunks included in the report 

% Utilisation: Percentage usage of trunks for the interval versus total trunks 
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Most frequent calls 

Gives details of which numbers have been handled most frequently for both incoming and outgoing. 

You can specify a minimum number of calls before a number is included in the report 

 

Statistics for these calls in the report are: 

 Caller Name 

 Call type 

 Number 

 Location 

 Amount 

 Total duration of calls to and from that number 

 Cost and total cost of calls to that number 
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Top Calls  

Provides information listing the calls with Duration, Held time or Ring time greater than a defined 
value or calls with a call cost or handling cost of greater than a defined value. 

Statistics for these calls in the report are: 

 Time of call 

 PBX 

 Extension 

 User 

 Duration 

 Dialled Number 

 Location 

 Ring Time 

 Call Cost 

 Handling Cost 

 Total Cost 

 

 

Custom Reports  
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What is a Custom Report  

A custom report allows you to specify precisely what information you want to include in the report 
fields. For example if you require a report which does not show costing information in a call details 
report then a custom report can be configured to accomplish that. 

The majority of the configuration process for custom reports follows the standard report template 
for that type of report. There are custom reports available for the following template types 

 Custom Call Details 

 Custom Group Summary 

 Custom Group Summary for each member 

 Custom Group Summary Profile 

Where a custom report differs is in the choice of fields which can be shown.  

How To: Setup a Custom Report 

1) Create a report item based on the custom report template required 

2) Configure the reporting period 

3) Configure the Device Groups and devices 

4) Configure the unavailable codes if required – The example screen shows the configuration for 
the Group Summary custom report. 
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5) Click on the ‘Available information’ button and Specify your custom fields using the menus and 
submenus, click on the required fields to add them to the report. 

 

6) Drag the columns to define their order from left to right on the report.  

7) If you wish you can preview the report at this time by clicking the ‘Preview Report’ button. You 
will see a resulting report which shows the columns configured but the data will not be accurate. 

8) Complete the configuration of the rest of the report i.e. Filtering, Transfer consolidation and call 
types 

9) Save the report item 

 

Custom Report Parameters  

Custom reports, by definition can contain a very wide range of parameters in the various report 
columns. Depending on the purpose of the report you will select parameters from one or more main 
categories. The actual parameters available for your custom report will differ depending on the 
custom report template you have chosen to base your report on. 

Parameters can be selected from the ‘Available Information’ option in the custom report 
configuration wizard 
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The following is a summary of the various report parameters. A detailed definition of each 
parameter is to be found at the end of this section. 

Custom Report Parameters fall into the following main categories.  

For custom summary reports 

 Call Durations 

 Costs 

 Call Counts 

 Call Count Percentages 

 Users 

 Performance 

For custom detail reports 

 General 

 Trunks 

 Extension 

 DIDs 

 Account codes 

 Callers 

 Costs 

 Times 

 Completion Codes 
 

 

Custom Summary Reports - Call Durations 

Call durations show you how long a specific type of call or how long a particular phase of a call has 
taken.  
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Call Durations - General 

The call durations are broken down into: 

Absolute Durations e.g. a call lasted 10 minutes or the longest call for a given extension lasted 25 
minutes.  

Average Durations e.g. the average incoming call lasted 5 minutes. 

Range  Durations e.g. Minimum, Maximum etc. 

The values available are: 

 Abandoned ring 

 Average abandoned ring 

 Average held 

 Average incoming 

 Average incoming + outgoing 

 Average incoming ring 

 Average outgoing 

 Average ring no answer ring time 

 Held 

 Incoming 

 Incoming + outgoing 

 Incoming ring 

 Longest abandoned ring 

 Longest incoming ring 

 Longest ring no answer ring time 

 Max call time 

 Min abandoned ring 

 Min incoming ring 

 Min ring no answer time 

 Outgoing 

 Ring no answer time 

Call Durations - Time to Answer 

Gives the ‘Time to Answer’ a specific percentage of calls e.g. how long did it take to answer 50% of 
calls 

  

Custom Summary Reports - Costs 

General 

 Call costs 

 Fixed Costs 

 Handling costs 

 Max incoming call 

 Max incoming handling 

 Max outgoing call 

 Max outgoing handling 

 Overall cost 

 Profit 
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 Taxes 

 Total incoming call 

 Total incoming handling 

 Total outgoing call 

 Total outgoing handling 

 

Category Counts, Category Totals, Category Averages 

 Free 

 In state 

 Incoming 

 International 

 Local 

 Local toll 

 Long distance 

 Mobile 

 National 

 National (Generic) 

 Not defined 

 Special 

 Unknown 

 

Custom Summary Reports - Call Counts 

Call counts for different types of calls as follows: 

 Abandoned Incoming 

 Abandoned Outgoing 

 Handled 

 Held 

 Incoming 

 Incoming + outgoing 

 Incoming conference 

 Incoming intraflow 

 Incoming network 

 Long calls 

 Long waits 

 Offered 

 Outgoing 

 Outgoing conference 

 Outgoing network 

 Picked up 

 Short calls 

 Transfer count 
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Ring Distributions 

Call count ring distributions provide a way of reporting how many calls were answered in specific 
time ranges e.g. how many calls were answered inside 6 – 10 seconds as opposed to 11-15 seconds. 
There are two distributions 

Incoming ring times – Calls which were answered 

Abandoned ring times – Calls which were abandoned 

 

Custom Summary Reports - Call Count Percentages 

Call count percentage values show how many calls rang up to a specific time and how many calls 
rang over a specific time. You have a choice of Incoming calls and Abandoned calls e.g. how many 
calls rang for up to 20 seconds? 

Call count percentage ring distributions split the call count percentages into time intervals as follows 

 Below 5 seconds 

 5 – 10 seconds 

 6 – 10 seconds 

 11 – 15 seconds 

 And every 5 second interval up to 60 seconds 

 Over 60 seconds 

This allows analysis of the percentage of incoming and abandoned ring times falling into a given time 
interval 

 

Custom Summary Reports - Performance 

 Abandoned Grade of service 

 Grade of service 

Custom Detailed Reports – General 

Various parameters for which usage can be calculated 

 Call ID 

 Call type 

 Costing type 

 Grouping details 

 Least cost routing digits 

 Location name 

 Location state 

 Long call 

 Long wait 

 PBX code 

 Short call 

 Telephone number 

 Time of call 

 Total transfers 
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 Transfers to this part of the call 

 User name 

 

Custom Detailed Reports – Trunks 

Values relating to the trunk usage 

 Destination trunk name 

 Destination trunk number 

 Source trunk name 

 Source trunk number 

 Trunk name 

 Trunk number 

 

Custom Detailed Reports – Extension 

Values relating to the extension usage 

 Destination extension name 

 Destination extension number 

 Source extension name 

 Source extension number 

 Extension name 

 Extension number 

 

Custom Detailed Reports – DIDs, Account codes, Callers  

Values for these various devices 

 Name 

 Number 

Custom Detailed Reports – Costs 

 Call costs 

 Handling costs 

 Overall costs 

 Profit 

 Taxes 

 Total call cost 

 

Custom Detailed Reports - Times 

 Held time 

 Ring time 
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 Talk time 

 Total duration 

Custom Detailed Reports – Completion Codes 

 Completion Code level 1 

 Completion Code level 2 

 Completion Code level 3 

 

Report Viewer 

Once a report has been generated it is presented in the report viewer. The viewer has the following 
options available from its toolbar. 

 

Paging controls: allow navigation between pages in multi-paged reports 

Customise report: Provides a number of report customisations 

Drill Down: allows you to drill down to more detail in the report 

Export: allows export to variety of formats including CSV 

Refresh: Allows updating of the report 

Print: Print the report 

How to create a distribution list  

Report Distribution Lists are the way by which a Report Schedule sends its results to the outside 
world. You can send the results via emails and FTP servers. You can also send the results to a 
specified folder location. 

How To: Creating a Report distribution list  

1) Select the ‘Reports’ option from the configure menu or click the  icon on the toolbar 
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2) Select ‘Report Distribution Lists’  

3) Click ‘Create a New Report Distribution’ 

4) In the window that appears enter a name and click ‘Next’ 

5) Specify which email addresses the reports will be sent to, click ‘Next’ 

6) Specify whether to send the reports to the system FTP server, click ‘Next’ 

7) Select a folder on the server ( a network path) where a file containing the report may be stored 

8) Click ‘Finish’ 

 

Saving to file is run on the server. Setting up the file path must be local to that server. It is 
recommended that this be configured on the server itself. 

When saving to a file, if the file exists then the date file is created appended to the filename. 
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Scheduling Reports  

Report Schedules are the means by which a set of report items can be configured to be run 
automatically and sent to various destinations at a certain time. Note that you must have configured 
at least one Report Distribution List before you can configure any report schedules. 

 

How to: Creating scheduled Reports 

1) Select the ‘Reports’ option from the configure menu or click the  icon on the toolbar 

 

2) Select ‘Report Schedules’ 

3) Click ‘Create a Report Schedule’ 

4) In the box that appears enter a name and click ‘Next’ 

 

5) In the next window you can schedule how often a task occurs from the drop down menu, e.g. 
once, hourly…, you can alter the start time and alter how many days to schedule the task. 

6) Click ‘Next’ 

7) Select the report items to include by selecting them and clicking ‘Add’ 
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8) Click ‘Next’ 

9) Specify the format in the next window 

10) Click ‘Finish’  

When the schedule runs and is going via email then there is an email generated and each of the 
report items is included as attachments. 
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 Chapter 14 

System Utilities 

System configuration 

System configuration menu provides a selection of system related utility functions 

 

To access the menu click ‘System’ and select the required function from the drop down list 

 Backup your database 

 Database information 

 Remove unwanted information 

 Import a bill 

 Re-cost calls 

 Import Costing Files 

 Area Code Import 

 

Automatic Backup 

Create automated schedules for database backup. There are two databases which can be backed up 
Configuration and Calls. It is suggested that a regular backup of both databases is scheduled to 
eliminate problems if your system fails. 



System Utilities 

 

   Chapter 14-2  
 

How To: Automatic Backup 

1) Click ‘System’ 

2) Select ‘Automatic Backup’ 

 

3) In the window that appears, you can alter the time of daily automatic backup along with how 
many days of historical copies to preserve. 

4) Optionally you can also back up the calls database, by clicking the option ‘Backup Calls’ 

5) Click ‘OK’ 

 

Manual Backup 

Alternatively you can manually backup the databases 

How To: Back up the Database 

1) Click ‘System’ 

2) Select ‘Backup database’ 
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3) In the window that appears, select the database that you want to back up and enter the file 
name to use for the backup. 

4) Optionally, you can provide a name and description for the backup: The filename MUST be a file 
local to this PC, backup CANNOT be made to network shares or UNC paths. 

5) Click ‘OK’ 

 

Database Information 

To access the database information, select ‘System’ and click ‘Database Information’ 

The window that appears provides all the information you need to know about the current state of 
your databases. 

 

Removing unwanted information 

You will from time to time need to remove information from the calls, alarms, audit entries, events 
or deleted devices lists. Deleted devices prevent those devices from being automatically 
reconfigured so be aware that removing them would allow the devices to automatically reconfigure.  



System Utilities 

 

   Chapter 14-4  
 

How To: Remove unwanted information  

1) Click ‘System’ 

2) Select ‘Remove Unwanted Information’ 

 

3) In the window that appears, select the date and time range that you wish to delete the 
information up to and the select the types of information to delete, e.g. alarm entries, calls… 

4) Also you can select whether to remove calls to all extensions or calls to specified extensions. 

5) Click ‘OK’ 

Removal of unwanted information will result in a new audit entry being created detailing the fact 
that information has been removed. This audit entry cannot be removed. 

Importing a Telephone bil l  

How To: Import a Telephone bill  

1) Click ‘System’ 

2) Select ‘Import Telephone Bill’ 
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3) In the window that appears, you can import the calls that appear on an employee’s home 
telephone bill. To do this you must set up a template so MyCalls knows how to read the bill. 

4) Select the PBX, area code and phone number the bill is for 

5) After the bill has been processed, a list of calls will be presented for approval. 

6) If they are correct click the ‘Send to Database’ button 

7) Click ‘OK’ 
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Re-costing calls  

How To: Re-Cost calls 

1) Click ‘System’ 

2) Select ‘Re-cost Calls’ 

 

3) In the window that appears you can re-cost calls over a specified time period, you may want to 
do this if a mistake was made entering call tariffs, taxes or profit margins. You can do this by 
altering the start/ end date and time. 

4) Optionally, you can re-cost the actual call charges and/ or the handling charges by clicking the 
boxes. 

5) The taxes and profits will always be recalculated. 

6) Once you have altered the information click ‘Re-cost Calls’ 

7) Click ‘OK’ 

 

Area Code Import 

To import new area codes or change existing ones select the System -> Area Code Import option. 
This option will also allow you to modify the geographical coordinates for an area code if your 
country costs calls based on distance.  

Quick tip:  

Only countries that are not covered by the country code 01 (North America) and 44 (United 
Kingdom) can be imported or edited. 
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How To: Import Area Codes 

1) Click ‘System’ 

2) Select ‘Area Code Import’ 

 

3) In the window that appears Select the country you wish to import or change. 

4) Select Load from Database. The area codes for the selected country will be shown in the grid. 

5) Either select Import or Export the current area codes for the country. 

6) If exporting, then the file will be saved in a .CSV format, use an editor such as Notepad to make 
any changes. Use the import option to bring the new version back into the system. 

7) Click ‘OK’ the new area codes will be saved back to the database 
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Quick tip:  

When upgrading the system to a different version, any changes you make to the area codes will 
need to be re-imported! 
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Chapter 15 

Importing Data Into MyCalls  

Configuration data can be imported from a comma delimited file (CSV files). CSV files can be 
generated from programs such as excel spreadsheets. 

Import is supported for the following types of entity: 

 Account codes 

 DDIs  

 Extensions 

 Trunks 

 Callers 

 Users 

The steps required to import a set of values are very similar for all the various entities. Devices all 
share the same import format. Callers and users have different formats. 
 

Importing devices   

Device Import formats 

All devices follow the same format of Name, Extension. This is easily produced in either a text editor 
or any application which creates CSV files such as Microsoft Excel. Simply enter the list of values and 
export the list as a CSV file. 

 

The following example shows the process for importing extensions. Extensions are the most complex 
device to import, other devices follow the same series of steps but with fewer items to specify. 
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How to: Import a set of Extensions 

1) Generate the CSV file (See formats below) 

2) Navigate to the respective configuration screen Configuration->Telephone system->PBX-
>Extensions 

3) Click the  ‘Import Extensions’ option 
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4) From the ‘Import’ screen use the ‘Browse’ button to select the file containing your extensions to 
be imported. 

5) If you are assigning all extensions as a specific type then select it from the ‘type’ menu 

6) If you are importing these extensions to a specific extension group then select that group from 
the ‘Import to extension group’ menu 

7) Clicking the ‘Create users for named extensions’ option creates organisational users for each 
extension (see section on organisation users)  

8) Click ‘Load’ 

9) The ‘Extensions to import’ grid will populate. You can now make final decisions as to which of 
these to import.  

10) To edit an entry click on the field in the grid and simply type in the edited value 

11) To delete an extension select the row and press your ‘delete’ key 

12) If you make a mistake or delete a row unintentionally simply click the ‘Load’ button to reload the 
file 

13) Once you are happy with your imported list click ‘OK’ 

14) Your extensions are now imported into the configuration 

Importing Callers  

Callers are treated in the same way as devices (see example above). Simply load the CSV file and 
select the caller type to import. You can edit the loaded list prior to committing the import, in the 
same way as for devices. 

Callers’ CSV files have three fields, namely;  

 Number – Numeric no spaces,  

 Alternate Number – Numeric no spaces,  

 Name. 

 

Importing Users 

By setting up a user based import file you are able to configure most user and extension related 
information which makes configuration of MyCalls much easier than configuring everything manually 
through Users are imported into organizational groups. The field format for users allows more values 
to be specified in addition to the user name. 

 

Field Descriptions 
 

            Group The organisation group the user will belong to. If left blank then the user will be 
added to the top level group. Groups will be created automatically and nested 
groups, such as Sales\Internal sales will create two groups, one called Sales that is 
under the top level group and another called Internal sales that is under the Sales 
group. 
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Name 
The name of the user that you wish to add. Apostrophes are not 
valid. 

      

               Abbreviation The abbreviated form of the user’s name. 
         

               Password Password the user will log on to the application with. 
        

               Email Address Email address for the user 
   

               Job Title Job Title of the user in the organisation 
   

               ACD Login PIN Leave blank* 

Default 
Extension 

The extension number this user will normally use. This will allow calls from the 
extension to be assigned to this user if ACD is not used or if Hot desking clients 
from the application are not configured. 

               Enable 
Statistics 

Set to 'true' if real time windows are going to be created to view the real time call 
activity for this user. Set this to 'false' if no windows are going to be shown. This 
does not affect the reporting of extension call activity. It is strongly 
recommended that no more than 100 users be configured with set to true as 
database and application performance will decrease dramatically. 

               Enable Call 
Playback 

Set to 'true' if this user is going to be allowed to listen to call recording. Otherwise 
set to false. 

               Call Control Set to '1' if Mycalls Desktop for this user is to be enabled, otherwise '0'. If MyCalls 
Desktop is not available on your system or has not been purchased then set this 
field to ‘0’ (zero). 

               Enable User 
Hot Desking 

This is used to present the user with a list of extensions to use if they can hot desk 
when they run the application client. Set to 'true' if this user is allowed to use 
other extensions for their daily work. If they always use the same extension then 
set this to 'false'.  

               
Enable 
Extension Hot 
Desking 

This is used to specify if the extension created in the default extension can be 
used by multiple people in a hot desking environment or only by one person. Set 
to 'true' if the extension is to be made available for multiple users, otherwise set 
to 'false' 

               User Type Specifies the role within the application that the user will adopt and the features 
available. Use one of the following values: '0' - User, '1' - Supervisor, '2' - PBX 
Administrator. 

Windows User 
Name 

Leave Blank* 

Auto Login false* 

 * marked fields are not used by the SL PBX system 
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How To: Importing Users 

1) From the organization window (Configure->Organization) select ‘organization’ or one of the 
‘organization groups’ 

2) Select ‘Import users’ 

 

3) Specify the file to import, load and import the users in the same way you load devices (see 
previous section) 

4) Edit the values if required and click ‘OK’ 

5) The data will be imported into MyCalls 

 

Example Files 

There is a sample file ‘import.xls’ which is preconfigured with several examples of import data and 
this file can be found in your MyCalls installation folder. 
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Chapter 16 

Scheduled Configuration Import 

 

Scheduled configuration import allows you to apply certain aspects of the current switch 
configuration to MyCalls such as extensions, trunks etc. The scheduling provides synchronisation at 
predefined intervals to keep all information within MyCalls as up to date as possible. Data is only 
read from the PBX to MyCalls changes made within MyCalls cannot be reflected back into the PBX.  

Parameters which can be imported  

The following parameters can be imported : 

 Account Codes 

 Callers (Abb Dial) 

 Carriers 

 DIDs  

 Extensions 

 Pilot Number 

 Service Codes 

 Skill Based Routing 

 Trunks 

For each of the above you can select the following options: 

Allow Import:  Allow information to be imported for that parameter. 
 
Allow Add: Allow new instanced of the parameter or device to be added to the existing list 
e.g. new extensions. 
 
Allow Update:  Allow updates to parameters within MyCalls to be updated if their values 
have changed within the PBX. 
 
Allow Delete:  Allow instances of the parameters to be deleted from MyCalls if they have 
been deleted within the PBX. 
 
Allow Update Name:  Allow the name of the parameters to be updated. Any name changes 
made within MyCalls to devices such as extensions, will be lost if this option is enabled. 
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Editing the Configuration Import Schedule  

 

Open the Configuration Import wizard by clicking Configure > Telephone Systems > PBXs  Select 

the required PBX e.g. ‘Head Office’ and select  ‘Edit Configuration Import Schedule’ 

  

Check the ‘Enable Scheduled Import’ box 

   

Set the ‘Import Interval’ 

 

Check the boxes to suit your needs 

 

Once all information has been appropriately selected, click OK. 
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Chapter 17 

Acronyms & Glossary 

Acronyms 

ACD Automatic Call Distributor  
ACW After-Call Work  
AHT Average Handling Time  
ANI  Automatic Number Identification, also called caller ID.  
ASA  Average Speed of Answer  
ASP  Application Service Provider  
ASR  Automatic Speech Recognition  
ATA  Average lime to Abandonment  
ATB  All Trunks Busy  
CCR  Customer-Controlled Routing  
CED  Caller-Entered Digits  
CIS  Customer Information System  
CLEC  Competitive Local Exchange Carrier/ CLI Calling Line Identity  
CLID  Calling Line Identification  
CMS  Call Management System  
CO  Central Office  
CPE  Customer Premises Equipment  
CRM  Customer Relationship Management  
CSR  Customer Service Representative  
CTI  Computer Telephony Integration  
DID  Direct Inward Dialling  
DN  Dialled Number  
DND Do not disturb 
DNIS  Dialled Number Identification Service  
DTMF  Dual-Tone-Multi-frequency  
EWT  Expected Wait Time  
FCR  First-Call Resolution  
FIFO  First In, First Out  
FX  Foreign Exchange Line  
GOS  Grade of Service  
IM  Instant Messaging  
IP  Internet Protocol  
ISDN  Integrated Services Digital Network ISP Internet Service Provider  
IVR  Interactive Voice Response  
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IXC  Interexchange Carrier  
KM  Knowledge Management  
KPI  Key Performance Indicator  
LAN  Local Area Network  
LEC  Local Exchange Carder  
MIS  Management Information System  
NCC  Network Control Centre  
NOC  Network Operations Centre  
PABX  Private Automatic Branch Exchange  
PBX  Private Branch Exchange  
PDA  Personal Digital Assistant  
PRI  Primary Rate Interface  
PSN  Public Switched Network  
PSTN  Public Switched Telephone Network  
QOS  Quality of Service  
RNA  Ring No Answer  
ROI  Return on Investment  
SBR  Skills-Based Routing  
SL  Service Level  
SLA  Service Level Agreement  
UCD  Uniform Call Distributor 
VoIP  Voice over Internet Protocol 
VPN  Virtual Private Network 
VRU  Voice Response Unit 
WAN Wide Area Network 
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Glossary 

Abandoned Call (Inbound): Also called a lost call. The caller hangs up before reaching an agent. 

Abandoned Grade of Service: The percentage of calls that are abandoned after an acceptable 
amount of time. Calls that are abandoned before the specified time are not considered. A value of 
97% is generally considered an adequate Abandoned Grade of Service. 

Account Code: Also known as Project Codes or Bill-Back Codes. Account Codes are additional digits 
dialled by the calling party that provide information about the call. If all calls come into a central 
number then it is possible to enter an account code for each call to identify its purpose. Reports can 
then be run on specific account codes or groups to isolate those calls from all the others. 

Alarm Distribution List: Identifies who the alarm notification should be sent to. It is possible to 
specify email addresses, computer names and processes to run. 

Adherence to Schedule: A general term that refers to how well agents adhere to their schedules. 
The two terms most often associated with adherence include availability (the amount of time agents 
were available) and compliance (when they were available to take calls).  

After-Call Work (ACW): Also called wrap-up, post call processing, average work time or not ready. 
Work that is necessitated by, and immediately follows, an inbound call.  

Announcement Port: Generally used by an ACD system which periodically transfers a call to an 
announcement port and plays a reassurance message to the caller if there are no agents free. 

Auto Attendant: The auto attendant feature is used to route incoming telephone calls based on 
selections or information provided by the incoming caller. The auto attendant feature may use 
interactive voice response (IVR) to prompt the caller to select the call routing based on category 
choices or it may use the calling number identification to determine the destination (e.g. a 
telephone number for a specific sales group). 

Agent: The person who handles incoming or outgoing contacts.  

Agent Status: The mode an agent is in (e.g., talk time, after-call work, unavailable, etc.).  

All Trunks Busy (ATB): When all trunks are busy in a specified trunk group. Generally, Trunk Usage 
reports indicate the percentage of trunks busy over a period of time as a percentage of potential 
usage for the whole group over that period 

Analogue: Telephone transmission or switching that uses a fluctuating voltage signal to transmit 
information.  

Analytics: Advanced data analysis and reporting tools that enable the organisation to better 
understand customer trends and business activities.  
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Announcement: A recorded verbal message played to callers.  

Answered Call: When referring to an agent group, a call is answered when reaches an agent.  

Auto Wrap-Up: An ACD feature whereby the ACD is programmed to automatically put agents into 
after-call work after they finish talk time and disconnect calls. When they have completed any after-
call work required, they put themselves back into available.  

Automated Greeting: An agent’s pre-recorded greeting that plays automatically when a call arrives 
at his or her telephone station.  

Automatic Call Distributor (ACD): A mechanism controlled by the PBX switch or call management 
software which can distribute calls among agents in an attempt to even out the distribution of calls 
to each agent. 

Automatic Number Identification (ANI): A telephone network feature that passes the number of the 
phone the caller is using to the call centre in real-time. ANI is an American term Calling Line Identity 
(CLI) is an alternative term used elsewhere.  

Availability: The time the agent spends handling calls or waiting for calls to arrive.  

Available State: The work state of agents who are signed on to the ACD and are waiting for calls to 
arrive.  

Average Call Value: A measure common in revenue-producing call centres. It is total revenue 
divided by total number of calls for a given period of time.  

Average Handling Time (AHT): The sum of average talk time plus average after-call work.  

Average Holding Time on Trunks (AHT): The average time inbound transactions occupy the trunks. 

Average Time to Answer (ATA or ASA): A measure that reflects the average delay of all calls 
including those that receive an immediate answer. Also called average delay.  

Average Abandonment Time (AAT): Also called average delay to abandon. The  
average time that callers wait in queue before abandoning. The calculation considers only the calls 
that abandon. 

Barge-In: An ACD feature that allows a supervisor or manager to join or “barge-in” on a call being 
handled by an agent.  

Blended Agent: An agent who handles both inbound and outbound calls, or who handles contacts 
from different channels (e.g., email and phone) 

Call: Also called contact, interaction or transaction. Although it most often refers to a telephone call, 
call can also refer to a video call, a Web call and other types of customer contacts  
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Call Forcing: An ACD feature that automatically delivers calls to agents who are available and ready 
to take calls. This is sometimes called automatic answer.  

Call Load: Also called workload. Call load is volume multiplied by average handling time, for a given 
period of time  

Call Recording: A type of monitoring in which the supervisor or automated system records a 
sampling of calls. The person conducting the monitoring then randomly selects calls for evaluation of 
agent performance.  

Call Time Alarms: Determines what the acceptable minimum and maximum average call times 
should be in a one hour period. An average call time that is less than the minimum value can indicate 
that you may be rushing your calls. An average call time that is more than the maximum value 
indicates that the calls are taking too long and you may need to speed up the conversation. 

Caller Alarms: Determines if a caller has been contacted within a specified time period. 

Caller Tolerance: How patient callers will be when they encounter queues or experience busy 
signals.  

Caller-Entered Digits (CED): Digits callers enter using their telephone keypads. The ACD, IVR, or 
network can prompt for CEDs.  

Calls in Queue: A real-time report that refers to the number of calls received by the ACD system but 
not yet connected to an agent.  

Carrier: A company that provides telecommunications circuits, Carriers include both local telephone 
companies, also called local exchange carriers (LEC5), and long-distance providers, also called inter-
exchange carriers (IXCs).  

Circuit: A transmission path between two points in a network.  

Combination Values: A real-time display of a parameters shown together. For example, number of 
incoming + outgoing and abandoned calls 

Computer Telephony Integration (CTI): The software, hardware and programming necessary to 
integrate computer systems and telephone systems so they can work together seamlessly and 
intelligently.  

Contacts Per Hour: An outbound term that refers to the number of contacts divided by agent hours 
on the dialler.  

Cost Per Call: Total costs (queued and variable) divided by total calls *01 a given period of time. 

Customer Expectations: The expectations customers have of a product, service or organization. 

Delay: Also called queue time. The time a caller spends in queue waiting for an agent to become 
available. Average delay is the same thing as average speed of answer.  

Delay Announcements: Recorded announcements that encourage callers to wait for an agent to 
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Delayed Call: A call which cannot be answered immediately and is placed in a queue.  

DID: Direct Inward Dial, A service offered by telephone companies which allows the last 3 or 4 digits 
of a phone number to be transmitted to the destination PBX. A company may for example have 10 
lines but the company could publish up to 1000 numbers if 3 digit DIDs are used. Each of these 
numbers can be assigned a purpose and routed to the appropriate extension or group. 

Dialled Number (DN): The number that the caller dialled to initiate the call.  

Dialled Number Identification Service (DNIS): A string of digits that the telephone network passes to 
the ACD, IVR or other device to indicate which telephone number the caller dialled, One trunk group 
can have many 1)NIS numbers. 

Fast Clear Down: A caller who hangs up immediately after hearing a delay announcement.  

First-Call Resolution: The percentage of calls that do not require any further contacts to address the 
customer’s reason for calling. The customer does not need to contact the call centre again to seek 
resolution, nor does anyone within the organization need to follow up.  

Forecasting: The process of predicting call centre workload and other activities.  

Gateway: A server dedicated to providing access to a network.  

Grade of Service (GOS): The probability that a call will not be connected to a system because all 
trunks are busy. Grade of service is often expressed as p.O1 meaning 1 percent of calls *11 be 
blocked. Sometimes grade of service is used interchangeably with service level, but the two terms 
have different meanings.  

Handled Call: A call that is received and handed by an agent or peripheral equipment.  

Handling Time: The time an agent spends in talk time and after-call work handling a  
transaction. 

Historical Report: A report that tracks call centre and agent performance over a period of time.  

Idle Time: The time agents are available and waiting for calls.  

Instant Messaging (IM): A type of text-chat between two or more Internet users. 

Integrated Services Digital Network (ISDN): A set of international standards for digital telephone 
transmission.  

Interactive Voice Response (IVR): An IVR system responds to caller entered digits or speech 
recognition in much the same way that a conventional computer responds to keystrokes or clicks of 
a mouse. When the IVR is integrated with database computers, callers can interact with databases to 
check current information (e.g., account balances) and complete transactions (e.g. make transfers 
between accounts).  

Least Cost Routing (LCR): is an automated function which routes outgoing calls via the cheapest 
telecom operator available, usually by dialling a prefix to the telephone number 

Local Area Network (LAN): The connection of multiple computers within a building so that they can 
share information, applications and peripherals.  

Local Exchange Carrier (LEC): Telephone companies responsible for providing local connections and 
services.  
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Long Call: A call that has exceeded a specified talk time. Used to identify which calls are taking 
longer to handle. Can be used as a measure for further training of the operator or agent.  

Longest-Available Agent: Also referred to as most-idle agent. A method of distributing calls to the 
agent who has been sitting idle the longest. With a queue, longest available agent becomes next 
available agent.  

Longest Delay (Oldest Call): The longest time a caller has waited in queue, before abandoning or 
reaching an agent.  

Manual Answer: The ACD system is set up so that agents must manually answer calls.  

Manual Available: The ACD system is set up so that agents must put themselves back into the 
available mode after completing any after call work.  

Most Frequent Calls Report: Report that provides a list of the most frequent numbers dialled or 
answered. The report can be configured to include or exclude and combination of call types or 
device 

Next-Available Agent: A call distribution method that sends calls to the next agent who becomes 
available. The method seeks to maintain an equal load across skill groups or services. When there is 
no queue, next-available agent reverts to longest-available agent.  

Non ACD Calls: Inbound calls that are directed to an agent’s extension rather than to a general 
group. These may be personal calls or calls from customers who dial the agents’ extension numbers. 

Offered Call: Offered calls include all times a call has been presented to an agent either answered or 
not. 

Off-Peak: Periods of time other than the call centre’s busiest periods. Also a term used to describe 
periods of time when long-distance carriers provide lower rates.  

Overflow: Calls that flow from one group or site to another. More specifically intraflow happens 
when calls flow between agent groups and interflow is when calls flow out of the ACD to another 
site.  

Other ACD Calls: Calls routed via an ACD queue to an agent but not from the queue in which a 
supervisor may be responsible.  

Pilot Number: A number that represents an ACD or hunt group. A call can be either made directly to 
this number or routed to this number if it is an incoming call. 

PBX/ACD: A private branch exchange (PBX) that is equipped with ACD functionality.  

Peaked Call Arrival: A surge of traffic beyond random variation. It is a spike within a short period of 
time. There are two types of peaked traffic — the type you can plan for, and incidents that are 
impossible to predict.  
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Private Branch Exchange (PBX): Also called private automatic branch exchange (PA8X). A telephone 
system located at the call centre’s site that handles incoming and outgoing calls. ACD software can 
provide PBXs with ACD functionality. Many refer to a PBX as a switch.  

Queue: Queue literally means ‘line of waiting people. Holds callers until an agent becomes available. 

Queue Status Alarms: Determines the acceptable number of calls in a queue, and also the 
acceptable amount of time that a call can remain in a queue before being answered. 

Real Time Statistics: The Real Time Statistics are available on a group basis and are a summary of a 
selected set of the available Single Value parameters. 

Received Call: A call detected and seized by a trunk. Received calls will either abandon or be 
answered by an agent.  

Report Schedule: A series of configured report items that will be run together at a specified time. 

Report Template: The definition that forms the basis of an ad-hoc report or saved report item. 

Ring Delay: Also called delay before answer. An ACD feature that enables the system to adjust the 
number of rings before the system automatically answers a call.  

Service Level Alarms: Determine the minimum average and maximum average acceptable Grade of 
Service (GOS) in a one hour period. A value below the minimum average can indicate that there are 
not enough staff available to take all of the calls. Conversely, if the value is above the maximum 
value it might indicate that there are too many people available to answer calls. 

Single Value Parameter: A real-time parameter that holds information about one statistic. For 
example, Number of Incoming Calls. 

System Alarms: Are triggered when either no data is received from the PBX for a certain period or if 
the free disk space on the disk that the database is situated on is below a specified level. 

Screen Monitoring: A system capability that enables a supervisor or manager to remotely monitor 
the activity on agent’s computer terminals.  

Screen Refresh: The rate at which real-time information is updated on a display. Screen refresh does 
not correlate with the time frame used for real-time calculations.  

Skills-Based Routing: An ACD capability that matches a caller’s specific needs with an agent that has 
the skills to handle that call, on a real-time basis.  

Talk Time: Everything from hello to goodbye in a phone call. In other words it’s the time callers are 
connected with agents. Anything that happens during talk time, such as placing customers on hold to 
confer with supervisors, should be included in this measurement.  
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TCP/IP Trunk: A trunk that routes calls through the internet rather than the PSTN. 

Telemarketing: Generally refers to outbound calls for the purpose of selling products or services, or 
placing informational calls to customers, prospective customers or constituents.  

Time Parameter Distribution Report: Report that list the number of calls that have either a wait, call 
or hold time within a specified time period. The time periods can start at any value, end at any value 
and each interval can be any size. 

Toll Fraud alarms: Determines whether a call is too expensive or lasts for too long or is to/from a 
specific destination. 

Trunk: Also called a line, exchange line or circuit. A telephone circuit linking two switching systems. 

Trunk Group: A collection of trunks associated with a single peripheral and usually used for a 
common purpose.  

Trunk Load: The load that trunks carry. Includes both delay and talk tine.  

Unavailable Codes: A user has made themselves unavailable to take calls from an ACD system for 
whatever reason. It is usual to supply a reason code or unavailable code when going unavailable so 
to track the reasons why this state has been entered. 

User Login/Pin code: A unique number that the user enters to associate themselves with the 
telephone system to inform them they are able to take calls, usually on one or more ACD queues. 

User Login (MyCalls): A unique username and password combination assigned to a MyCalls User to 
allow the user to use the MyCalls application. 

Wallboard: Also called reader boards, display boards or wall displays. A visual display, usually 
mounted on the wall or ceiling that provides real-time and historical information on queue 
conditions, agent status and call centre performance.  

Wide Area Network (WAN): The connection of multiple computers across a wide area.  

Wrap-Up Codes: Codes which agents enter on their phones to identify the types of calls they are 
handing. The ACD can then generate reports on call types by handling time, time of day, etc. 

 

 



 

 

Appendix A 

MyCalls Licensing 

MyCalls uses a licensing system to control the features available within the product. Once MyCalls 
has been installed the user will be unaware of any licensing mechanisms other than the fact that 
certain features will be unavailable. 

There are several versions of the MyCalls Product 

SL MyCalls  

MyCalls Call Manager 

 

The default license purchased for each contains the following features. 

 

Feature  SL MyCalls  
MyCalls Call 

Manager 

Licensing    

Max extensions  12 128 

Concurrent users (Max) 1(1) 1(Unlimited) 

Call Control users (Max) 0(Unlimited) 0(Unlimited) 

Wallboard users (Max) 0(0) 0(Unlimited) 

Client/Server  Yes  Yes 

PBXs (Max)  1(1)  1(Unlimited) 

User Role Security No Yes 

Users/Group Hierarchy No Yes 

Telephone Configuration    

Account codes  No Yes  

DDIs  Yes Yes  

Extensions  Yes  Yes  

Trunks  Yes  Yes  



 

 

Account code groups  No Yes  

DDI groups  No Yes  

Extension groups  No Yes  

Trunk groups  No Yes  

Import Device  No  Yes  

Callers    

Create/Edit/Delete/Import 
Callers  

No  Yes 

Create/Edit/Delete Caller 
groups  

No  Yes 

Costing    

Fixed costs  Yes Yes 

User costs  Yes Yes 

Account code costs  No Yes 

DDI costs  No Yes 

Local area code  Yes Yes 

Carrier associations  Yes Yes 

Profit margins  Yes Yes 

Taxes  Yes Yes 

Create/Edit/Delete Carriers  Yes Yes 

Alarms    

Severity levels  No Yes 

Distribution lists  No Yes 

Alarm Schedules  No Yes 

System Alarms  No Yes 

Incoming call rate  No Yes 

Abandoned call rate  No Yes 

Outgoing call rate  No Yes 

Incoming wait time  No Yes 

Abandoned wait time  No  Yes 

Incoming call time  No  Yes 



 

 

Outgoing call time  No  Yes 

General Service  No  Yes 

Abandoned Service  No  Yes 

Trunk group concurrent 
usage 

No No 

Trunk/Extension 
locked/dead 

No No 

Emergency  No  Yes 

Toll fraud  No  Yes 

Caller  No  Yes 

Trunk/Extension/DID 
Queue Group Status 

No No 

Off Hook No No 

Operational Settings    

Grade of Service  No Yes 

Grace periods  No Yes 

Real Time Views    

Alarms  No Yes 

Call records  Yes  Yes 

Unreturned Calls No Yes 

Audit  Yes  Yes 

Layout Management Yes  Yes 

Sequenced Layouts No Yes 

Miscellaneous Real Time 
Windows 

  

Web Browser No Yes 

External Data XML/ODBC No Yes 

Real Time Parameters    

DDI queue status No No 

DDI queue group status No No 

Extension status No No 

Trunk status No No 



 

 

Trunk group queue status No No 

Trunk group queue group 
status 

No No 

DDI group statistics  No Yes 

DDI statistics Yes Yes 

Trunk group statistics  No Yes  

Extension group statistics No Yes 

Extension statistics Yes Yes 

Incoming calls, call rate  Yes  Yes  

Outgoing calls, call rate  Yes  Yes  

Abandoned calls, call rate  Yes  Yes  

Avg. incoming call, wait 
time  

No Yes  

Avg. incoming call, call time  No Yes 

Avg. outgoing call, call time  No Yes 

Avg. abandoned call, wait 
time  

No Yes 

No. long waiting incoming 
calls  

No Yes 

No. long incoming calls  No Yes 

No. long waiting 
abandoned calls  

No Yes 

General service level  No Yes 

Abandoned service level  No Yes 

Account code group call 
volume / wait time  

No Yes  

Extension group call 
volume / wait time  

No Yes  

DDI group call volume / 
wait time  

No Yes  

Organisation group call 
volume / wait time  

No  Yes  

Trunk group call volume / 
wait time  

No Yes  

Reports    



 

 

Report Scheduling No  Yes 

Report Editing Yes Yes 

Report Filtering No Yes 

Call Details Yes Yes 

Top calls  Yes  Yes  

Most frequent numbers  Yes Yes  

Call summary time 
distribution  

No Yes  

Call summary in time 
periods  

No  Yes  

Call summary over same 
Interval  

No  Yes  

Group summary for each 
member  

No  Yes  

Trunk Utilisation  No  Yes  

Group summary  Yes Yes  

Call type summary 
comparison  

No  Yes  

Grade of service group 
summary  

No  Yes  

Grade of service group 
detail  

No  Yes  

Response times  No  Yes  

Unused devices  No Yes  

Alarms raised  No Yes  

Auto configured devices  No Yes  

System audit  Yes  Yes  

Custom Field call details No Yes 

Custom Field group 
summary 

No Yes 

Custom Field group 
member summary 

No Yes 

Custom Field group 
summary over time 

No Yes 

Directors Report Yes Yes 



 

 

Playback Audit Report No Optional 

System    

Automatic database 
backup  

Yes  Yes  

Backup database  Yes  Yes  

Database information  Yes  Yes  

Remove unwanted 
information  

Yes  Yes  

Import bill  No  Yes  

Re-cost calls  No  Yes  

Import file  No  Yes  

Call Recording   

Customisable recording 
rules 

No Yes 

Call playback No Yes 

Playback access rights No Yes 

Enhanced Call Playback No Optional 

Call Playback Auditing No Optional 
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